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\Y e computer, a home network can be pretty
D r ﬁB@ S?work you can share files, printers, and Internet
coRmnections. Your home network may also connect devices such as game
consoles, PDAs, digital media players, security cameras, and more. And
thanks to modern wireless networking technologies, it's now easier than ever
to create a large, useful home network without turning your home into a

rat’s nest of cables.

About This Book

Networking is an advanced computer topic, which means that many net-
working books are dry and difficult to follow. But some people just want to
get their network up and running, and they're not terribly interested in read-
ing a lot of discussion of network theory and concepts. If this sounds like
you, then I hope that this is your book. Following the Just the Steps style, this
book includes only the essential steps you need to perform common home
networking tasks.

Why You Need This Book

Networks are a lot more fun to use than to configure. If you want to start
using your wireless network right away, this book can help you get things
functioning quickly. Each task covers a specific subject, and most steps take
only a minute or two to follow. Think of this as the anti-computer computer
book, because it's all about less reading and more networking.

v —
Introduction

Conventions used
in this book

w= When you have to access a menu command,
| use the => symbol. For example, if you have
to open the File menu and then choose Open,
| say File > Open.

w= [nternet addresses are presented like
www . dummies . com. | leave off the
http: // part of Web addresses because
you usually don't have to type it anyway.

When you see this icon, the text includes
helpful tips or extra information relating
to the task.
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This Book Is Organized

Ho
D ro p QIQ a 5 of this book into several basic parts:

Part I: Starting a Wireless Network

This part shows you how to get your home network started. I
show you how to set up a wireless access point, connect wireless
computers — both Windows PCs and Macs — to the access
point, and share your Internet connection with the network.

Part II: Securing Your Network

If you aren't careful, intruders can easily access your wireless
network, stealing your Internet access and accessing your per-
sonal files. This part helps you secure your home network
from intrusion.

Part 11I: Improving Your Network’s Performance

Does your network seem a little slow? Does the connection
drop out frequently? This part helps you improve the perform-
ance of your network, as well as identify and fix network
problems.

Part IU: Using Someone Else’s Network

Wireless networks are popping up everywhere, and if you
have a Wi-Fi-equipped laptop or PDA you may be able to
use hotspots and other public wireless networks. The chap-
ters in Part IV show you how to use hotspots, connect two
computers directly to each other wirelessly, and network
your computer with Bluetooth devices, such as headsets
and GPS receivers.

Part U: Practical Applications

These chapters help you perform some common network-
ing tasks, such as networking game consoles, playing
digital music and videos from anywhere in your home,
using Internet telephony, and more.

Get Ready To

If you're setting up your first home network, or if you're
trying to use a public hotspot, there’s a task in this book
to get you started right away. So jump right in and get
connected!
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Dr(ﬁﬂ;tfm Up Wireless ——
ccess Points Chapter

If you want to do wireless networking, your first step is to install a wireless
access point. All of your wireless gear — laptops, PDAs, cameras, media
centers, printers — connects to your network using radio waves instead of
cables, and a wireless access point (WAP) is the device that creates your radio
wave network.

As the name implies, a wireless access point gives wireless devices access to Get ready to...
a network. The network may include other devices that are connected by e Wireless Access Poi 6
Ethernet cables, or the network may consist entirely of wireless connections. oose a Wireless Access Fonf .................
Whatever' type of network you need, your ﬁrsj[ step in setting up a wireless =S Conﬁgure Your Wireless Hardware............... 7
network is to buy and configure a WAP. In this chapter, you discover how to:

3 I
m= Select a wireless access point: The market now offers many different Log In to the Access PO ... 8

wireless access points from which to choose. I go over how to select a w= Change the Admin Password ........................ 8
model that meets your needs and budget.

. e Set the SSID 9
w= Set up the hardware: After you purchase a WAP, you need to set it up
and make all the necessary hardware connections to make it work. = Activate the Wireless Radio .............cccooeee.... 9
w= Take the first steps towards creating a secure network: Wireless net- w= Set Up Remote Access Point Management....10
works are extremely handy, but if left unsecured, they also leave your .
personal files open to theft and your Internet connection available to »= Manage Your Access Point Remotely ........ 11
strangers.

"= Manage your network remotely: You can control your wireless net-
work even if you're on the other side of the country.
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Chagse a Wireless Access Point
DropB00o

as a router.

¥éless access point (WAP) will also serve

A router allows your network to share a broadband (cable or DSL)
Internet connection, as well as connect your wireless devices to
Ethernet wired computers. WAPs with built-in routers are widely
available.

Count the number of Ethernet cable ports on the WAP.

Use a router/WAP with four Ethernet ports (see Figure 1-1)
or a router/ WAP/DSL modem with only one Ethernet
port (see Figure 1-2).

At the very least, a WAP/router should have an Ethernet port labeled
WAN for connecting to a broadband modem. WAN stands for wide
area network and usually refers fo a very large network such as the
Internet. You may also need some LAN Ethernet ports for connect-

ing to Ethernet wired computers. Your home network is a LAN,
which stands for local area network.

4. Determine which Wi-Fi standards your WAP needs to
support.

The 802.11g standard is faster than 802.11h, and 802.11g WAPs
are backwards-compatible with 802.11b devices. If you also have
802.11a gear, you'll need a WAP that supports 802.11a.

Figure 1-1: Access point with four Ethernet pors.

Figure 1-2: Access point with one Ethernet port.



Configure Your Wireless Hardware

Con ({gflre ur Wireless Hardware i
D ro p 4 So a computer using an Ethernet
cable. [— D
=
If your ultimate plan is to connect all devices wirelessly, you can dis- e *
connect this Ethernet cable later, after you have finished configuring h
your WAP and router. 1 Y
omputer
2. If you have a broadband modem, connect it to the Figure 1-3: Temporarily connect the WAP to a computer.

WAN port on your wireless access point using an
Ethernet cable.

Wall jack to
Internet

3. Make sure that the modem is on and connected to your
Internet Service Provider (ISP). Your hardware should be
set up similar to the configuration shown in Figure 1-3.

4. Start up your computer.

Rauter

—3
=]
If your computer has Windows 2000, Windows XP. or Mac 05 X, . 1

make sure that you log in with a user account that has administra- T
tor rights.

Figure 1-4: Disconnect the Ethernet cables and network wirelessly.
5. Plug in the power connector for the WAP and, if the
WAP has a power switch, turn it on at this time. For hest performance and Wi-Fi range, position your wireless access
point as high as possible and away from metal or stone walls. Also avoid
placing the WAP near electronic devices, such as microwave ovens and
the base units for 2.4 GHz cordless phones.

6. After you have logged in to the router and performed
the initial setup (as I describe later in this chapter), you
can disconnect the Ethernet cable and link all of your
computers wirelessly, as shown in Figure 1-4.



Chapter 1: Setting Up Wireless Access Points

Lo

n to the Access Point

D ro p Qh e Swser, such as Internet Explorer, and

click Stop in the browser toolbar to stop any Web pages
from loading.

In the Address bar, type the default IP address for your
access point and press the Enter key. If the connection
is successful, you should see a log in dialog box (see
Figure 1-5).

Enter the default administrative user name and pass-
word for your WAP. (The default password should be
listed in the WAP’s documentation. Often, the default
user name is blank and the default password is admin.)

Change the Admin Password

1.

Log in to the router WAP using a Web browser (refer to
the previous task).

Click the tab that contains administrative controls.
(On some routers, admin controls are located on the
Tools tab, as shown in Figure 1-6.)

Type your new password in both of the password text
boxes provided.

Try to choose a password that is somewhat complex; include both
letters and numbers. Avoid easily guessed passwords, such as the
name of your pet, and keep in mind that passwords are usually
case-sensitive. The router’s password should be changed as soon as
possible because hackers know the default passwords programmed
into new routers.

Click OK or Apply.

Connect to 192.168.0.10 8]
=

DI-624

User name: lﬁ | »
Password:

[ remember my passward

Figure 1-5: Use the default admin name
and password.

192.168.0.1 s the default IP address for many WAP/routers. Linksys routers
usually use the IP address 192.168.1.1 instead. If Internet Explorer is
unable to connect fo this address, check the router’s documentation fo
see if you should use a different IP address.

DI-624 |
Home __ Advancedill 'R Status___Help |
can change their login passward
|
L Admin Administrator (The Login Name is "adrmin®)
e Paggugrg feessssesssss:
' Time =
Confirm Pagsworg feesssessssss
User (The Login name is "user”)
i t
System v Pagaur eesssssssessss
— Canfirm Password
' Firmware
ote Mana
e— © Enabled @ Disabled
Se. IP Address *
Port | 5080 |v
»
= 2 00
Apply Cancel Help

Figure 1-6: Administrative controls.



Activate the Wireless Radio

S ss =]
et (1T Advanced  Tools Status____Help
D r . . "‘F;e;e: a‘?‘e (‘)';e“;/w;e\ess settings for the AP(Access Point)Portion.

oint and find the wireless controls.

‘Wireless Radic O on @ Off
Most access pomts have a Wireless tab or a Wireless but- —_— 5510 - eut
ton (see Figure 1-7). Wireless

Channel ; B v
Authentication : & Open System O Shared key O wpa O wpaA-PSK
WEP: O Enabled @ Disabled
WEP Encryption : | 128Bit |+

2. Enter a word in the SSID text box.

SSID is the name that wireless devices use to identify your access e
point. If you want to keep your wireless network more private from
others, choose a cryptic SSID like the one shown in Figure 1-8,

Keyl : & 00000000000000000000000000
Key2 | 00000000000000000000000000
Key3 : © |00000000000000000000000000

which combines letters and numbers. Kyt © |oononsnoosoooanasosooooon
@ 90O
3. Click OK or App]y. Apply Cancel Help
AC tivate the w ire I eéss Rad 1o Figure 1-7: The radio and SSID controls.
1. Login to the access point and find the wireless controls. DIG2e |
Most access points have a Wireless tab or a Wireless ; LCLCR Advanced ) Tools Status Help

Wireless Settings

button.

2. Select the On radio button, as shown in Figure 1-8, and
click OK or Apply.

-
These are the wireless settings for the AP(Access Point)Portion.
Wirglese Radic @ on O oOff
SSID : ehisLMVES4Z
Wireless Channel - |6 v
Authentication : & opan Systam O Shared key © wpa O wpa-PsK
WEP: © enabled @ Disabled

WEP Encryption : | 1258t [»

Key Type - | HEX |+

If you are going to be away for several days, temporarily turn off
the wireless radio fo prevent others from using your wireless signal.

Keyl | 00000000000000000000000000
Key2 . © |00000000000000000000000000
Key3: O |00000000000000000000000000
Key4 . O |00000000000000000000000000

9 90

Apply Cancel Help

Figure 1-8: Turn on the wireless radio and se the SSID.
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1.

10

ote Access
ent

Determine the IP address for the computer from which
you want to be able to access your router/ WAP over the
Internet.

To quickly determine the IP address of the computer on which you
are currently working, visit a Web site such as www . what
ismyip.com or www.showmyip .com. Your
computer’s current IP address appears on-screen.

At your local network, log in to the router/WAP control
panel and open the controls for remote access manage-
ment (see Figure 1-9).

In the IP Address text box, enter the IP address of the
computer that will be remotely managing your router,
as shown in Figure 1-10.

If the remote computer has a dynamic IP, or if you don’t know what
computer you'll be using for remote management, just enter an
asterisk (*) in the IP Address box, as shown in Figure 1-9. Doing
this allows any computer at any IP address to access the router, pro-
vided it has the correct password.

Specify the port that will be used to access the router.

If you are accessing the router over the Internet using a
Web browser, choose Port 80, which is the port used by
Web browsers.

Enable remote management and click OK or Apply to
apply your settings.

DI-624 l -
Home  Advancediis (.11 M
6‘ Administrator Seftings
1 ] can change their login pagsword
l Admin | Administratar (The Login Mame is "admin®)
‘ New Paggwpr [eessessees
Time
Confirm Paggugrg oo
User (The Login name is "user”)
i t
System New Passuor [
Confirm Password
' Firmware
Remote Managenm
—_— © Enabled @ Disabled
Misc. IP Addrass *
Port | 8080 v
T v
' Cable Test 9 O O

Apply Cancel Help

Figure 1-9: Remote access management conirols.

DI-624 |

Admin

i

Time

' System

' Firmware

—_—

HEDE

Home __Advanced VORI Status___ Help |
Administrator Settin
ri can change their login password
Administrator (The Login Mame is "admin®)
New Password [
Confirm Passwprg feowsssses
Uszer (The Login name is "user”)
Mew Paggurd oo
Confirm Pagguprg s
Remote Man
@ Enabled O Disabled
Misc. IP Address 71.34.247.12
Port (80 v/
9 00
Apply Cancel Help

Figure 1-10: Only a computer at IP address 71.34.247.12 can access this router.




Manage Your Access Point Remotely

Man e Voyr Access Point Remotely e T e T i U e

LQ w-op - & D @ [0 azerse [v] © co [GL
er on the remote computer.

2. In the Address bar of the Web browser, enter the IP
address for your home network, followed by a colon,
and then the port number specified in your router for
remote access (see Figure 1-11).

Remember, you need to determine your home IP address while you
are actually ot home, using your home network. | go over how to
do this in the previous fask.

éinpped-

Press the Enter key. Figure 1-11: Enter the IP address and port for your home router/WAP.

4. Log in to your router/WAP using your administrative

account name and password, as shown in Figure 1-12. PO
. . (i | Enteruserame and password for "WebAdmin" at http:471.34 247 59:50
After you are logged in you should be able to perform all adminis- " User Name
trative tasks of your router/WAP as normal. ladrin

Fassward
—

[] Use Password Manager to remember this password.

| strongly recommend that you disable remote management when
you are not using it. When remote management is enabled, hackers

can more easily gain access to your router’s control panel over the lmisze! |

Internet and gain access to the rest of your network.

Figure 1-12: Log in fo your router/WAP.
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tgaring Your
etwork

efore your wireless devices can talk to each other, you are going to have
to do some basic network configuration. Setting up networks is pretty

easy these days, especially if you use the Windows Network Setup Wizard to
walk through the setup process. But some things may need to be configured
manually. In this chapter, I go over how to configure those items and change
them later if necessary. You find out how to:

)

=

-y

Iy

Set a network’s workgroup name: You can think of the workgroup
name as the name of your network. The workgroup name needs to

be the same on all of your computers in order for them to see and

communicate easily with each other.

Set up DHCP: Each computer on your network is identified by a
unique IP address. A Dynamic Host Configuration Protocol (DHCP)
server is the program that hands out IP addresses to each computer
on the network.

Use Windows Internet Connection Sharing (ICS): If you have one
computer that connects directly to the Internet through a modem, you
can share that computer’s Internet connection using Windows ICS.

Set up your router/WAP to use the Internet: You can adjust Internet
connection settings, including setting a MAC address if your Internet
Service Provider (ISP) requires you to use a specific one.

R R
Chapter

Getready to. ..

= Use the Windows Network Setup Wizard ....14
w= Change the Workgroup Name.................... 15
w= Set Up the DHCP Server in Your Router ......16

w= Share a Connection with Windows

Internet Connection Sharing ..................... 17
w= Configure a Windows PC as a DHCP Client ....18
w= Configure a Mac as a DHCP Client .............. 19
w= Adjust WAN Settings in the Roufer .............. 20
w= (lone Your PC's MAC Address...................... 21



Chapter 2: Configuring Your Network

Usethe Windows Network

Drop

1.

14

Choose Start>All Programsr>Accessoriest
Communications=>Network Setup Wizard.

In the resulting Network Setup Wizard, shown in
Figure 2-1, click Next, read the on-screen instructions to
connect all of your hardware, and then click Next again.

Choose whether or not you want your network to share
an existing Internet connection. (You may be asked a
different series of basic questions based on how you
answer.)

When you see the screen shown in Figure 2-2, enter a
description and name for the computer. Click Next.

Give each computer a descriptive name, because this is how it will
be identified to other computers on the network.

Enter a workgroup name. The workgroup name must be
the same on every computer on the network.

Choose whether or not you want to allow file and
printer sharing and click Next again.

If you enable file and printer sharing, other people on your network
can access shared folders and printers on your computer. If you choose
not fo enable file and printer sharing, the Windows XP Firewall pre-
vents others from accessing items on your computer. | describe how
to customize file and printer sharing in Chapter 4.

Review your settings in the next screen and click Next to
apply them.

Network Setup Wizard

Welcome to the Network Setup
Wizard

This wizard will help you set up this computer ta run on your
nztwork, With a network vou can:

+ Share an Interet cannection
+ Setup Windows Firewall

+ Share files and folders
+ Share a printer

To continue, click Nesxt

Figure 2-1: The Windows Network Setup Wizard.

When the Network Setup Wizard is done, you will be asked if you want
to create a network setup disk. Windows Network Setup disks uses floppy
disks, so unless all of your computers have floppy drives creating a disk
may not be very useful.

Network Setup Wizard

Give this computer a description and name.

Keith's Main PC

Computer descriplion

Examplss: Family Foom Computer or Monica's Compuler

Computer name 50Y0P4|
Examples: FAMILY or MONICA

The cunent compuler name is CELEROM

Leam more about computer names and descriptions.

[ < Back ][ Mext > ][ Cancel ]

Figure 2-2: Enter a name and description for the computer.



Change the Workgroup Name

General | Computer Name Hardware | Advanced

\&ODU‘OI Panel and dOUble-CliCk the 1 Windows uses the following information to identify wour computer

7 onthe network,

Chag the Workgroup Name S =
QQ |

D r : p _ Sustem Festore | Automatic Updates Remote

System icon to open it.

Cormputer description; Feith's Main PC

. . . | o For example: "Kitchen Computer'' or "Many's
You can also open System Properiies by right-clicking the My . e i
Computer icon and choosing Properies from the menu that appears. Ralccrectiineger  (30YO0RY,
Wwharkgroup: FREELANCE

il he N k |dentification Wizard to joi
2. In the resulting System Properties dialog box, click the Fg”’u:;ta"ed Sl (10
: i ! To vename this computer o join a domain, cick Change. [ Changs
Computer Name tab (see Figure 2-3). S

3. Click the Change button to open the Computer Name
Changes dialog box.

4. Enter a new name in the Workgroup text box (see

Figure 2-4). ==
You can also change the computer’s name in the Computer Name Figure 2-3: The Systems Properties dialog box, Computer
Changes dialog box. Name tab.
‘Computer Name Changes BJEJ
5. Click OK to ClOSe each Open dialog bOX, “You can change the name and the membership of this
computer. Changes may affect access to network resources.
You should set the exact same workgroup name on each Windows P
PC on your network. If each PC doesn’t have the same workgroup LR,
! 1 H ull computer name:
name, you won't be able fo eq5||y perform many networking tasks, [
such as printing and sharing files.
More.
IMember of
If you change a computer’s name or workgroup name, you must O Daran
restart the computer for those changes fo take effect. .
%) WWorkgroup:
UNDERHOME]|

Figure 2-4: The Computer Name Changes
dialog box.
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p the DHCP Server
Bhoks

Log in to the router using a Web browser and locate the
DHCP controls.

The DHCP controls are usually located on a General tab, or a spe-
cial DHCP screen as shown in Figure 2-5.

Enable the DHCP server (see Figure 2-5). On D-Link
routers, select the Enabled radio button. On some other
routers, you need to choose the DHCP network type.

Choose a starting number for the range of IP addresses
that you want the router to use.

Choose an ending number for the IP address range.

Each computer on your network must have a unique IP address.
If you know for sure that only four computers will ever access your
network, you can limit the range of IP addresses fo just four num-
bers by entering 100 as the starfing number and 103 as the end-
ing number. Doing so provides one additional level of security to
your network.

Click OK or Apply to apply your changes. You may need
to restart the router.

Reopen the DHCP controls and review the IP addresses
assigned to each computer (see Figure 2-6).

DHCP assigns IP addresses to computers that are turned on and con-
nected to the network. Nofing the IP addresses may come in handy
later when troubleshooting network problems.

Home Advanced  Tools Status Help

The D624 can be setup as a DHCP Server to distribute IP addresses to the LAM
netwark

DHCP Server
Starting IP Address
Ending IP Address

@ Enabled O Disabled
192 168 .0 (100

192 1880198

Lease Time 1 wveek [v]

Static DHCP is used to allow DHCP server to agsign same P address to specific MAC
address,

© Enabled @ Disabled

MName

IIF 192 1880
MAC Address - - -
DHCP Client 00-09-20-62-1E-31 ]
Apply Cancel Help
Host Name IP Address MAC Address
Host Name [P Address MAC Address Expired Time

192.168.0.100  00-09-2D-82-1E-31
nle-machine 192 168 0 10

Oetf23/2005 15:50:51

5254 00.FA-73.DF Qotf232005 19965

Figure 2-5: Enable the router's DHCP server.

Host Marne

& Getting Started 5L Latest Headlines | | AGES Software

IF Address MAC Address

IP Address

152.168.0.100
nle-machine  152.168.0.107
KIDE 152.168.0.104
ifac 152.168.0.106
SOYCP4  192168.0.105

Host Narne

< |

MAC Address

00-08-2D-82-1E-21
52-54-00-E6-73-DF
00-03-6D-14-EC-F0
00-30-65-6D-E1-FC
00-50-2C-07-B2-25

Expired Tirme

Oetf23/2005 15:50:51
Oetf23/2005 09:56:58
Oetf26/2005 02:09:33
Oetf25/2005 09:39:53
Oetf25/2005 18:24:08

& DI624 - Mozilla Firefox B %]
File Edit View Go Bookmarks Tools Help Q
G- - & @) D hiping21e8.0.10m_dnepni[v] © Go |G

[

]

Daone

Figure 2-6: Review the IP addresses.
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Share a Connection with Windows Internet Connection Sharing

Share.a Conpection with Window's
Qﬂ%%r‘ﬁtion Sharing

1.

On the computer that connects to the Internet, choose
Start=>All Programs=>Accessoriess>Communicationst
Network Setup Wizard to run the Windows Network
Setup wizard.

Only set up Internet Connection Sharing (ICS) if you connect fo the
Internet directly from a computer, such as through a dial-up
modem. If you connect to the Internet through a broadband modem
that is connected to a router, do not use ICS. Instead, use the
router’s built-in DHCP server as described in the previous task.

Click Next when the Network Setup Wizard begins, read
the instructions on the screen shown in Figure 2-7, and
click Next again.

Choose No, Let Me Choose Another Way to Connect to
the Internet and click Next.

In the screen that appears (see Figure 2-8), select
This Computer Connects Directly to the Internet
and click Next.

In the resulting list of network cards and modems, select
your modem and click Next.

If your computer connecs to the Internet using an external modem
which is attached directly o your computer’s network card, select
the network card to which the modem is attached. The network card
may actually be a USB port, depending on how you have your hard-
ware set up.

Complete the Network Setup Wizard as I describe earlier
in this chapter.

Network Setup Wizard

Before you continue. ..

Biefore yau continue, reviews the EHECEIE o Ceding = nefn s
Then, complete the fallawing steps:

+ Install the network cards, modems, and cables.

+ Turm on all computers, printers. and external modems.

+ Connect to the Intermet.

‘wihen you click Mext, the wizard will search for a shared Internet connection on wour network.

[ ¢ Back I[ Nest » ][ Cancel ]

Figure 2-7: The Network Setup Wizard.

When you set up ICS, your computer — called the host computer —
becomes a DHCP server for the rest of the network. After the host is set
up, the rest of the computers on your network must be set up as clients.
Follow the instructions in the next two tasks to configure your other
computers as DHCP clients. ICS clients can be other Windows PCs, or they

can he Macintosh computers.

Network Setup Wizard

Select a connection method.

Select the statement that best desciibes this computer:

(%) This camputer connects directly to the Intemet. The ather computers on my netwark. connect
ta the Intermet thraugh this computer.
Wiew an example.

) This computer connects ta the Intermet thiough a residentiel gateway or thiough another
compuler on my network

() Other

Lean more about home or small office network configurations:

[ < Back ][ Nest > ][ Cancel ]

Figure 2-8: Set up ICS on the computer.
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'qure w"ndows pc _L Local Area Connection Properties [Z]

Gieneral | Authentication | Advanced)

Co
Drop ent
1

H DAVICOM 3102-Based PCI Fast Ethe

This connection uses the following items:

. Open the Windows Control Panel and then double-click L

Igl Client for Microzoft Networks

the Network Connections icon to open a list of network gmg T —
. ] = 005 Packet Scheduler
ConneCtlons‘ ¥ % Intemet Protocol [TCP/IP)
Double-click your current connection to the network. Drineal
. . . . Deescription
3. In the resulting Status dialog box, click Properties. Traratision Caritel Pretocol e Protccsl, The defaul

wide area network pratocol that provides communic ation
acioss diverse interconnected networks,

4. In the Local Area Connection Properties dialog box,

] Show icon in notification area when connected

Shown in Figure 2'91 SeleCt Internet PrOtOCOl (TCP/IP) [] Motify me when this cannection has limited or no connectivity
and then click the Properties button.
5. In the Internet Protocol (TCP/IP) Properties dialog [ o J[ coma |

box (see Figure 2-10), select the Obtain an IP Address Figure 2-9: The Local Area Connection Properties

Automatically option. dialog box.
6. Select the Obtain DNS server address automatically
Option. Internet Protocol (TCP/IP) Properties [2]%]

Gerneral ! Alternate Configuration

7. Click OK and close all open dialog boxes.

You can get I seltings assigned automatically if your network supports
this capabiity. Otherwise, you need to ask your network administrator for
the appropriate IF settings.

When you set your computer fo obtain an IP address automatically,
it gets the address from either your router’s built-in DHCP server, or e e
() Use the fallowing |P address:

from an 1CS Host on another computer. See the tasks in this chap- ) |
ter for setting up DHCP servers and ICS.

You may need to restart your computer for your changes to take T e

eﬂed. () Use the following DNG server addresses:
Figure 2-10: The Internet Protocol (TCP/IP) Properies
dialog box.
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Configure a Mac as a DHCP Client

Dréﬁgﬁé

2.

ac as a DHCP Client

&nces from the Apple menu and
click the Network icon.

In the resulting Network control panel (see Figure 2-11),
click the Show menu drop-down arrow and choose the
network connection you use to connect to the network.

If your computer connecis to the network using the built-in Ethernet
network port, choose Built-In Ethernet in the Show menu. If you
connect using an AirPort Card, choose AirPort in the Show menu
instead.

Click the TCP/IP tab (see Figure 2-12).

Click the Configure menu drop-down arrow and choose
Using DHCP.

Click the Apply Now button and then close the Network
control panel.

Press Command+Q to quit System Preferences and then
restart your computer.

If you're using a portable Mac, you can use it o connect to several
different networks. For example, at home you may connect it to
your home network using an Ethernet cable, but at Wi-Fi hotspots
you may connect using AirPort instead. Use the Location menu at
the top of the Network control panel to specify connection settings
for different network locations.

Macintosh 0S X can obtain an IP address automatically from a
DHCP server built in to any router, or from a Windows PC running
Infernet Connection Sharing.

8o Network =

Location: | Automatic v

Show: | Netwerk Port Configurations | ]

Check a configuration to make it active. Drag configurations into the
order you want to try them when connecting to a netwark.

On | Port Configurations
a Internal Modem

New..
a Built-in Ethernet —_—
T errbicaem )
/\ Duplicate )
. Deleta...
To change the name of a port configuration, double-click it.
E_ Click the lack to prevent further changes. Revert Apply Now
i :Th k control panel
Figure 2-11: The Network control panel.
88 Network (=]
Location: | Automatic I c]

Show: _ Built-in Ethernet b+ ]

[Freppp | peroe | AppleTalk | Proxies |

Configure: | Using DHCP ]

DNS Servers {Optional)

IP Address: 192.168.0.106
(Provided by DHCP Server)

Subnet Mask: 255.255.255.0

Router: 192.168.0.10 Search Domains (Optional)

DHCP Client ID:
(Optional)

Example: apple.com

Ethernet Address: 00:30:65:6d:el:fc earthlink.net

3 Click the lock to prevent further changes. Revert Apply Now

Figure 2-12: Obtain an IP address for your Mac.
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2.

st WAN Settings in the Router

)
Q Q e Ser and locate the WAN controls on the

General tab or a special WAN screen (see Figure 2-13).

Choose the setting that applies to your connection, as
shown in Figure 2-14. Most WAN connections fall into
one of three categories:

Dynamic IP Address: If you have a cable modem, you
probably need to use the Dynamic IP address setting.

Static IP Address: Some Internet service providers
(ISPs) assign static IP addresses to users. If you have a
static IP address, choose the static option, as shown
in Figure 2-13.

PPPoE: The Point-to-Point over Ethernet setting is
most often used by DSL connections.

Enter additional connection information as required by
your ISP.

@. @,

If you choose the Static IP address setfing, you need to specify the
IP address assigned to you. If you choose PPPoE, you may need to
enter your ISP account name and password.

PPPoE connections can be static or dynamic. If your PPPoE connec-
tion is static, also enter the IP address and DNS addresses provided
by your ISP.

4. Click OK or Apply to save your changes in the router.

20
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WAN stands for wide area network. When you're setting up a home
network, the WAN is usually your ISP,

Your ISP should provide detailed instructions on exactly what set-
tings 1o use in your router. The steps here should be considered
guidelines that work in most cases, but if your ISP gives you special
instructions you should follow those instead.

Mi|

Ezars

DHCP

31| g

Home Advanced 00 Status elp

Please select the appropnate opbon to connect to your ISP

Dynamic P Address

= Sratic 1P Addenas
C FFPOE
O Others

O pP1P

O BigPond Cable

P Address

Subnot Mask

190 Gileway Address
Primaty ONE Address
Secondary DNS Address
MTU

Choose this option to obiain an IP address automatically
from your ISP, (For mast Cable modem users)

Choase this option 10 £et static 1P infarmation pravided to
you by your ISP,

Choose this option il your ISP uses PPPoE. (For most
OSL ugers)

PPTP and BigPand Cable

{for Europe use only)

(for Australia use onky)

voog (assigned by your ISP
0000
0000
na0o
0000 {aptional)
1500
@ 00

Apply Cancel Help

Figure 2-13: Some ISPs assign a static IP address.

Dl-624 |

Wircless

!

LAN

DHCP

Home

Advanced DO Status Help

Plasss select the appropriate cption to cannect to your ISP

O Dynamic IP Address

O Swstic IP Address
© PPPGE
O Others

Q PPTP

0 BigPond Cable

Usar Name

Pagsword

Retype Paysword
Service Mame

P Address

Primary DNS Address
Secondary ONS Address
Maximurn Idie Time

MTU

Aulo-reconnect

Chaose this option to oblain sn 1P sddress sutomatically
froen your 159 (For most Cable modom users)

% option 1o 38t siatic IP infarmation provided 10
v ISP

5 option i your ISE yses PRPGE, (Fur most
PPTP and BigPond Cable

{for Europe use only)

(for Australis use only)

O Stabc PPPE

= Oynamic PPPGE

723402352 @mryeds| ned
{optional)

{eptooraly
0 Minutes
1482

@ Enabled ©) Disabled

2 90

Figure 2-14: If you have DSL, you'll probably use PPPoE.




Clone Your PC’'s MAC Address

// D1-624
Clong Vour PC’s MAC Address ~ tone_hcvonced__Tooie_JCTVRR o
IL nd locate the network activity o
log. (If you don’t see a screen named Log, check the l:““ ||| o i) (i) (e (g Satinge) Hele
Status al‘ea.) Fagu:.?n; Message SourceDestination Hoie
. . Stats e ot 00-50-20-07-53-25
2. Write down the MAC address listed for your PC. - s N -
. . . OP Request 2 5
(In Figure 2-15, MAC addresses are listed in the A s,
R ctf22/2005 DHCE lease I 00-03-6D-14-EC-F0
far—rlght column.) 183618 192 168.0.104 1o KIDS
Der222005 DHOP lease [P iy
o th W, i . t 123610 192.168.0.104 to EIDS ISR MSER0
« en e WAN settings in your router. Qee222005  DHCP lepse I — .
p 8 3 15473 192.1680.106 o dac P ASREELEE
Enter the MAC address and click the Clone MAC Oaukion 1216801000 00-09-2D-82-15-31
Address button (see Figure 2-16). Your PC's MAC g e
144077 Wrreless PC comected 00-09-2D-82-1E-31
address has now been cloned to the router. s )
143016 192 168.0.105 te 20YOP 030-30- 018353
. Cet222005 DHOP lease TP e
Each network adapter connected to a network has a unique MAC 140146 1921630104 1o KIDS 00-03-6D-14-EC-F0
(Media Access Control) address. Even game consoles, PDAs, and R e 00-03-6D-14-C-F0
wireless cameras have unique MAC addresses.
Figure 2-15: Find your MAC address.
In most cases, you do not need to clone a MAC address. However,
some ISPs register the MAC address of your computer, so if you oLe24 | — | ———
change computers or add a router to your network your ISP may © T ———

not let you online because the device now connected to the ISP has
an unregistered MAC address. By cloning your PC's MAC address to
your router, you avoid having to register a new MAC address with
your ISP

Wizard

Wired
N

L

=]
=

& Dyramic IP Addrass

O Sitic IP Address

O BigPond Cable
jic |

Host Hame
MAL Addiess

et thee appropiate optsan ta connect to your ISP

Choose this opticn 1o cbtain an IP address autornatically
fram your ISP. (For most Cable modem users)

Choose this option to sel static IP informalion provded to
you by your [SP

© PPPoE hoose this option o your ISP uses PPFOE. (For most
OSL users)
© Others PPTP and BigPond Cable
o peTR (for Ernge use only)

ifor Austraha yse only)

Orege (optional)
o 50 2C 07 Bl 25
(optionad) | Clone MAC Address |

Pnmary ONS Address 0600
Secandary DNS Addrets onon {ogteanal)
MY 1500

9 ©0

Apply Cancel Help

Figure 2-16: Clone the MAC address under WAN setfings.
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s Wireless
evices to Your
Network

A fter you have a wireless access point (WAP) up and running, your next
step is to add wireless devices to your network. To connect to your
wireless network, computers and other network devices must meet two
conditions:

w= Each device needs a wireless adapter. Some of your devices — such
as laptops — may already have built-in Wi-Fi capabilities. If not, you
can install an internal Wi-Fi card or add an external Wi-Fi adapter.

w= Each wireless adapter must be configured for the network. Each wire-
less device on your network must be able to find and access your WAP.

In this chapter, you find out how to add wireless computers to your net-
work. I go over how to install the hardware and configure the software to
make your wireless network function properly. I also describe how to find
available Wi-Fi networks within range of your computer, a task that may
come in handy if you visit a Wi-Fi hotspot. And you discover how to disable
your computer’s wireless adapter so that it doesn’t automatically connect to
wireless networks when you don’t want it to happen.

N R
Chapter

Getready to. ..

= [nstall an Infernal Wi-Fi Card..................... 24
w= Connect an External Wi-Fi Adapfer ............ 26
w= Configure the Adapter Software ............... 27
w= Start the Windows Wireless

Connection Utility 28
w= Display the Wireless Connection

System Tray Icon 29
= Search for Wireless Networks .................... 30
= Disable the Wi-Fi Connection....................... 3l
w= Reactivate the Connection .............cceee.... 31

w= Choose a Network Access Mode.................. 32



Chapter 3: Adding Wireless Devices to Your Network

Inﬁﬂ an Internal Wi-Fi Card
D ro p \QrQ Sacturer’s instructions to install the

Wi-Fi card software.

Make sure that you follow any special installafion instructions pro-
vided by the Wi-Fi card’s manufacturer. Most cards require you to
install the supporting software before physically installing the card
in your computer.

2. Leave the Wi-Fi card’s installation CD-ROM in the
CD-ROM drive and shut down your computer.

3. Disconnect all cables and move the case to a safe, clean
working area.

4. Open the case of your computer as described in the
manufacturer’s documentation.

Locate an open PCI slot (see Figure 3-1).

6. Use a screwdriver to remove the blank-off plate on the
back of the computer case next to the open PCI slot you
plan to use.

7. Carefully insert the network card into the PCI slot.
Secure the card in the case, as shown in Figure 3-2.

9. Reconnect all cables and restart your computer.

Figure 3-2: Secure the card in the case.
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Install an Internal Wi-Fi Card

10. Log in to Windows

D rO p@ﬁﬂk d New Hardware Wizard (see
[ hether or not you want Windows
Update to search for installation software for the card
and then click Next.

If the card’s installation CD isn't sfill in the CD-ROM drive, insert it
at this fime. If you have the card’s installafion (D, choose No, not
This Time in the Found New Hardware Wizard.

12. In the next screen, choose the Install the Software
Automatically option and then click Next to install
the driver.

If you see a warning that the hardware hasn't passed Windows
Logo testing, click Continue Anyway.

13. Click Finish to close the Found New Hardware Wizard.

Warning: Computer hardware is very fragile. If you don’t have
experience installing expansion cards in computers or making other
hardware upgrades, consider hiring a professional to install your
Wi-Fi card. Computer retailers can install cards and other hardware
you buy for a nominal fee.

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

windows will search for cument and updated software by
looking on your computer, on the hardware installation CO, or on
the Windows Update \Web site (with your permission).

i

o}

Can Windows connect to Windows Update to search for
software?

() ez, thiz time anly
() ez, now and every time | connect a device

() Mo, not this time

Click Mexst to continue.

Cancel

Figure 3-3: The Found New Hardware Wizard.

After installing a new wireless networking card, visit the manufacturer’s
Web site (it should be listed in the card’s documentation) and check its
support pages for any updates for your card. It's possible that the card
you hought sat on a store shelf for a couple of months, and during that
time the manufacturer may have developed some important updates.
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Chapter 3: Adding Wireless Devices to Your Network

Cougect an External Wi-Fi Adapter
D ro pngnQKSI adapter, such as the one shown in

Figure 3-4, that is compatible with your computer.

Most newer laptops have a cardbus slot that can accept a cardbus
Wi-Fi adapter, as shown in Figure 3-4. Other wireless adapters can
connect to a USB port or an Ethernet port.

2. Install the adapter’s software as described by the manu-
facturer’s documentation.

3. Connect the adapter to the appropriate port on your
computer and then turn on the computer’s power.

4. Follow the steps in the previous task to complete instal-
lation of the adapter’s driver software.

If you are using a cardbus-style Wi-Fi adapter in a laptop, remove
the adapter when you are transporting the laptop. Leaving the

adapter in the laptop’s cardbus slot may damage .

26

Figure 3-4: Cardbus Wi-Fi cards are compa-IibIe with most laptops. -

©)
©)

If you use a USB Wi-Fi adapter, make sure you connect it fo a USB port
directly on your computer, rather than a USB hub. Although connecting
the adapter to a USB hub might work, the likelihood of configuration
problems is greater.

Some external Wi-Fi adapters connect to an Ethernet port on your com-
puter, rather than a USB port or Cardbus slot. Adapters that use an
Ethernet port are actually called network bridges because they create a
bridge hetween an existing network connection and your network. See
Chapter 16 for more on using network bridges.



Configure the Adapter Software

Configure the Adapter Software

D ro p QIQ ﬁktop icon for the adapter software.

In many cases, a Wi-Fi adapter’s management software places an
icon in the Windows system tray, which is the area in the lower-right
corner next to the clock. You should be able to double-click the sys-
tem tray icon to open the adapter software.

2. When the program opens, locate the screen that lists
available networks.

3. If your network appears in the list, select it. If your net-
work doesn't appear, click Add under Preferred
Networks.

4. Enter the SSID for your network and choose encryption
settings that match the settings used in your WAP.

5. Enter the network key (see Figure 3-5).

6. Click OK and view your network in the Preferred net-
works list (see Figure 3-6). Click the Refresh button if
your network does not appear in the list of available
networks.

In Chapter 6, | describe how to set the SSID, encryption, and network
keys in your WAP. If you disable SSID broadcast as | recommend,
the network will not be visible o your new wireless computer unfil
you manually enter the SSID.

Sometimes the Windows wireless connection utility does a better job
of managing wireless connections than the software that comes with
Wi-Fi cards. If you are unable to connedt to your wireless network
using the card's proprietary software, iry using the Windows ufility
instead.

Witeless Netwatk Propeitios =]
Wesis Hetwark. Frogedes | suthantc shon
Network name (35101 SLien 1 T745
i b
This etk requines 3 kay o the iokowing
Mphweork: Authertication Doiy =
Data Encrppenn WEF -
Motk oy
Confmbey  sesersassresassesannssennd |

Kty nden [scdvircedt 1

[ Thit in & computes-to-comgater |ad hoc] Ptk wiekerr
acters ponty we ol used

[l Authesiticatis Prioe 1o Windews Login

| | _Coesl ) (]
Figure 3-5: Set the SSID and network keys.

& Belkin Wireless Utility (%]
She Munbay Usagrmales. Irfamatn
‘Wirskass Netwodia Link, S1aha Seatiecy

7] L this ool manage yous vireless seifing:
[ Erable Fiade
P

T connect 1o an avalsbls natwork. cich Configurs.

Rebeth

5 irvalebh

bk

1 SEweniTV4E

L. || e | | Poosie |

5] St woshors s s iyl l Advarced |

Lor [ coed ] [ )
Figure 3-6: Check for available networks.
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the indows Wireless
lity

Choose Start>All Programsr>Accessoriest
Communications=>Network Connections.

If your Wi-Fi card came with its own management software that is
currently running on your computer, disable it before activating the
Windows management utility.

In the resulting Network Connections window, double-
click the Wireless Network Connection.

In the Wireless Network Connection window, click Set
Up a Wireless Network for a Home or Small Office
under Network Tasks on the left side of the window.

In the resulting Wireless Network Setup Wizard screen,
click Next in the first screen of the wizard and then
enter your network’s SSID (see Figure 3-7).

If your network has a security key, choose whether it is
assigned manually or automatically.

Select the WPA checkbox at the bottom of the screen if
you use WPA encryption on your network. Click Next.

In the resulting screen, enter your network’s security key
if it's assigned manually, and then click Next again.

Select Set Up a Network Manually, click Next, and then
click Finish. Your wireless network should now be active
(see Figure 3-8).

Wireless Network Setup Wizard

Create a name for your wireless network.

Give wour netwark & name, using up ko 32 characters.
NMetwork name (5SI0%: SEren1TY46
() Automatically assign a network key (recommended)

secure key (also called a WEP or WPA key) to yaur network,

() Manually assign a network key

existing wireless networking using an old key,

compatible with WPA)

To prevent outsiders from accessing your network, Windows will sutomatically assign a

Use this option if you would prefer ta create your own key, or add a new device ko your

[ Use WPA encryptian instead of WEP (WP is stronger than WEP but not all devices are

[ <Back [ mext> | [ cancel
Figure 3-7: Enter the network’s SSID.
1 Wireless Network Connection 2 %]
network Tasks Choose a wireless network
. YR — mmmnhnwmmmuelnomuu.m«mwm
o T
ald

Figure 3-8: Your connection is now active.
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Display the Wireless Connection System Tray lcon

’S th ire,ess Connection _L Wireless Network Connection 2 Properties 2%
y [ General [wwireless Networks | Advanced :
r@ S |
B Belkin 802.11g Network Adapter
Thi ti the fallawing items:
Choose Start=>All Programs=>Accessories=> - ":hz:::s;;o;z e —
Communications=>Network Connections. B gg‘?gd O PRl e
05 Packet Scheduler
. . . . .’r‘fAEG\SP 1t HIEEEBU21] 3.2.03 b
2. In the Network Connections window, right-click your [ B T— >
wireless connection and choose Properties from the [ mstel. ][ sl ] [ Properies
resulting menu. e oo e ot
. A . nitwork,
3. Select the Show Icon in Notification Area When
Connected check bOX, as shown in Figure 3.9, sm_w ivon in rofication asa when conmected _
[] Motify me when this connection has limited or na connectivity
4. Click OK to close the Network Connection Properties
dialog box.

5. Locate the wireless connection icon in the Windows sys- Figure 3-9: Enable the system fray icon.
tem tray in the lower-right corner next to the clock, as
shown in Figure 3-10.

The system tray icon gives you quick access fo settings for your '.A
wireless connection, which comes in handy when you need to man- e
X N X . m
age your connection. Double-click the icon to open the Wireless
Network Status window, or right-click the icon for additional e a
opfions. Y
&

Hover your mouse pointer over the wireless network system fray
icon to quickly see the status of your wireless network. A foolfip
appears, showing the wireless connection speed and signal quality. »

M5N
tmstaller

(i)

£

Googln
Talk

]

Belkin
Wirele..,

Rucveln

|tecen
Figure 3-10: Check your network status.




Chapter 3: Adding Wireless Devices to Your Network

Drop&0o0ks

h for,Wireless Networks

1reless connection icon in the

Wlndows system tray.

2. In the Wireless Network Connection Status dialog box,
shown in Figure 3-11, click the View Wireless Networks

button.

3. In the resulting Wireless Network Connection window,
shown in Figure 3-12, click Refresh Network List in the
Network Tasks menu on the left side of the screen.

30

The system fray is the area in the lower-right corner of the screen,
next to the dock. If you don't see a wireless connection icon there,
see the previous task to enable the icon.

Use the Wireless Network Connection window to manage your net-
work connections. Using this window you can connect or disconnect
from networks, or change the order of preferred networks when
more than one is available.

" Wireless Network Connection 2 Status 2%
|VEEHEIE| E.Suppgﬂ-. B B B B . -
| staus Comnected | |
Network: SErenlTY4E |
Duration: 01:17:52 |
Speed. 54.0 Mbps
Signal Stiength aill |
Activity |
St ')j & Focoed |
=,
i ()
Packets: 2583 | 2787
Froperties ] [ Dizable ] l View Wirgless Netwarls ]
Close:

Figure 3-11: Click View Wireless Networks.

1 Wireless Network Connection 2 %]
Network Tasks Choose a wireless network

mmumuhn oo b connect b & wirshkess natwerk in range o o gt more

((E’) SEFENITY4E Cannected o
s e aild

| Disconnees |

Figure 3-12: lick Refresh Network List to see available networks.



Reactivate the Connection

Dls e the i-Fi Connection

p &SS connection icon in the Windows

system tray, shown in Figure 3-13.

2. Choose Disable from the context menu that appears.
The connection is disconnected, and the wireless con-
nection icon disappears from the system tray.

Right-clicking the wireless connection icon in the Windows system
tray gives you access fo several useful commands relating to the
wireless connection. You can also use this context menu to quickly
view a list of other available networks or to review the status of the
connection.

It's a good idea to disable your wireless connection if you are work-
ing in a remote location where other un-trusted wireless networks
or computers may be active. Disabling your wireless connection pre-
vents other networks and computers from accessing your computer.

Reactivate the Connection

1. Choose Start=>Connect To.

2. In the submenu that appears, choose your wireless con-
nection (see Figure 3-14). The connection is restored,
and the wireless connection icon reappears in the
Windows system tray.

If you want fo connect to a different network, choose Show All
Connections from the Connect To menu. In the Network Connections
window that appears, right-click the wireless connection and choose
View Available Wireless Networks. You can then choose a different
wireless network, if others are available.

i |
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Reader 5.8 DVD Bask

f.u‘ A

Adobe  betmihcnsal
Aciobat 58 Player

A

Adobe
Phatash_

Swdin
Varsion 8§

A

Adabe
Render 79

»
SN
Irstaller

]

Belkin
Wirele,.,

Dinable
Status
Repalr

2 Wiirw Available Wirsless Notwedks

Macycln Changs Windows Hiswall satings
Bin
Open Harwork Connecians

M W eirid it | werguan —
Figure 3-13: Disable the connedlion.

Heith]
| 2 termet
; (‘5’5' Intermet Explorer _J My Documents
Adobo Premiare 3 My Racent ,
Hl Eloments 1.0 = Dacumants
‘5‘] E. |||.|I| ) My Pictures
iflock Expres
5 My Music
w Paint =
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:dg Notepad
on D’ Control Panel
@| Studio Version 8 @ ol Promant Accaee
and Defaults |
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&8 Holp and Suppont
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Alprograms [ =7 Ruan...

| <] Log OfF 5] Shut Down

]
Figure 3-14: Reconnedt to your wireless network.
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gse a Network Access Mode
ogg ireless connection icon in the

Windows system tray.

In the Wireless Network Connection Status dialog box,
click the Properties button.

In the Wireless Network Connection Properties dialog
box, click the Wireless Networks tab (see Figure 3-15).

Click the Advanced button to open the Advanced dialog
box (see Figure 3-16).

Choose a network access mode:

¢ Any Available Network: The computer tries to con-
nect to any wireless network that is detected.

e Access Point (Infrastructure) Networks Only: The
computer tries to connect to networks using a wire-
less access point. This setting gives you more security,
especially at Wi-Fi hotspots.

¢ Computer-to-Computer (ad hoc) Networks Only:
The computer tries to connect to other computers,
called ad hoc networking. See Chapter 13 for more
on using ad hoc networks.

If you want to automatically log on to any available
wireless network, select the Automatically Connect to
Non-Preferred Networks check box.

Automatically logging on to any available network could leave your
computer vulnerable to unknown and untrusted networks. Do not
enable this option if your computer contains sensitive or personal
information.

Click Close to close the Advanced dialog box and click
OK to close all remaining dialog boxes.

_L Wireless Network Connection 2 Properties 2%

General | wireless Metworks | Advanced
Use Windows to configure my wireless network settings
Awailable netwarks:

To connect ta, disconnect from, or find ouk more infarmation
about wireless networks in range, click the button below,

Wiew Wireless Networks
Prefermed netwarks:

Automaticaly connect to available networks in the arder listed
below:

[ SErentTv48 (Automatic] [

Add... H Remave ][ Froperties ]

Leam about setiing up wieless network Advanced
configuration.

(ot
Figure 3-15: Open the Wireless Networks fab.

Advanced %]

Netwarks to access
(%) Any available network [access point preferred)
() Access point (infrastiucture] networks only

() Computer-to-computer [ad hoc] networks only

[ Automatically connect to non-prefered netwarks

Close

Figure 3-16: Choose a network access
mode.
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etwork

hances are you have two main reasons for setting up a home network:
you want to share an Internet connection between your computers and

you want to be able to copy files between computers. I discuss how to share
an Internet connection in Chapter 2, and in this chapter I cover how to
share files. If you want to share files between your computers, you need to
do the following:

)

)

=

Share folders: Computer files are organized into folders on your
hard drive. In Windows and Mac OS X, access to those folders is
strictly controlled. If you own a folder, other computers on your
network — and even other users on the same computer — can't
access it. To copy files back and forth over the network, you can
share folders with others.

Log in to other computers: If your network is all Windows or all
Macintosh, sharing files back and forth is easy. But if you have a mix
of Windows PCs and Macs, you'll have to go through a special log in
procedure before you can share files and folders.

Transfer files: Actually copying files across your network is the final
step. I show you how to copy files between network computers,
whether your computers are Windows PCs, Macs, or a mixture

of both.

R R
Chapter

Getready to. ..

= Share a Folder in Windows ........................ 34
= Access a Shared Network

Folder in Windows 35
w= Enable File Sharing in 0S X........................ 36
w= Change the Workgroup Name in 0S X........36
= (reate a Windows User Account.................. 3

= Log In to a Windows PC from a Mac .......... 38
= Log In to a Mac from a Windows PC .......... 40
w= Copy Files Between Networked Macs .......... 4
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g&j a Falger in Windows

QQ Programs=>Accessoriest>

Communications>Network Connections.

In the Network Connections window, right-click your
network connection and choose Properties from the
menu that appears.

In the Network Connection Properties dialog box, select
the File and Printer Sharing for Microsoft Networks
check box, as shown in Figure 4-1.

File and Printer Sharing may already be enabled on your com-
puter, but you should double-check it to make sure.

Click OK to close the dialog box.
Open My Computer or Windows Explorer.

Locate the Shared Documents folder. Right-click the
Shared Documents folder and choose Sharing and
Security from the menu that appears.

In the resulting Properties dialog box, select the Share
This Folder on the Network check box (see Figure 4-2).

Type a descriptive name for the folder in the Share
Name field.

Click OK to close the Properties dialog box.

To share files or folders, copy them into the Shared
Documents folder using My Computer or Windows
Explorer.

To create a new subfolder in the Shared Documents folder, open
Shared Documents and then choose FilecoNewcoFolder. Give the
new folder a descriptive name.

L. Wireless Network Connection 2 Properties 2]

“General | Wireless Metworks | Advanced |

Connect using;

BB Belkin 802110 Network dapter

This connection uses the following items:

2 Client for Microsoft Metworks
¥ J=IFile and Frinter Sharing for Miciosoft Networks
W = 005 Packet Scheduler

| ¥ %= EGIS Protocol IEEE 802141 v3.2.0.3 i
led >
[ Install. I [ Uninstall

Description

Allaws ather computers to access resoUIces an pour computer
uzing a Microsoft netwark,

Show icon in notification area when connected
[] Motify me when this cannection has limited or na connectivity

[ o]

Figure 4-1: Enable File and Printer Sharing.

Shared Documents Properties €] %]

General | Shating | Web Sharing|

Local sharing and security

g To share this folder wi

g_! only, drag it to the £hs
To make this folder and its subfalders private sa that

only you have sccess, select the fallowing check box.

of this computer
11 Folder,

Mebwark sharing and security

") To share this folder with bath network users and ather
.JS.J ugers of this computer, select the first check bax below
= % andtype a share name.

Share this folder on the netwaork.
Share name: | SharedDocs

Allaw network. users to change my files

Leam more about sharng and securt

i Windows Firewal is corfigured to allow this Folder to be shared
with other computers on the network

Figure 4-2: Share the folder.



Access a Shared Network Folder in Windows

ccess a Shared Network
D rcm@ s

Choose Start>My Network Places.

You can also access My Network Places from My Computer or
Windows Explorer. In My Computer, dick My Network Places under
Other Places on the left side of the screen. In Windows Explorer,
click My Network Places near the bottom of the folder tree on the
left side of the screen.

In the My Network Places window that appears, as shown
in Figure 4-3, double-click the network place that you
want to open.

If you don't see a network folder that you think should be avail-
able, make sure that the computer containing the network folder is
turned on and connected fo the network. Also, double-check the
file sharing settings on the other computer as described in the pre-
vious task.

Browse the network folder (see Figure 4-4).

To copy an item to a shared network folder, simply click
and drag it to the shared folder’s window.

You can also use Cut, Copy, and Paste commands when browsing
shared network drives.

When you share a folder, anyone on your network can access it. Do
not store private or sensitive files in shared folders.

&) My Network Places B@.
File Edit View Favorites Tools Help -
@ Back - T y. ! Search || Folders '

Address | %) My Network Places V =4 Go

Netwark Tasks < ‘ ﬂl D-Link Router
g Add & network place -

& View network connections

; HKeith's Pictures on Keith's Main PC
,,J (Soyopd)
-

# Set up & home or small
 office network

<2 Sst up & wirelsss network
for & home or small office

‘l" Wiew workgroup computers

E Hide icons For networked
UPnP devices

 SharedDocs on Keith’s Main PC
— (Soyopd)
i

3 SharedDocs on NLE machine

.—(j (Nle-machine)
Other Places ¥ =
Details R

My Network Places
System Folder

4 objects

Figure 4-3: Choose a network place.

. SharedDocs on Keith's Main PC (Soyopd) B[]
File Edit View Favorites Tools Help l,:'
0 Back - () ,m‘ /- ! Search || Folders El'

Address \4 \\Suyupd\shareddnns 1 B 6o

File and Folder Tasks 2 E= 9.02

‘j Make a new folder
8 Publish this folder ta the
Web

|/} Adobe PDF
Other Places ¥ o
) fonts
[

Details A
SharedDocs on Keith's Main
PL (Soyopd4) /J FZ
WSovopdishareddocs

/l iconstud

/! images

|

s
48 ohjects (plus & hidden) 1.28GB ‘j Local intranet

Figure 4-4: Browse the folder.
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En

DropB09

2.

le Filekssﬁarinq in 0S X

erences from the Apple menu and
then click Sharing.

In the resulting Sharing control panel (see Figure 4-5),
provide a descriptive name for your computer. (Other
computers will see this name over the network.)

Select the Personal File Sharing check box. If you will be
sharing folders with Windows PCs, check the Windows
File Sharing option as well.

Close the Sharing control panel.

These steps assume that you have Mac 05 Version 10.2 o better. If
you have an earlier version of the Macintosh operating system, |
strongly recommend that you upgrade. Windows File Sharing is only
available in Mac 0S 10.2 or better. Sharing files between Windows
and older versions of Mac 0S require special third-party programs.

Change the Workgroup Name in 0S X

1.

36

Open the Applications folder on your hard drive and
then open the Utilities subfolder.

Double-click the Directory Access utility to open it.

Click the lock icon at the bottom of the Directory
Access utility and then enter an administrator name
and password.

Select SMB/CIFS on the Services tab and then click the
Configure button.

Enter your Windows workgroup name in the Workgroup
field (see Figure 4-6) and click OK.

e 0 Sharing

Computer Name: iMac

Rendezvous Name: iMac .local

}ﬁervices ]' Firewall f Internet |

Network Address: 192.168.0.106 ( Edit..

Select a service to change its settings.
[ on  service

Personal File Sharing
Windows File Sharing

Personal Web Sharing

Remote Login

FTP Access

Remote Apple Events

Printer Sharing

Personal File Sharing On
“ stop )
Click Stop to prevent users of other

computers from accessing Public folders on
this computer.

Do0AOBEE

Other Macintosh users can access your computer at afp://192.168.0.106/

=
\ij Click the lock to prevent further changes.

1Y

Figure 4-5: The Sharing control panel.

a8 Directory Access
S — Workgroup: FREELANCEl E‘ D —
'Enah\e__ WINS Server:
5]
v
¥ I5ARI T5%6
] Netinfo 1.5.1
¥ NS 1.0
z Rendezvous 1.01
¥ sip 1.0
V¥ smE 1.0
. Configure...
—
é/ Click the lock to prevent further changes. Revert Apply

Figure 4-6: The Directory Access utility.




Create a Windows User Account

Creﬁa Wl&dom User Account

&nces from the Apple menu.
2. Click the Accounts icon to open the Accounts window.

3. Click New User (OS 10.3 and earlier) or the plus sign in
the lower-left corner of the Accounts window (OS 10.4
and later).

4. Enter a name, short name, and password for the user
(see Figure 4-7).

| recommend naming the account Windows to help you remember
the purpose of the account lafer.

5. Select the Allow User to Log In from Windows check
box if you see it.

As the name implies, this option enables users to log in using this
account on Windows PCs. This option is not available (or required)
in newer versions of Mac 0S X.

6. Click Save or Create Account (depending on your OS X
version) to save the new user account. The Windows
account now appears in the list of user accounts, as
shown in Figure 4-8.

Because Mac 0S X is based on UNIX, user account names and pass-
words are case sensitive. Make sure that Windows users on your
network know this, because if the user name is “Windows” and they
try to log on using “windows,” the log in attempt will be unsuccessful.

Accounts =

Name: Windows B
Short Name: windows

New Password: ssssssses _’4‘
Verify: sesesssss | N

Password Hint:

(optional)

Picture Drag a picture from the Finder, select one below,
= _ | orclick Choose Another to Incate a picture file.  —
( Choose Ancther... )
% g '9'«
25 e
- | 4w
h
3/ ] Allow user to administer this computer
™ Allow user to log in from Windows
Figure 4-7: Nome the Windows user account.
80 Accounts =
F'Users** Login Options |

[Picture | Name [Type s
. New User... )
Keith Underdahl Admin e
{ Edit User... ),

Capabilities
Windows

Ld =

F P W m—
Set Auto Login...

Delete User

3 Click the lock to prevent further changes.

Figure 4-8: The Windows account appears in the list.
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LogJn to ¢ Windows PC from a Mac

D ro p QCQ : 10.3, choose Go=>Connect to Server.

In OS 10.4 and later, open Finder and then click
Network.

You may need to wait several seconds for the list of computers to be
populated. In some cases you may also see a Windows workgroup
name listed. If you see the workgroup, double-click it to open it.

2. In the Connect to Server window (OS 10.2 or 10.3),
click the name of the computer to which you want to
connect. In OS 10.4 and later, double-click the folder
bearing the name of your Windows workgroup to
browse the workgroup (see Figure 4-9).

By default, newer Macs are set with the default workgroup name
“Workgroup.” This probably isn't the correct workgroup name for
your Windows workgroup. To check the workgroup name for your
Windows network, go to a Windows PG, right-click the My Computer
icon, and choose Properties from the menu that appears. In the
System Properties window, dick the Computer Name tab fo bring it
to the front. The workgroup name is listed on this tab. Click OK or
Cancel to close the System Properties window.

3. Double-click the computer to which you want to
connect.

4. In the resulting SMB/CIFS Filesystem Authentication
dialog box (see Figure 4-10), type a username and pass-
word for an account on the Windows computer to
which you are trying to connect and click OK.
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§ Plerures
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Figure 4-9: Choose the computer to which you want to connet.

Workgroup/Domain

SME/CIFS Filesystem Authentication
o Enter username and password for SOYOP4

FREELANCE

Username

Keith Underdahl

Password

----------

] Add to Keychain

Cancel ) @

Figure 4-10: Enter log in information.



Log In to a Windows PC from a Mac

If you only want to access shared items on the Windows P, just 1 Freeance B
pier afly me and leave the password field empty. Doing so 2 —
D ro p @ tgo public items on the Windows PC. s o )
-~ ) Nie-achine

[ oesvon

5. Choose a volume that you want to mount (see -
'_ (8} kenthunderdant

Figure 4-11).

Select the 5MB/CIFS shared volume you want to

-& Applications -
I o @ connect to.

Items in the list of things you can mount include shared folders, as ; [3 coaens

SharedDocs 4]

well s folders owned by the user account you are using to log in fo L Jaee I
'he WindowS P(' § Music [ Cancel Authenticate Again ) (0K
! & ) Pictures
6. Click OK. The selected item mounts on your computer | ]
o L0f 2 selected, Zero Kb avallabie e

as if it were a disk drive or volume.
Figure 4-11: Find the shared volume.

7. Double-click the network volume’s desktop icon to
browse its contents (see Figure 4-12).

|06 = 4 SHAREDDOCS ')
ERE [ Q
In Mac 0S 10.4 and later, you can also access mounted volumes & — e pa R
H : f i d i / {59 Newwork = By [ 0,02 Apr 27, 2005, 10:06 A
directly from Finder. In the Finder window, simply click the volume’s . S o i e
icon in the Upper—lefi corner. I é MacintoshiHD, [7] 541145 CSAR.doc Apr 28, 2003, 2:57 PM
.~ - [ 783285 chz0.doc Jan 1, 2006, 9:21 AM
|) 783285 intro.doc Jan 3, 2006, 8:34 PM
3 » [ Adobe PDF Oct 17, 2005, 8:40 AM
8. Click and drag files to copy them between computers. (g oesteop B Aces o a3 005 s
M ¥ bph08402.pdf Jun 29, 2005, 12:03 AN
. keithunderdahl i ' 2000, 10:
If you only want fo access shared folders on the Windows PC, enter /& :‘ i_m e e |
any user name in Step 4 and leave the password blank. You will still X Apelicarions Bllcolelvavil Jul 23, 2005, 3:03 P
. . 4 3 L] desktop.ini Apr 26, 2005, 7:10 AM
be able fo log in to the Windows PC, although you will only be able [ pocumens B DsCF0305.7G 1l 15, 2005, 11:03 AM
h d f Id i # exterminate.jpg Mar 23, 2005, 11:25 Ph
to access shared rolaers. E | Firefox Setup 1.0.3.exe Apr 26, 2005, 6:51 AM
& Hisic b [ fonts Jul 20, 2005, 11:05 AM
< > [Erz Jun 16, 2005, 5:13 PM
il ¥ hp.if Jun 14, 2005, 10:22 AN
» | iconstud Sep 16, 2005, 1:45 PM
F R y———————————— ,—_—_—_—-‘ IR RE =
49 items, 70.03 GB available /24

Figure 4-12: Browse your Windows PC from your Mac.



Chapter 4: Using Your Wireless Network

Lo

Dro

40

n to ¢ Mac from a Windows PC

Places from the Windows Start menu.

Click View Workgroup Computers under Network Tasks
on the left side of the screen to display the list of work-
group computers on the right (see Figure 4-13).

Macintosh computers may have the word Samba in front of their
names in the list of workgroup computers. Samba is the Mac 0S X
software that allows Windows and Macintosh PCs to network with
each other.

Double-click a Macintosh computer in the list.

In the resulting Connect To dialog box, enter the user
name and password for the Windows user account on
the Mac, as shown in Figure 4-14.

Click OK to log in. After you are logged in, you can see
a list of available files and folders on the Mac.

You can only access items that are owned by the Windows user
account on the Mac. If you want to share items with other user
accounts on the Mac, store them in the Public folder. Each user's
Public folder in Mac 0S X is shared with other users.

# Freelance ==X
. File Edit Yiew Favorites Tools Help >
: = »
e Back ~ (gJ |ﬁ.‘ P ! Search : norton Antivirus 51
Address | ) Freelance |Vi Go
LA 2 »:/@ Compagq Laptop (Compay2170)

o Add anetwork place

e,- Wigw nebwork conneckions

% Set up ahome or small LJE Samba 2.2.3a (build 26) {Imac)
D

office network
‘J‘-"} Wiew workgroup computers

B
h'g KEITH UNDERDAHL (Keith)

4

Other Places

A
Details ¥ ‘!"4@ CJ and Cole's PC (Kids)
o

4 objects

Figure 4-13: View workgroup computers.

Connect to Imac &g

=
R

Connecting ko Imac

T
User name: | € windows | i

Password: sssnsnnnns

L O ][ Cancel ]

Figure 4-14: Log in to the Mac from Windows.




Copy Files Between Networked Macs

C
Drop.

iles lEtw'een Networked Macs
aQQ). Slater, double-click your hard drive

icon to open Finder. In older versions of Mac OS X,
Choose Go=>Connect to Server and skip ahead to
Step 3.

You can also open Finder from the Dock.

In Finder, click Network.

If you don’t see your other Mac listed in the network window, open
the My Network folder. If you have Windows PCs on your network,
you may also be able to access other Macs through the folder for
your Windows workgroup.

Double-click the computer to which you want to con-
nect, as shown in Figure 4-15 (OS 10.4 and later) or
Figure 4-16 (OS 10.3 and earlier).

In the login box that appears (OS 10.4 and later shown in
Figure 4-15), log in using one of the following options:

¢ Guest: If you log in as a guest, no user name or pass-
word is required. You will only be able to access public
folders on the network computer.

e Registered User: You must enter a valid user name
and password for a user account on the network
computer. When you log in as a registered user,
you can access that user’s files and folders.

Click the Connect button.

In the dialog box that appears, choose a volume that
you want to mount and click OK.

ann | My Network =
o - i{8ti= mi &-] 2
! -
( B rerwor — (9
T Maciniouh Hp » gl s Connect to Server
s [ iMac
q“_‘\ SHAREDOO, . = - Cannect to the file server *Mac.”
i
m Desktop - :
f " Connmect as: [_ Cuest
4?\ keithunderdanl ) Registered User
Il A Applications Nama: Keith Underdahl
1 cocumeens i | e
o | Remember password in keychain
u Movies
@ —_— ., _'tlnn'L ] Eﬁmnm3
[ Pictures
'x 1 of 1 selected, Zero K avaitible _,5‘:'

Figure 4-15: Log in from 0S5 10.4 and later.

After you connect, you will see an icon for the network computer on
your desktop. Double-click this icon fo access the network computer.

Connect to Server

Chaoose a server from the list or enter a server address
At: | @ Keith Underdahl's iB... |+] (&)

B iMac

&8 Keith Underdahl's iBook G4
£ NLE-MACHINE

& NLE-MACHINE

& sovora
Name: Keith ...ahl's iBook G4
Service: afp
Location: local
5 items Searching... %
Address:

Add to Favorites

|

Figure 4-16: Log in from older versions of 0S X.
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Drdfeérss Networking
with Vour Mac

Wndows PCs aren't the only computers that can take advantage of Wi-
Fi networks. Macintosh computers have been at the forefront of wire-
less networking with AirPort, Apple’s name for the Wi-Fi technology used in
modern Macs. Most new Macs have AirPort Extreme — a newer, faster

version of AirPort — built right in, and even if you buy a new Mac without
AirPort Extreme you may be able to install a card. By using AirPort or

AirPort Extreme, you can connect your Mac to any 802.11b/g Wi-Fi network.

In this chapter, I discuss how to use AirPort to connect your Mac to Wi-Fi net-
works, whether at home or at a hotspot. If your computer doesn't already have
AirPort, I show you how to install an AirPort Extreme card in your Mac. Before
you buy an AirPort Extreme card, however, make sure that your computer is
AirPort Extreme-ready. If you're not sure that your Mac is compatible, visit
http://docs.info.apple.com/article.html?artnum=107440.

S Some Macs — such as the Mac mini — can only be upgraded by an Apple repair pro-

fessional. When you buy a new Mac, spend a little extra money to get an AirPort Extreme
card preinstalled — it's worth it.

N R
Chapter

Getready to. ..

w= |nstall an AirPort Card in an iBook ............ 44
w= |nstall an AirPort Card in an eMac............... 45
w= Update AirPort Software ...........cccceeeeeeeeee. 45
w= Connect to a Wi-Fi Access Point .................. 46
= Manage Wi-Fi Networks ..........cccceeereerne. 47
w= Set Up WEP Encryption ...........coveevceeunnnnne. 48
w= Configure WPA Encryption..........cccococecce.e. 49

w= Disable AirPort 50
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Il an AirPort Card in an iBook

D ro ﬁ. ook and remove the battery.
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To remove the battery, use a coin to furn the lock screw on the bot-
tom of the iBook fo the unlocked position.

On the front of your iBook, push the keyboard release
tabs (see Figure 5-1) towards the front of the iBook and
gently lift the keyboard out of the chassis.

You don't need fo disconnect the keyboard; simply rest it upside
down on the touch pad.

Locate the built-in AirPort antenna in the space pro-
vided for the AirPort card (see Figure 5-2).

If you don't see a space for the AirPort card, as shown in Figure 5-2,
your iBook either is not compafible with AirPort or it already has
AirPort installed.

Connect the antenna to the antenna port on the AirPort
card.

Insert the AirPort card into the slot, ensuring that the
connector pins seat firmly in the AirPort card socket.

Do not force the card into position. If the AirPort card and the port
on your computer don’t match, you probably have the wrong kind
of card for your iBook model.

Seat the AirPort card wire retention clasp and replace
the keyboard and battery.

tab tab

1
_4_..-—----‘IZ

[ =—=—————————
Figure 5-1: The keyhoard release tabs.

Figure 5-2: The AirPort card slot under the keyboard.



Update AirPort Software

AirPort card slot

Instql( an Akl’ort Card in an eMac
D ro p Qeg - 51 disc tray and leave it open.

2. Shut down your computer and make sure that the
power is off.

Disconnect the power cable to make sure that the computer doesn’t
accidentally turn on while you are installing the card.

3. Remove the two Philips-head screws on the cover
inside the disc tray to reveal the AirPort card slot (see

Figure 5-3). Figure 5-3: The AirPort card slot.
4. Disconnect the antenna from the cover and then press
the antenna into the AirPort card’s antenna port. Softwarelipdate
5. [Insert the AirPort card firmly into the slot until it seats (@ [ ofuse e eatnie o your computer.
and then reinstall the cover inside the disc tray. b 07 e i
Install Name Version Size
L AirPort 4.2 12.3 MB |
Update AirPort Software e s B
p @ Java 1.3.1 and 1.4.2 Release 2 2.0 45.3 MB
< a8 iTunes Phone Driver : £is) 380 KB
o @] QuickTi 7.0.3 33.1MB
1. Make sure that your Mac can connect to the Internet e e Gin i
using a wired solution, such as a direct connection to a 0 iPod Updater 2005-11-17 36.8MB L
o © [ Mac0SXUpdate 10.4.3 97.0ME v
modem or an Ethernet cable, to network with a shared _ SR ——
COI‘IHeCtiOH. :Jii:t‘):;:;x:rsk:?nnectlon problems and resolves security issues with WPA2
See Chapter 2 for more on using a shared Infernet connection with
your Mac.
2. Turn on your Mac and choose Applem>Software Update Cor)
to run the Software Update (see Figure 5-4). >
3. Download and install any necessary updates to your Figure 5-4: Check for updates.

computer that are identified by Software Update.
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ect tj{r Wi-Fi Access Point

Seady enabled, click the AirPort icon on
the menu bar in the upper-right corner of the screen
and choose Turn AirPort On.

Click the AirPort icon in the menu bar again and choose
Other to connect to a new Wi-Fi network.

If the access point is set to broadcast its SSID, it may appear in the
list of available networks in the AirPort menu. If you see the net-
work to which you want to connect listed, click its name.

In the resulting Closed Network dialog box (see Fig-
ure 5-5), enter the network’s SSID in the Network
Name text box.

Choose a Wireless Security method as needed for the
network.

I show how to change WEP and WPA-PSK keys later in this chapter.

Click OK to connect to the network.

Check the status and signal strength of the Wi-Fi net-
work by clicking the AirPort icon in the menu bar and
choosing Open Internet Connect (see Figure 5-6).

Closed Network

Choose a security type and enter the name of the AirPort
network to join with an optional password.

Network Name: SEren1TY46 I:i
Wireless Security: "None [ :-]
® (" Cancel ) @

Figure 5-5: Enter the network’s SSID.

@ Intermet Connect File Edit Comnect Window Help

ene AirPort (=]
® o > a8
Summary | termat Moders Buriooth Mirpors | P
AirPort Power: On Turn AirPart OF
Netwerk: | SEran1TY46 #
Sgalleve: BABBRDERORRRARRNRD
Base Stasion ID: 00-00/8A:0:£4.63

¥ Show AirPort statie in menu bar

SERbuR: Comnected 1o “Fres TV

B Do saasiem

Turn AlsPorn Off l

o SEren1TY46 .
Other...
Create Nenwork
Use Interference Robustmess

=]

Figure 5-6: Check signal strength and status.
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Manage Wi-Fi Networks

Man
op

e Wi£i Networks
ol

Preferences window.

m Preferences to open the System

Click the Network icon to open the Network dialog box.

Choose AirPort in the Show menu to reveal AirPort set-
tings (see Figure 5-7).

In the By Default, Join menu, choose Preferred Networks.

In the resulting list, rearrange the order by clicking
and dragging networks up or down in the list (see
Figure 5-8).

AirPort attempts to connect with the network at the top of the list
first, and then moves down the list in order.

To remove a network from the list, click the network to
select it and then click the Remove (-) button.

Select a network and choose Edit to change encryption
keys and other network details for a given network.

When you are done making changes, click the Apply
Now button and then quit System Preferences.

8e8o Network

[« ) Gt a

Location: _Automatic s

Show: [ AirPort )

AppleTalk  Proxies |

————————{ AirPort  TCP/IP | PPPoE

AirPort ID: 00:14:51:79:7e:de

By default, join: | Automatic v

AirPort remembers the networks this computer has joined. If none of
the remembered networks are available, AirPort will ask before
joining an open newwark.

¥ Show AirPort status in menu bar @
QP —
[ Click the lock to prevent further changes. Assist me... Apply Now

Figure 5-7: Choose AirPort in the Show menu.

86o Network

|« » || showall CY

Location: | Automatic

g

Show: | AirPort

[ AirPort | TCP/IP  PPPoE  AppleTalk | Proxies '

AirPort ID:  00:14:51:79:7e.de

By default, join: | Preferred networks H
Network Name ~ Security
SErenlTY46 WEP

NTEC
tmobile one
ACTIONTEC None
+[ - |[ et |

AirPort will connect to the first available network in the list. If none
are available, AirPort will ask before joining an open network. Drag
the network name to reorder the list,

( Options... ) ¥ Show AirPort status in menu bar @

( Assistme... ) ( Apply Now )

n
[J Click the lock to prevent further changes.

Figure 5-8: Networks at the top of the list are most preferred.
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Encryption

Set Up WEP
D ro pgggy stem Preferences to open the System

48

Preferences window.

Click the Network icon to open the Network dialog box.

Choose AirPort in the Show menu and choose Preferred
Networks in the By Default, Join menu.

Select a network in the list of networks and click Edit.

In the Wireless Security menu, choose a WEP option, as
shown in Figure 5-9. Choose ASCII or HEX as appropri-
ate for your network.

If you're not sure whether fo choose ASCII or HEX, or if your net-
work uses 64-bit WEP encryption, choose WEP Password instead.

Enter the WEP key in the password text box shown in
Figure 5-10.

Click OK and then quit Network Preferences.

To make sure you're typing the WEP key correctly, temporarily select
the Show Password check box so that you can see the characters
you are typing. Make sure no one is looking over your shoulder
when you do this.

0eon Network
e
Choose a security type and enter the name of the AirPort |
network to join with an eptional password.
Network Name: SEren1TY46 &3]
Wireless Security v None i

WEP Password |
~+ @ WEP 40/128-bit hex

WEP 40/128-bit ASCII I

LEAP

By default, join: | Pl \wpa personal

Network Name WPA Enterprise

SEren1TY46 | WPA2 Personal
tmobile WPA2 Enterprise
ACTIONTEC 802.1X WEP

+| - || Eair

AirPort will connect to the first available netwark in the list. If none
are available, AirPort will ask before joining an apen network. Drag
the network name to reorder the list.

=

Options... (V| Show AirPort status in menu bar &)

iyl — —
J'\ Click the lock to prevent further changes. ( Assistme... ) [ Apply Now )

Figure 5-9: The Wireless security menu.

Network

000
EH |

= Choose a security type and enter the name of the AirPort |——=
network to join with an optional password.

Network Name: SErenlTY46 i3]

Wireless Security: | WEP Password H

Password: eeesscssssccsccsccsscsncens
[ Show password

@ (Cancel ) EEOKED)

Network Name Security
SErenlTY46 WEP
tmobile None
ACTIONTEC None

+| = || Edit
AirPart will connect to the first available netwark in the list. If none

are available, AirPort will ask before joining an open network. Drag
the network name to reorder the list.

( Options... ) ZShnwAirPnrt status in menu bar @

1l e
Jll Click the lock to prevent further changes. (_ Assist me... ) Apply Now )

Figure 5-10: Enter the WEP key in the Password fext box.



Dr

Configure WPA Encryption

Con

Op

f‘g@ure MKA Encryption
Q m Preferences to open the System

Preferences window.

Click the Network icon to open the Network dialog box.

Choose AirPort in the Show drop-down menu and
choose Preferred Networks in the By Default, Join
menu.

Select a network in the list of networks and click Edit.

In the Wireless Security menu, choose WPA Personal, as
shown in Figure 5-11.

WPA Personal is equivalent to WPA-PSK, which is used by many
wireless access points. WPA Enterprise requires that a RADIUS
server be running on your network, something your home network
is not likely fo have.

Enter the WPA password in the password text box
shown in Figure 5-12.

Click OK and then quit Network Preferences.
WPA encryption is much more secure than WEP encryption. You

should use WPA-PSK/WPA Personal encryption on your home wire-
less network unless you have computers that only support WEP.

NGHE
- | WEP Password
Choose a security typ  yep 40,/128-bit hex
network to join with af WEP 40/128-bit ASCIl

Network Namg ~ LEAP ]

(LAITERTLNL ~ WPA Personal
WPA Enterprise

Password  \WpA2 Personal ¥
| WPA2 Enterprise |
| 802.1X WEP

T TWeewo NamE Seeury
SEren1TY46 IWYEE:
tmobile blone
ACTIONTEC one

+ = Edit a

AirPort will connect to the first available netwark in the list. If none
are available, AirPort will ask before joining an open network. Drag
the network name to reorder the list.

Options... (¥| Show AirPort status in menu bar @
('] Click the lock to prevent further changes. Assist me... Apply Now
o
Figure 5-11: Choose WPA Personal.
0o Network
|«
Choose a security type and enter the name of the AirPort EEE——
network to join with an optional password.
Network Name: SErenlTY46 kS
Wireless Security: | WPA Personal )
Password: sseesssssscsassssnscassscs |
[ Show password
® Eo) GEED
Network Name Securfty
SErenlTY46 WEP
tmobile None
ACTIONTEC None
+ | = || Edit
AirPart will connect to the first available network in the list. If none
are available, AirPort will ask before joining an open network. Drag
the network name to reorder the list.
TR = = = o
( Options... ¥ Show AirPort status in menu bar Q)
[ Click the lock to prevent further changes. (_ Assist me.. Apply Now

Figure 5-12: Enter the WPA password in the Password fext hox.
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Disable AirP
D ro p QQ con in the menu bar and choose Turn

AirPort Off, as shown in Figure 5-13.

You should disable AirPort whenever you are not using it, especially
when you are working in a public area. Leaving AirPort enabled
allows others to potentially access your computer.

2. Choose Apple>System Preferences.

3. Click the Network icon in System Preferences to open
the Network settings window, and then choose AirPort
in the Show menu.

4. In the resulting AirPort settings, click the Options
button.

5. Select automatic connection options, as shown in
Figure 5-14.

To maintain control over your wireless network connections, choose
the Ask Before Joining an Open Network option, as shown in
Figure 5-14. When you choose this option, AirPort asks you if you
want fo connect to open networks when they are detected. In many
cases, you will not want to join open, unknown networks.

50

@ Grab File Ede Capture Window Help

t [ B sz @

Turn Adrfor OF

« SEren1TY46
Other.

Create Network
Use Interference Robustness

Open internet Connect

Figure 5-13: Disable wireless networking.

006 Network

= If no preferred networks are found:

Ask before joining an open network 3]

Require administrator password to:
I Change wireless networks
4 ] Create Computer-to-Computer networks

EAuwmaticallv add new networks to the preferred networks list

[_l Disconnect from wireless networks when | log out
[ Enable interference robustness

(2) (Restore Defaults ) ( Cancel
TACTIONTEC None
|- Edit

AirPort will connect to the first available network in the list. If none
are available, AirPort will ask before joining an open network. Drag
the network name to rearder the list.

( Options... ) ¥ Show AirPort status in menu bar

1l —_—
JJE Click the lock to prevent further changes. (_Assist me... )

@

Apply Now

Figure 5-14: Connection options.
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DropBooks Securing Your Network

The 5t Wave By Rich Tennant

ORIGTENNANT

“Frankly, the idea of an entirely wireless future
scares me to death.”
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Drepaanting Wi-Fi e
ecurit /] Chapter

W—Fi technologies bring new levels of ease and convenience to home
computer networking. No longer do you have to run Ethernet cable
all over your house or confine computers to a single room. With Wi-Fi you
can use your computers anywhere — even the backyard on a sunny day —
that gets reception from your wireless access point (WAP). Get ready to

Of course, the convenience of Wi-Fi brings with it a new security threat.

Anyone within broadcast range of your wireless network signal — neighbors, = Determine the Level of Security You Need....54

passers-by — can access your network. After they have access to the network, w= Disable SSID Broadcast oo 55
they can steal your Internet bandwidth, view your sensitive computer files,
and even damage your software and operating system. No matter where your = Filtier MAC Addresses 56
network is located, you should take some basic precautions to keep it secure. ) .
= Activate WEP Encryption ..........ceveeecceveeenens 51
In this chapter, you find out how to start securing your wireless network. I
go over how to determine your security threats, and what you need to do to = Change the WEP Key 51
protect yourself from them. I also show you how to activate security features we> Rotate Multiple WEP Keys ... 58
in your wireless access point.
] _ ) o L i w= Enhance Security with WPA-PSK

I show how to implement various security measures in this chapter, including WEP encryption, WPA- E 59

PSK encryption, and MAC filtering. Of these methods, WPA-PSK provides the greatest level of secu- P

rity and should be used whenever possible. Only use WEP and MAC filtering if some of your wireless w= Update the WPA-PSK Key in Your Wireless

devices don't support WPA-PSK. Devices 60
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Determine the Level of

Drop

1.

eed

Decide whether or not you want others to be able to
easily use your Wi-Fi network periodically.

If you want to create a hotspot that friends or associates can use,
you will want to use minimal security so that others can easily
aceess it.

Walk around your building, property, and general area
with your handheld PC or laptop to measure the range
of your Wi-Fi signal in different areas (see Figure 6-1).

Evaluate the proximity of potential threats.

Find out what your equipment supports. In Figure 6-2,
this router supports several encryption technologies
including:

WEP (Wireless Encryption Protocol): WEP is sup-
ported by virtually all Wi-Fi devices. Unfortunately
WEP is easily defeated by widely available hacking
programs.

WPA (Wi-Fi Protected Access): WPA is vastly supe-
rior to WEP, but it requires a special RADIUS server,
which most home networks don’t have.

WPA-PSK (WPA Pre-Shared Key): This option is a
form of WPA that does not require a RADIUS server
and is the best choice for home networks. WPA-PSK
is also called WPA Personal. Some older devices don't
support WPA or WPA-PSK.

Routinely check for Wi-Fi intrusions. (I go over how to
check for and eject unauthorized users in Chapter 8.)

p 5:00PM-G:

Figure 6-1: A weak signal.

DI-624 ]

Y. Advanced  Tools Status Help

"-’ - Wireless Settings
These are the wirsless settings for the AP(Access Point)Portion
T
Wiraless Radio & on O oOff

undlerHOME

230
| \Vlutess;' Channel : | 6 [+

WAN WEP: @ gnabled O Disabled
WEP Encryption : | 126Bit |~
Key Type - | HEX v
LAN ¥ lyp |

Keyl - @ [1234567890ABCDEF1 234567690

DHCP Key2 | 00000000000000000000000000
Key3 © © [00000000000000000000000000

Keyd 0 00000000000000000000000000

Authentication : @ oOpen System O Shared Key O wpa O Wpa-pSK

2 OO0

Apply Cancel Help

Figure 6-2: Check fo see what your equipment supports.




Disable SSID Broadcast

Disable SSID Broadcast | I anons ErrRETT—

r : pL Q Q S lf WAP . W b +he&e a‘r‘el)"!e‘Ww‘él‘ess‘F features for the AP(; Point) Portion.
panel tor your using a We Wit server

. Ti Rate : Auto [v|(Mdbps)
browser. (For just the steps to do so, refer to Chapter 1.) o :

Beacon interval - 100

IO

(msec, rangs:20~1000, default: 100}
RTS Threshold : (2346 | (range: 1~2346, default:2346)

Awumunm
2. Locate the SSID broadcast controls, usually found in the irange: 296~2346, defaut 2345, even uraber )
wireless controls area. (On some routers, such as the Fitters DTt interal: [ (anges 1-255, defauls )
. . h Preamble Type : @ Short Preamble © Long Preamble
one shown in Figure 6-3, SSID broadcast controls are — B e
located on the Performance tab of the Advanced tab.)

Fragmentation : 2346

Firewall =
802119 Only Mode : © Enabled @ Disabled
CTS Mode : O None O Always ® Auto
Super G Mode : | Super G with Dynamic Turba [v]

it

Select the Disabled radio button next to SSID Broadcast.
Click OK or Apply to save your changes in the access Purforcs| Sﬂy ci‘n?e. Eu,
point.

The SSID (short for service set identifier) is the digital name of your
wireless network, and it is the first layer of security for your net-
work. If a wireless device wants to access your network, it must first
know the correct SSID. If a laptop, PDA, game console, or other

Figure 6-3: Disable SSID broadcast.

wireless device doesn't know the correct SSID, it can’t log on to your 7 ;| settings
network. Unfortunately, if your access point is broadcasting the Configura Wtleas Hersre )
SSID, then you lose this security layer because others can easily see T
your network, and they know the correct SSID. (Ptmobie Avaiable
5. Use a wireless computer that has not yet been set up to

access your network to check for SSID broadcast, as

shown in Figure 6-4. If SSID broadcast is disabled, your

network should not be detected.
If SSID broadcast has been enabled on your access point, change Networks to access:
the SSID after you disable SSID broadcast. If someone detected [V Avaiable M|
your SSID before you disabled broadcast, they probably still have it Wireless [ Network Adapters

saved in their list of available networks.

Figure 6-4: I've found a wireless
network named tmobile.



Chapter 6: Activating Wi-Fi Security

'y

gr MAC Addresses
egrg h $\C address for each wireless computer —

and device on your network. (For just the steps to do so,
turn to Chapter 8.)

Droﬁ.

2. Login to the control panel for your WAP using a Web
browser.

I

3. Locate the MAC filter controls. Most routers have a spe-
cial Filters screen (see Figure 6-5).

LE

4. If the router offers both IP and MAC filtering, select
MAC Filters.

5. Select the Only Allow filtering option.

When you choose the Only Allow option, only computers with the

MAC addresses you enter will be allowed on your network by the Figure 6-5: The Filters screen.
router.
2= [ Home RNl foole Sous  Helo |
6. Enter the MAC address for one of your computers. @ . ———

) 4
§
H
%
H

Make sure that the first MAC address you enter is the
one for the computer from which you are currently P
working.

.....
= Only uters wih MAC addres
€3 Cinly ey compaiets wih MAC sddrass

In many routers, you can use the DHCP pull-down menu o select
computers that are currently connected to the network, and then - :
click the Clone button to automatically fill in the Name and MAC oHcP ol J0T0 ITE0829 =
Address fields. Doing this saves you some typing.

MAL Adérass

IFTIT)

LE

Pectormance [ IEENM— =

7. Enter a name for the computer so that it can be easily
identified later.

Click Apply to apply the filter.

Repeat the above steps until all of your computers are

entered (see Figure 6-6). Figure 6-6: Add all of your computers.
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Change the WEP Key

Actigate WEP Encryption

0,

pL rQ Q S panel for your WAP using a Web

browser.

2. Locate the wireless security controls in your access point

3.

(see Figure 6-7).
Enable WEP encryption and set the following options:

e Bit Depth: Choose the highest possible setting,
which is normally 128-bit.

e Key Type: Choose HEX (hexadecimal) or ASCII. Some
wireless devices can only use hexadecimal keys.

Enter at least one key and click OK or Apply to apply
your changes.

Change the WEP Key

1.

Log in to the control panel for your WAP using a Web
browser.

Locate the wireless security controls in your access
point.

Enter a new key in the access point and then click OK or
Apply to apply the new key in the WAP.

Open the connection utility in your wireless device.
(For just the steps to do so, refer to Chapter 3.)

Enter the WEP key in the wireless device (see Figure 6-8)
and click OK or Apply to apply your new key.

WEP keys are not case sensitive, however, when you set a hexa-
decimal WEP key you can only use digits 0—9 and letters A-F. A
128-bit WEP key is 26 characters long.

Home Advanced

Tools

These are the wireless settings for the AP(Access Point)Portion.

Status Help

‘Wireless Radic & on O Off
S8ID - underHOME]
Channel ; B v
Authentication : & Open System O Shared key O wpa O wpaA-PSK
WEP: & Enabled O Disabled
WEP Encryption : | 128Bit |+
Key Type - | HER v
Keyl - & |1234567890ABCDEF1234567890
Key2 | 00000000000000000000000000
Key3 - © | 00000000000000000000000000
Keyd ) |00000000000000000000000000

9 00

Apply Cancel Help

Figure 6-7: Enable WEP encryption.

;T.'|_5em-gs 1 #$10:53 ok

Configure Network Authentication e

Data Encryption: WEP -

D The key is automatically provided

i

Key index:
General | Network Key | 802.1x
123[1]2[3]a]s[6[7]8[9]0]-[=[4«

Tab[g[wle[r]t]y[ulifo[p[L]]
caPlafs[d[flo[n]jk[1[:]"

|
|
>

cufai] " [\

Figure 6-8: Enter the WEP key in your
wireless device.
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le WEP Keys

rol panel for your WAP using a Web
browser.

Locate the wireless security controls in your access
point.

Enter up to four unique WEP keys, as shown in Fig-
ure 6-9.

Select which key you want to use today and click OK or
Apply to apply your new key.

Open the connection utility in your wireless device.

Click the arrows next to the Key Index box to choose
Key Index 1, 2, 3, or 4 (see Figure 6-10).

Enter the WEP key matching the Key Index number.
Repeat Steps 6 and 7 for each Key Index.

Select the currently active Key Index and click OK to
close the connection utility.

By using multiple WEP keys and rofating them frequently — for
example, once daily or every other day — you greatly increase
the security of your network. Hackers need a lot of fime to defect
and decrypt a single WEP key, and multiple keys increase that chal-
lenge exponentially. Rotating WEP keys provides a way to slightly
enhance your network security if your hardware doesn't allow you
to use WPA-PSK encryption.

DI-624 I
l L LR Advanced Tools Status Help
These are the wireless settings for the AP(Access Point)Portion.
—
Wizard Wireless Radic & on O oOff
— SSID: underHOME
| Wireless Channel : 6 %
— Authentication © @& Open System O Shared key © wea O wpa-PSK
WAN WEP: @ Enabled O Disabled
WEP Encryption © | 128Bit ||
o Key Typa | HEX [+]
Keyl : (@ |1234567830ABCDEFT 234567890
!W Key2 - O 0987654321 FEDCEAQI87654321
Keya ' O ABCDEF1234567890ABCDEF1234
Keyd: O 0987654321 ABCDEF1234567840]
@ ©0
Apply Cancel Help

Figure 6-9: Use muiltiple keys for greater security.

SErentTYd6 properties

[2[*]

Assosiation | Authentication | Connection |

Metwark name (S510]

Wireless network key

This netwark requites a kep for the following

Dpen

Nebwark Authentication:

Data enciyption:
Metwark: key:

Confitm netwark key.

Key index [advanced] 4 =

Gel)

[C] The keyis pravided for me automatically

Figure 6-10: Choose o Key Index.




Enhance Security with WPA-PSK Encryption

Enhquce Security with =8| Home _ [T A T

These are the wireless settings for the AP(Access Point)Portion.

Dr

. Y=
ption

Log in to the control panel for your WAP using a Web
browser.

Locate the wireless security controls in your access
point.

Select WPA-PSK as the authentication method.

Enter a passphrase in both Passphrase boxes (see
Figure 6-11).

The passphrase can be between 8 and 63 characters, and it can
include symbols such as question marks and ampersands. The
passphrase should be long, random, and include both letters and
numbers.

Click OK or Apply to apply your changes.

If your network has a RADIUS server, select WPA, as
shown in Figure 6-12. Enter the IP address, Port num-
ber, and Shared secret for your RADIUS server.

RADIUS servers are usually only found in corporate networks.

WPA-PSK stands for Wi-Fi Protected Access Pre-Shared Key (WPA-PSK),
and is more secure than WEP encryption. The only disadvantage of
WPA-PSK is that it is not supported by some older Wi-Fi gear.

Wireless Radio & on O Off
321D : junclerHOME
Channel ; B v

Authentication : & Open System O Shared key O wpa @ wpa-psK

Passphrage :

Confirmed Passphrase

9 ©0

Apply Cancel Help

Figure 6-11: Use muiltiple keys for greater security.

Home Advanced  Tools Status Help |

‘ = Wireless Settings
‘ These are the wireless settings for the AP(Access Point)Partion
—_—
Wireless Radio & on O off
SSID ; underHOME
i Wireless Channel : | B v

Authentication : O Open System O Shared Key [ wpa O wpA-PSK

02.1X
RADIUS Semer 1 |p 0000
Port 1812
Shared Secret
RADIUS Server 2 |p 0000
(Optional)
Pont 0

Shared Secret

9 00

Apply Cancel Help

Figure 6-12: WPA requires a RADIUS server.

59



Chapter 6: Activating Wi-Fi Security

te th I’A PSK Key
D I’O ss Devices
Open the connection utility in your wireless device.

2. Locate the network security controls.

3. In the Network Authentication drop-down list, choose
WPA-PSK.

If your connection utility allows you to choose the TKIP or AES
encryption methods, choose TKIP.

4. Enter the Network key (see Figure 6-13).
Click OK to apply your changes.
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SEren1TY46 properties B8]

Association | Authertication | Connection

Metwork name (551D
Wireless network key

This network requites a key for the fallowing: |

Network Authentication |wPa-Psk ~]
Data encryption: (TP | |
Metworkkey, ~ |essssessenss |
Confitm netwark key,  sssssssssass

o]

Figure 6-13: Enter the WPA-PSK.



Drdmusauéng Firewalls
and Network Security

your home network faces a variety of security threats. These threats can

-y

1)

be divided into two categories:

Wireless intrusion: Wireless intrusion comes from other people
within radio broadcast range of your wireless access point. Wireless
intrusion generally comes from people who are physically close to
you, at a distance usually less than 100 meters. Chapter 6 shows you
how to activate wireless encryption to protect against Wi-Fi intruders.

Internet intrusion: Hackers create programs that can enter your net-
work through your Internet connection. They can access your files and
personal information, and possibly change settings or damage your
operating system so that you can't use your computer. The risk of
Internet intrusion is even greater if you have an always-on broadband

Internet connection, such as DSL or cable. Internet intrusion can come

from down the block or halfway around the world.

The best protection from Internet-based intruders is having a firewall pro-
gram. Just as firewalls in cars and office buildings prevent the spread of fire,
firewall programs provide a protective barrier between your computer and
the denizens of the Internet. This chapter shows you how to set up and use
firewalls to protect your computers and your network.

N R
Chapter

Getready to. ..

w= Configure the Windows Firewall.................. 62
w= Set Up a Third-Party Firewall...................... 64
w= Update the Firewall 65
w= Halt Network Traffic 66
> Review the Firewall Logs..........ccceureernn. 67
w= Add Programs to an Exception List ............ 68
w= Block Ping Commands..........cooooessesrccceeees 69
w= Activate the Mac 0S X Firewall ................. 69
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é‘\qure he Windows Firewall

QQ& Sntrol Panel to open the Windows

Control Panel.

Double-click the Security Center icon.

The Security Center icon is only available if you have Windows XP
SP2 or better installed. If you don't see the Security Center icon in
your Windows XP Control Panel, use Windows Update to download
and install the SP2 update.

In the resulting Windows Security Center window (see
Figure 7-1), click the Windows Firewall link.

In the resulting Windows Firewall dialog box, click the
General tab and select the On radio button, as shown in
Figure 7-2.

You should only run one software firewall on a computer. If you
have a third-party firewall program such as Norton Internet
Security, ZoneAlarm, or a similar program, you may want to disable
the Windows Firewall and use the more powerful third-party pro-
gram instead.

If you are using your computer at a public Wi-Fi hotspot, select the
Don't Allow Exceptions check box. When you enable the Don't Allow
Exceptions option, you can use Web browsers and e-mail programs,
but you cannot use Internet messaging programs, FTP programs,
and other programs which must access the Infernet. Disallowing such
programs protects your computer from being accessed by other
people at the hotspot.

U Windows Security Center (2= %]
@ Security Center

Help protect your PC

@) Resources =

se2tncs, To help probect wour computer,
s awes vk O, ol 1

+ ot i Latesst sncurity and s
nformation from Micresolt

= Check fer the bsbest updates from

Whindares Update e Firawall @ ON =
* (et spport For securty-relsted
e ° Automatic Updates 00N =
+ ek bk abouk Sty Cenker
H:u wray Securty Cerker Q' Virus Protection @ 0N =

Manage security settings for:

@ Internet Options % Automatic Updates
ﬁ Windows Firewall

e acy, Fieas

Tty SHARemAN.

Figure 7-1: The Windows Security Center.

& Windows Firewall

General | Exceptions | Advanced |

s helping to protect your PC

Windows Firewall helps protect your computer by preventing unauthorized users
from gaining access o your computer thiaugh the Intemet or 3 network.

@ ®iln frecommendedf

This setting blocks all autside sources fiom connecting ta this
computer, with the exception of thase sslected on the Exceptions tab

[ Don't allow exceptions

Select this when you cannect ta public netwarks in less secure
localions, such as aiporte. Y ou will not be notified when Windows
Firewal blocks programs, Selections on the Exceptions tab will be
ianored

@ ) OFf [not recommended)

Awaid wsing this setting. Turming off Windows Firewal may make this
computer mare wulnerable to vinses and ntuders

What etse should | know about Windows Firswall?

Figure 7-2: The Windows Firewall dialog box.



Configure the Windows Firewall

5. Click the Advanced tab (see Figure 7-3).

D ro ﬁ onnections to which the Windows
S 1 d select or deselect them as needed.

Normally you should leave all network connections checked, as
shown in Figure 7-3. However, if you have trouble using devices
(other than networking devices) that are connected to your IEEE-
1394 port, you may want to uncheck 1394 Connection. This con-
nection will not be listed if your computer doesnt have an
IEEE-1394 (also called FireWire) port.

Click the Settings button in the Security Logging area.

8. In the resulting Log Settings dialog box, select both the
Log Dropped Packets and Log Successful Connections
check boxes, as shown in Figure 7-4.

By logging dropped packets you may be able to determine whether
network problems are due to a poor Wi-Fi signal. Lots of dropped
packets may indicate a poor or infermittent signal. Logging suc-
cessful connections can also help you troubleshoot connection
issues; if you don't see any successful connections in the log, then
you know that you aren’t connecting to the network. | show how fo
review logs later in this chapter.

9. Click OK to close the Log Settings dialog box.
10. Click OK to close the Windows Firewall dialog box.

If you have a router between your broadband Internet modem and
the rest of your network, that router should also have a built-in
firewall. This built-in firewall serves as a great first line of defense
to your network, but it does not take the place of software firewalls
installed on each computer on your network.

& Windows Firewall
General | Exceptions | Advanced |
Metwark Connection 5ettings
wiindowss Firewall is enabled for the connections selected below. To add
exceptions for an individual connection, select it and then click Settings:
1394 Connection Settings..
Logal frea Connection
|
Security Logging
You can create a log fi for tioubleshonting purposes. Seltings.
ICHP
Wiith Intemet Control Message Protocol [|ICMP), the
computers on & netwark can share erar and status
infarmation,
Default 5 ettings:
Ta restore all Windows Firewall seltings to a default state, [[p_o o p o
click Restore Defaults.

Figure 7-3: Advanced Windows Firewall settings.

Log Settings

Logging Dptions

Log diopped packets

Log successhul connections

Log File Options

Nare:

CAWIND DS plirewall.log |

Size lmit (KB): 4098 :r"’

Figure 7-4: The Log Settings dialog box.
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glp a Third-Party Firewall
0

t 1 s Firewall controls and select the Off
radio button.

Drof)e.

The Windows Firewall is likely to conflict with third-party firewall e

programs, thus preventing you from accessing the Internet. 9

2. Install the third-party firewall in accordance with the p
instructions provided by the program’s publisher. °;\'

3. Open the firewall’s control panel by double-clicking its
icon in the Windows system tray (see Figure 7-5). L]

e

Many programs now market themselves as antivirus and Internet
security programs. A program that is marketed as an Internet secu-
rity program should include a firewall feature.

[Trwad Micra P cilin bnts et Sacucity (7 500. 1002 2 517 50
e mm

Figure 7-5: The firewall program’s system tray icon.

4. In the security program'’s control panel, locate the fire- AL o
wall controls. Make sure that the firewall is enabled. EREY PC-cillin” Internet Security 2005

The firewall controls may be labeled Personal Firewall and may be (PRVVPTFSTNENS, SERFFHITR., s BT

a subcategory of general network controls. Personal Firewall !

= Choose a Persanal Firewall prafile to help protect vour computer against

unautharized access from the Internet. Enable automatic profile switching to

autormnatically chanae profiles if you change netwarks.

5. 1If the program offers security profiles, choose the profile [¥lEnable Fersonal Frswal
that seems to best describe your network, as I have done BaProtle: [ Wirslass netuork [l

(See Figure 7-6) . [C1Enable automatic prafile switching

Edit Profile

Netwurk + Add ,4 Edit X Delete

Control

Profile Narne Description

@ Direct connection For connection directly to the Internet. |
Harne network For connection to a home netwark, wh
Office netwark For connection to an office netwatk. Th..
Wireless network For connection to a wireless network. ...

Updates and

— ey Return 1o Main Screen Apply

64 Figure 7-6: Locate the Network Security controls.



Update the Firewall

6. Choose a profile and then click Edit.

D ro p k for the Trend Micro security program shown in
Flgure 6, buT'most security programs should let you review and
edit settings for the various security profiles that are available.

In the profile settings that appear, check the security
level for the profile (see Figure 7-7).

Carefully review the security settings for every profile because they
may hold surprises. For example, the Trend Micro Home Network
profile has the security level set to Low, as opposed to Medium,
which | recommend.

8. Close the firewall program and save your settings.

Make sure that when you close the program, the program’s icon is
sfill in the Windows system tray. If the icon is present, the program
is still running.

Update the Firewall

1. Right-click the firewall program'’s icon in the Windows
system tray.

2. In the context menu (see Figure 7-8), choose Update
Components.

3. Follow the on-screen instructions to download and
install updates.

Most firewall programs automatically check for updates on a regu-
lar basis; if it has been a couple of days since you saw an update
being performed, perform a manual update.

Personal Firewall Profile

Prifile Marne | Metwork | Security Level | Exception List | Proy

Security Level

Choose a High, Medium, or Low security level for this firewall profile.

High Recommended far most users
-Blocks incoming trafic unless allowed in the Exception
List
-Allows outgoing trafiic unless blocked inthe Exception

5 List
1|—> Medium -Blocks network virus attacks and other known threats

Figure 7-7: Check your firewalls security level.

=
W el the
FRengim)
Adeh Rusyele B
5

DiLsrme
Streat 221

Mania

Furstox

DuiekTitra

o
Open Main

]A-‘ Scan far Vieuses

A Updaie Comgrneni.
Sl Chock Sacurity

Rk Hah Intermet Traffic

E Unes Prafite 0
Finils  Realime Scan

N Exit
= arE™ T st

Figure 7-8: Update your firewall.
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HaéNet rk Traffic
D ro R$ndows system tray icon for your

66

Internet security program.

In the context menu, choose Halt Internet Traffic, as
shown in Figure 7-9. Traffic between your computer and
the Internet should be disabled.

The Halt Internet Traffic command can be used as an emergency
panic button if you believe that your computer is currently under
attack. For example, if your computer is currently having a lot of
hard drive activity but no programs are running, and your Internet
connection is flowing a lot of data but no one is online, activate the
Halt Internet Traffic command. If the hard drive activity or connec-
tion activity suddenly stops, then it is likely that your computer was
being attacked.

Run a complete virus and Internet security scan of your
computer to identify and neutralize potential threats on
your computer.

Choose Halt Internet Traffic again to re-enable Internet
traffic. You can also disable and enable traffic from
directly within your security program, as shown in
Figure 7-10.

The Halt Internet Traffic command only works on the computer on
which it is installed. Halting Internet traffic on one computer won't
prevent other computers on your network from connecting with the
Internet.

Open Main

Scan for Viruses
Update Components
Check Security

Halt Internet Traffic
User Profile *

v Realtime Scan

Exit

Figure 7-9: Hal Internet
traffic.

P Trend Micro PC-cillin Internet Security

prjl‘ate C‘ulm{' % Scan for S.pyware."

Internet Security Status

Last Attack Information
Date of last attack

- Source P address:

| Trend Micro PC-cillin Internet Security

10/3042005 15:00
182.168.0.10

Internet traffic has been restarted. All incoming and outgoing Internet connections have been
started.

Personal Firewall: Enabled

Internet traffic monitoring
Bytes Received: 42,452,293

Network [ o 5 =
Security s > J

Bytes Sent: 16,481,926
[ EL R Halt Internet Traffic!

ﬁ Updates and
* Registration
p—

Return to Main Screen

Figure 7-10: Reactivate your Infernet connection when you believe it's safe.



Review the Firewall Logs

Rev:gf the & irewall Logs
p Snel for your firewall program.

2.

3.

Locate the logging or event logs section of the control
panel and open it.

Open a log:

e Third-Party Firewalls: If the program maintains sev-
eral different kinds of logs, choose the Firewall or
Personal Firewall logs and click View Logs.

¢ Windows Firewall: Use My Computer or Windows
Explorer to open the folder C:\WINDOWS and then
double-click the file pfirewall.log.

Review the firewall logs (see Figure 7-11). If you are
using the Windows Firewall, the file pfirewall.log opens
in a text editor (see Figure 7-12).

When you review the firewall logs, look for entries that come from
source IP addresses outside of your network. Sources inside your
own network usually start with 192.168, as shown in Figures 7-11
and 7-12.

Most activities listed in the firewall logs are harmless network func-
tions. However, if you are having network connection difficulties, or
if you have been victimized by an attack from outside your network,
these logs can help you identify and troubleshoot those problems.

1 Personal Firewall Log

Computer name:  SOVOP4

® Epon [l Debin

fef asne-w#l-o‘i

[ Doscription |~

39 CWMNDOW..  Genenc Host
CWMINDOW, Gandnic Host
CWWINDOW., Genenc Host

2066 COMWINDOW,.  Generc Host

[Applcarn | Apglication
- - tination
Dustination
CMNDOW... Generic Host. Sacuity rule
9 COWWINDOW,.. Genenc Host,. Secunly rule

Sncurity ruli
Secunty rule
Socurity rule
Sacurity ruls
Security rule
Security ruls
Secunty rule
Sucurity rule,
3

Llote A
o . .
Figure 7-11: Review your firewall logs.
. pfirewall.log - Notepad 2[&]%]
File Edit Format View Help
pversion: 1.5 ||
#software: Microsoft windows Firewall =
#Time Format: Local
#Fields: date time action protocal src—ip dst-ip src-port dst-port size tepflags tcopsyn
2005-10-30 11:42:23 OPEN UDP 152.168.0.105 152.168.0. 10 1028 52 777777777
2005-10-30 q OPEN UDP 192.168.0.105 192.168.0.10 1553 55 - - - - - - - - —
2005-10-30 e OPEN TCP 192.168.0.105 207.124.111.225 2269 B0
2005-10-30 OPEN TCP 1582.168.0.105 212.58.240.143 2270 80
2005-10-30 CLOSE TCP 192.168.0.105 207.126.111.225 2269 80 -
2005-10-30 CLOSE TCP 192.168.0.105 212.58.240.143 2270 B0 - -
2005-10-30 OPEN TCP 192.168.0.103 64,202.163.18% 2271 80 - -
2005-10-30 OPEN TCP 192.168.0.105 192.163.0.10 2272 80 - - - - - -
2005-10-30 CLOSE TCP 192.168.0.105 192.168.0.10 2272 80 - - - - - - - — -
2005-10-30 CLOSE TCP 1‘32 168 0. 105 64.202.163.189 2271 8O - -
2005-10-30 OPEN TCP 19 .0.1 2.163.0.10 2273 80 - - -
2005-10-30 OPEN TCP 192.168.0.105 192.168.0.10 2274 BO - - -
2005-10-30 OPEN TCP 152.168.0.105 192.168.0.10 2275 80 - - - - -
2005-10-30 OPEN TCP 182.168.0.105 192.168.0.10 2276 80 - - - - -
2005-10-30 OPEN TCP 192.168.0.105 192.168.0.10 2277 80 - - -
2005-10-30 OPEN TCP 192.168.0.105 192.163.0.10 2278 80 - - -
2005-10-30 OPEN TCP 182.168.0.105 192.168.0.10 2279 80 - - -
2005-10-30 OPEN TCP 152.168.0.105 192.168.0.10 2280 80 - - - - -
2005-10-30 OPEN TCP 1892.168.0.105 192.168.0.10 2281 80 - - - - -
2005-10-30 OPEN TCP 192.168.0.105 192.168.0.10 2282 80 - - -
2005-10-30 OPEN TCP 192.163.0.105 192.163.0.10 2283 80 - - -
2005-10-30 OPEN TCP 162.168.0.105 102.168.0.10 2284 80 - - -
2005-10-30 OPEN TCP 152.168.0.105 192.168.0.10 2285 80 - - - - -
2005-10-30 OPEN TCP 1562.168.0.105 192.168.0.10 2286 80 - - - - -
2005-10-30 OPEN TCP 192.168.0.105 1592.168.0.10 2287 80 =
2005-10-30 OPEN TCP 192.168.0.105 192.163.0.10 2288 80 - - -
2005-10-30 OPEN TCP 182.168.0.105 192.168.0.10 2289 80 - - -
2005-10-30 OPEN TCP 152.168.0.105 192.168.0.10 2290 80 - - - - -
2005-10-30 OPEN TCP 152.168.0.105 192.168.0.10 2201 B0 - - - - —
2005-10-30 OPEN TCP 192.168.0.105 192.168.0.10 2292 80 - - -
2005-10-30 OPEN TCP 192.168.0.105 192.163.0.10 2293 80 - - -
2005-10-30 OPEN TCP 192 168 0.105 192 168 0.10 ZZBQ EO - - -
2005-10-30 11 OPEN TCP .0.1 .0.10 2295 B0 - - - - -
2005-10-30 CLOSE TCP 192 lGE a. 105 192 lGE a. 10 2295 SO 777777777 vl
3 | 3]

Figure 7-12: The pfirewall.log.
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Prafile Marne | Metwork | Security Level | Exception List | Prowy

Add _Programs to an Exception List ._
DropB00K _

panel for your firewall program. —

2 Open the ﬁrewall Contl‘ols If you see an eXCeption list Define the direction of Internet traffic, IP address or range of IP addresses, ports, and
) . . : | protocols for exceptions.
area, open it. Otherwise, open the personal firewall set- || g - p

tings, select your security profile, and click Edit.

I Description i Connection  Access | Protocol A
. . . Internet Explorer out Allow TCP
3. Open the Exception List tab or controls (see Figure 7-13). Explorer out Alow e
Cutlook Express Out Allow TCP
. Windows Messenger (.. Out Allow TCRIUDP
4- Click Add. Windows Messenger (L. In allow  TCPIUDP
Trend Micro Internal Pr...  Out Allow TCP
] 3 1 Send Mail (SMTP} Qut Allow TCP
5. Type a descriptive name for the exception (see SmavenEwe o i L
Figure 7_14) Internet Mail (POP3) out Alow  TCP
: YWeh Service (HTTP) Out Allow TCP |
SecureWieh Service (H..  Out Allowy FER, ||
m [2]

Although I'm creating a rule for ActiveSync here, you can follow
these steps to create an excepfion for any program that uses net-

work connections. Keep in mind that you may have to create sepa-

rate rules for outgoing and incoming traffic. Figure 7-13: Control which programs can use the network.
6. Click Browse and locate the program file for the pro- AU Pamsenal Firawall Excontion
gram for which you are creating an exception. W i
. A Target: O All applications
Program files are usually located in the folder C\PROGRAM FILES & s T
und most huVe 'he EXE flle ex'ension' (%) Specified application ActiveSync Connection Manager
C-\Program FilesiMicrosoft ActiveSynciweessomm.
Cannection ) Incoming @ Dutgoing
7. Choose to which target group the exception applies. ften £ O
Protacal
8. Choose whether you want the exception rule to allow traf- oM R e
fic, deny traffic, or warn you when traffic is about to occur. Portsy: © Al ports

) Specified port(s):
(Forexample, 10,15, 20- 30}

Choose Deny if you want to block a program from using the 1P Sating
neIWUfk. Type. All P addresses e

9. Click OK to save your new exception rule.

QK Cancel

Figure 7-14: Set up a firewall exception.
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Activate the Mac 0S X Firewall

Bloc
opRA

2. Locate the controls for blocking WAN ping commands.

Piné ommands

r lSt's control panel.

3. Enable WAN ping blocking, as shown in Figure 7-15.

4. Click OK or Apply to save your changes.

The ping command is used simply to determine if a computer’s IP
address is valid. Hackers somefimes use the ping command to iden-
tify valid, active IP addresses fo attack. By blocking ping commands,
you make your network less visible to hackers.

The steps here assume that you connect fo the Infernet using a
broadband cable or DSL modem, and that you have a router con-
necting the broadband modem to the rest of your network. If you
connect to the Infernet through a dial-up connection, blocking ping
commands is less important because your ISP probably gives you a
different IP address every fime you connect.

Activate the Mac 0S X Firewall

Choose Appler>System Preferences.
In System Preferences, click the Sharing icon.

In the Sharing window, click Firewall to open the
Personal Firewall settings (see Figure 7-16).

Click Start to start the firewall.

Close the Sharing window.

Ping Test i3 ueed 1o send “Ping” packets 1o tast if & computer is on the Intemet

i

Host Nama or 1P

addross e |

™ ime

Reboots the DIHG24

[

System [ Raboot

Firmware

Whin you "Black WAN Ping”. you
10 mol respend 10 ping comman
method wked by hackers 1o fest wh

Digcaed PING from WAN side [ Enabled ©' Disabled

public WAN IP addrestes i @ common
er your WAN IF address s valid

I

@ Enabled © Disabled

& Enabled © Disabled

ABows VPN cannections 1o wark thicugh the DIE24

FPTR @ Enabled O Disabled
IPSac @ Enabled O Dissblnd

[ __Home _ Advancedii TR Status___Help |

ysing the public WAN IP address on the DEG24

Figure 7-15: Block ping commands from the Internet.

88 o Sharing

[« » | [ Showal Q|

Computer Name: Keith Underdahl's iBook G4

Other computers on your local subnet can access
your computer at keith-underdahls-ibook-g4.local Edit...

! Services | Firewall | Internet -
Firewall On
Click Stop to allow incoming network communication to all services and
op
ports.
Allow:  On Description C New.. )
v Personal File Sharing
¥ Windows Sharing (__ Edit.. )
———
Personal Web Sharing Delete
v Remote Login - SSH =
FTP Access
_ Apple Remote Desktop
__ Remote Apple Events A
———————
| Printer Sharing v M

To use FTP to retrieve files while the firewall is on, enable passive FTP mode using the Proxies
tab in Network Preferances. @

N
[%l Click the lock to prevent further changes.

Figure 7-16: Enable the 0S X Personal Firewall.
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DrdfBdenting
dgfauthorized
Network Users

If you live in a neighborhood with lots of other people, sadly, it's probably
only a matter of time before unauthorized users start appearing on your
network. Even if your neighbors are a long distance away, your network isn’t
entirely safe.

Of course, we were all taught to share, and many people believe that sharing
Internet bandwidth with neighbors is a nice thing to do. However, your
Internet service provider may object to the increased traffic, and if one of
your neighbors downloads illegal material using your Internet connection,
the police will come knocking on your door first.

Before you start viewing your neighbors with suspicion, keep in mind that
most wireless network intrusions are inadvertent. Suppose that your next
door neighbor buys a Wi-Fi-equipped laptop. He brings it home, fires it up,
and discovers that the wireless Internet access works perfectly. He may not
realize that he’s actually using your Internet connection rather than his own.
In this chapter, you discover how to identify unauthorized users on your
network, and how to eject them from your network and keep them away.
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Drop

72

Reyiew the Access Point Logs

Q Qf Seless access point (WAP) using a Web

browser. (For just the steps to do so, refer to Chapter 1.)

Locate the status or logging area of the access point’s
control panel. (Most WAP control panels have a
Status tab.

Click Log to review the access point log (see Figure 8-1).

If your wireless access point is also a router, you will probably see
a lot of router adivity listed in the log as well as wireless activity.

Note the MAC address shown for each wireless device
that has logged in or tried to log in to your WAP.

In Figure 8-1, the MAC address is listed to the right in the Note
column.

If the WAP has a status screen dedicated specifically to
wireless devices, click the link to open it (see Figure 8-2).

The Wireless status screen, shown in Figure 8-2, lists wireless devices
that are currently connected fo your WAP. or were recently connected.
If you don’t recognize some of the computers in the log, they may e
unauthorized users. The log may list additional wireless devices that
connected fo your WAP earlier, but are no longer connected and thus
are not listed in the Wireless status screen.

DI-624 l

Devicenfo

' Stats

Wireless

|

Home Advanced  Tools

Status I!E]_

View Lag displays the activities occurring on the D524, Click on Log Settings for advance

features.

page 1 of 2

Time Message
Octf30/2005 17:54:52 Wireless PC connected
Octf30/2005 17:51:24 Wireless PC connected
Octf30/2005 17:51.06 Wireless PC connected
Q30,2005 17.39:52 Wireless PC connected
Octf30/2005 17:24:52 Wireless PC connected
Oct/30/2005 17:24 48 DHCP Fequest success
Q3072005 17.24 48 DHCP Request
Octf30/2005 17:24: 48 DHCF Discover
Oct/30/2005 17:24:43 System started
Qct'30/2005 17.24:43DHCP Discover

Help

o

Mote
00-0D-34-20-23-73
00-08-2D-82-1E-31
00-09-2D-82-1E-31
00-0D-34-20-23-73
00-0D-34-20-23-73
192.168.0.6
192.1680.6

Figure 8-1: Review the log for all access point acivity.

DI-624 l

Device Info

e

Log

' Stats

!

Home  Advanced  Tools Status M

The Wireless Client table below displays Wireless clients Connected to the AP o

(Access Paint)
Connacted Time

Oct/30/2005 18:13.52
Oet/30/2005 17:51:24

MAC Address
00-0D-34-20-23-73
00-03-20-82-1E-31

Help
Mode
2.4 GHz
24 GHz

Figure 8-2: Wireless devices are currently connected to your WAP.




Identify Wireless Clients on the Access Point

Identify Wireless Clients

Drop

1.

Roint

Open a Web browser and log in to the control panel on
your WAP.

Open the Status tab and go to the Wireless screen
(see Figure 8-3).

The names of the screens for your WAP may be different, but you
should have a screen that lists currently connected wireless devices.

Note the MAC address for each wireless device con-
nected to your WAP.

Open the log for your WAP (see Figure 8-4).

Match the MAC addresses from the Wireless status
screen with entries in the log.

By comparing the status screen in Figure 8-3 with the log in Figure
8-4, you can see that one of the wireless devices is a computer named
WM_The_Arhiter, which | happen to know is my Wi-Fi-enabled
Pocket PC. The other wireless device is an unidentified computer sim-
ply named “Wireless PC” in the log. Because I'm unfamiliar with this
name, | need to research that device further.

Home  Advanced  Tools Status m

The Wireless Client table below displays Wireless clients Cannected to the AP 0

(Access Point]. Help
Connected Time MAC Address Mode
Oct/30/2005 19:38:52 00-00-3A-20-23-73 2.4 GHz
Oct/30/2005 19:14:52 00-02-2D-82-1E-31 24 GHz
Figure 8-3: Two wireless devices connected.
DI-624
l Home  Advanced  Tools LTI Help |

Device Info

og

| Stats

Wireless

0

View Log
Wiew Log displays the activities occurring on the DI-B24. Click on Log Settings for advance

features.

Help

E 1T|?1’13 Message SourceDestination Naote

?;1:3/205./'5005 Wireless PC connected 00-0D-34-20-23-73

?;cfl(;fgoos ]139%011;;3525 to 00-09-2D-82-1E-31
WM The Arbiter

?;tliiﬂjfsﬁﬁﬁ Wireless PC connected 00-09-2D-82-1E-31

Woete 1921550 1060 Mac 00306501

?;g;if?ggs ?iﬁiéegsigm 00-09-2D-82-1E-31
WM_The_Arbiter

?gcgg(jﬁﬂﬂﬁ Wireless PC connected 00-09-2D-282-1E-31

Tasadr 102 1680 08t e 00-30.65-D 51RO

%ﬁ(’gm ?Qléﬂiggsjg to 00-09-2D-82-1E-31
WM The_Arbiter

?gcjiozfgﬂﬂﬁ Wireless PC connected 00-09-2D-82-1E-31

o s

Figure 8-4: Mach the MAC addresses with the WAP log.

73



Chapter 8: Preventing Unauthorized Network Users

Identify Wireless Clients
Drop fféfkysy Program
1. Open the control panel for your Internet security pro-

gram and locate the network security controls (see
Figure 8-5).

Click the Wi-Fi Detection tool option.

3. In the Wi-Fi Detection screen, click Find to find network
computers.

Most network security programs have a tool fo help you detect wire-
less clients that are connected o your network. The names of butons
and screens may be slightly different in your program, but the func-
tion and basic concept should be similar o what is shown here.

4. When the detection process is complete, review the list
of computers (see Figure 8-6).

Keep in mind that although security programs will claim that they are
detecting Wi-Fi devices, they're actually detecting all computers on
your network. Some of the computers that show up in the list may be
connected to your network by Ethernet cables instead of Wi-Fi.

Some of the listings may be instantly recognizable as other network
computers that you own. For example, | know that the computers
named KIDS and IMAC are computers that | own. The computer
named “WM_THE_ARBITER” is my Pocket PC.

74

7 Trend Micro PC_cillin Internet Security =)0

PC-cillin” Internet Security 2005

Network
Control

Updates and
Registration

" ’%Scan fﬁ?éhyware' |

Network Security

These features help protect your computer against attacks from outside
your network, The Personal Firewsall helps protect your computer against
aftacks from the Internet. Emergency Center helps you prevent infection
from netwark viruses. \Wi-Fi Detection detects and warns you of potential
intrusions into your wireless network.

Per Firewall
[d Setand manage Personal Firewall profiles

.ﬁ Networ rus Emergency Center
—4 Specify preventative actions for network viruses.

Wi-Fi Detection
LK Detect intrusion into your wireless network.

Figure 8-5: The Network Security controls.

Trend Micro PC-cillin Internet Security
é) There are unknown computers connected to wour netwark. b4
Do Mat Trast
Status IP &ddress Computer Name MALC Addiess
S8 Unknown 192168.010 00:0c:80:0d:24:93
! Unknown  192168.0100  wh_THE_ARBITER 00:09:2d:82:1e:31
Unknown 192168.0102 - 00:0c: 32:20:22:73
Unknown  192163.0104  KIDS 00:03:6d:14:ec:f0
B0 Unknown 192168.0106  IMAC 00:30:65:6d eT:fc
2N I e
Yiew Help for Wi-Fi Delection
Detected:  10/30/2005 1857

Figure 8-6: Review the list of computers and devices.



Identify Wireless Clients with a Security Program

5. Click a computer in the list to select it and then click

DropBOGUKS.
ropl Wddg box, review details about the

device (see Figure 8-7).

Wi-Fi detection ufilities usually present several kinds of information
which can be used to detect computers, including IP addresses,
device types, and in some cases computer names. Keep in mind,
however, that the device type detection isn't always fotally reliable.
For example, on my network an Apple iMac running Mac 0S X is
detected as a Windows computer, while a Pocket PC — which runs
the Windows Mobile operating system — is unknown.

7. Repeat Steps 5 and 6 for each device listed, making note
of the MAC addresses listed for any devices that you
don't recognize.

8. If a device is positively identified as a computer that
you own, select it in the list and click the Trust button.
In Figure 8-8, the computer WM_THE_ARBITER is
trusted.

Setfing a device fo Trusted status tells your security program that
the device is safe o network with, and you are less likely to have
networking problems in the future.

Wi Fi Detection

.
T ) Toprevent the selected computer from 4
accessing your local computer, click Add
Exception. This will add a new exception to the

cunently active Personal Firewall profile.

Property Yalue
Status Unknown
IP Address 192.168.0.10
Computer Name -
MAC Address 00:0d:28:8d:e4:93
| Device Type Router
2 I | [

Detected: 1043042005 18:49

Add Exception

This action cannot easily be undone: Ta re-enable ancess for
the selected computer, iemave the exeplion fiom the Personal
Firewall Excaption List. Consul the online Halp for more

information
Close

Figure 8-7: View defails about each computer.

Trend Micro PC-cillin Internet Security
i ) There are unknown computers connected to your netwark. &
I Trust ] [ Do Mot Trust ] Properties

Status IP &ddress Computer Mame MAL Address
S8 Unknown  192.168.0.10 000
she 1t oo
Unknown  192.168.0.102

A_THE_ARBITER

00:06:32:20:23:73 |

Unkrown 1921880704 KIDS 00036014 0
Unkrown 1921680706 IMAC 003065 6d eTfe
EaP TR— J )
View Help for Wi Detection
Detected:  10/20/2005 1329

Figure 8-8: One of my computers is now trusted.
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Deérmine the MAC Address e g
D ro p )@ evice S — '

G Addrese Type Assigned by DHCP
S e addiess 192.168.0.105
1. On a Windows PC, choose Starte>Control Panel and Subnet Mask: 255,255,255,

then click the Network Connections icon. Default Batsway 1521880710

2. In the Network Connections window, double-click the

network connection currently used to connect to the Wedons dd el detect s Wt [ oy )
. . i it I
network and then click the Support tab (see Figure 8-9). Ropar, o e o

3. Click the Details button and note the Physical Address
listed in the Network Connection Details dialog box
(see Figure 8-10).

The Physical Address is actually the MAC address for the network T

card. MAC stands for Media Access Control, and each network card,

wireless access point, or wireless card on your network has a unique Figure 8-9: The Support tab for the network

MAC address. connection.
If you have a wireless game console adapter, check the label on the ":“"“:‘Ec"""“':"_:’_""""s 2L%)
underside of the adapter to determine its MAC address. Although e
game consoles don't normally interact with other computers on Phyical s S0 2£079525
your network, they do show up in the router logs as wireless ot 262552310
devices, and they have MAC addresses just like any other computer DHCF Server EaL T
on your network. Lee ot sy
WINS Server

Although MAC addresses are normally a useful way to identify
devices on your network, keep in mind that it is possible to spoof a
MAC address. In other words, someone could detfect a valid MAC

address for a device on your network, and then assign that MAC
address to a device of their own. They could later use this spoofed - : —
MAC address to gain access to your network, without being imme- Figure 8-10: The Physical Address is this

diately recognized as an unauthorized intruder. card's MAC address.
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Determine the MAC Address of a Macintosh PC

e
B Deterpine the MAC Address --
rO WLAN Utility
‘ I Authentication:
1. Tap the wireless connection icon on the status bar at fons: Mode:
the top of the Pocket PC’s Today screen, and then tap MAC Address:
Settings. Network Inf
2. In the resulting WLAN utility screen, tap the icon for T
: eway:
your WLAN connection. Setevey ————
s
3. Tap the Advanced tab. Note the MAC address (see
Figure 8-11).
Main | Site | Cmﬁg| TDBE:| Advanced 4 »
The steps here assume you have a Pocket PC running Windows =l
Mobile 5 or better. Most handheld devices with Wi-Fi capability are Figure 8-11: Check the MAC address
similar, however. for your Pocket PC.
006 Network =

Determine the MAC Address ' ——— —
0{“ Macintash pc Show: | Built-in Ethernet }-:j_

[repnp | perot | AppleTalk | Proxies |

1. Choose Applem>System Preferences to open System

Configure: ' Using DHCP s
Preferences. )
DNS Servers (Optional)
2. Click the Network icon to open the Network control IP Address: 192.168.0.106
1 (Provided by DHCP Server}
pane : Subnet Mask: 255.255.255.0
3. In the Network control panel, note the Ethernet Address Router: 192.168.0.10 Search Domains ___ (Optional
. . 7
(see Figure 8-12). The Ethernet address is the computer’s e
MAC addl’eSS. (Optional)
Example: apple.com
Ethernet Address: 00:30:65:6d:el:fc earthlink.net

Make sure that you have the right connection selected in the Show
menu of the Network control panel. If you are connecting to the
network with an AirPort card, the Built-in Ethernet option won't give (@) Click the lock to prevent further changes. e
you the correct MAC address.

Figure 8-12: A Macintosh's MAC address s listed as the Ethernet Address.
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Blgz a szgrom the Router
D ro ! Q Q e rol panel for your WAP using a Web

browser.

Locate the filter controls and select MAC filters (see
Figure 8-13).

Select the Only Deny Computers option to create a
MAC filter that will deny access to a specific MAC
address.

See Chapter 6 for steps on MAC address filtering.

Enter a name for the rule, and enter the MAC address
for the unwanted device.

Click OK or Apply to save your changes. The new MAC
filter appears in your list of MAC filters, as shown in
Figure 8-14.

Double-check that SSID broadcast is disabled in your
access point.

Disable SSID broadcast before you change the SSID and other net-
work security keys as described in the following step.

Change the SSID, WEP key, WPA-PSK passphrase, and
administrator password for your access point.

You should change the SSID and all security keys in your wireless
devices any fime you even suspect that your network has had an
unauthorized infrusion. Although MAC filtering creates a roadblock
for the infruder, diligent intruders can get around that road-
block either by MAC address spoofing, or by simply using a differ-
ent computer.

Wirtued Sorver

1]/

Firewall

Lid

DMZ

Performance

i

Fimers are uzed 10 Gllow or deny LAN wsers fram accessing the Intarnet
3 1P Fiers © URL Blocking
%) MAC Filters © Domain Blocking

Use MAL addiess o allow or dany computers accass to the netwark

1 Dizsbied MAL F
© Only allow cor

th MAC address listed below to access the network

& Only dany com MAL addrecs Eetad balow 1o accate the network

Nama Infruder] L.gr"_"_J
MAC Address 00 d |-Pa |- |- |3
DOHCP Chent | b8-740 00-00-3A-30-23-73 » [Cione |
Apply Cancel Help
Hame MAL Address

Figure 8-13: Filter unauthorized MAC addresses from your network.

DI-624 l

Wirtued Sorver

Applicationy

|
Firewall

160/mn

BT Advanced [P Help

Filters are weed 10 allow or deny LAN users fram accessing the Intarnet

1P Filiews * LRL Blocking
& MAC Filtare © Damain Blocking

Usa MAT address o allow oe dany computers accass to the netwark

 Disabied MAC Fiers
3 Only allow computers with MAC address listed below to access the network
& Dnly dany computars with MAT addrecs Etd balow 1 atcase the netwark

e [Clons |
MAL Address
OHCP Clhent | O0-00-34¢ 7-08-0% » | Cone |
Apply Cancel Help
HNama MAC Address
Inteuddert O0-00-34-20.23-73 [£5]

Figure 8-14: The MAC filter now appears in your list of filters.




Block a User with a Security Program

Block a Use wlth a s
D 1 ) Topievert the selected computer hom v
r G accessing your local computer, click Add =
Exceplion. This wil add a new exception la the
currently active Personal Firewall profile
Propesty Yalue
Open your Internet security program, open the Wi-Fi gt Jrkon
C [T —
detection screen used for detecting computers on your Lt lanel e T,
network, and find local computers, as I describe earlier JiCeceope Huisshibe

<] m | [

in this chapter.

Detected 10/30/2005 20:42

2. Select the computer you want to restrict and click
Propertles~ This action cannot easily be undone. Ta re-enable access for

the selected camputer, remove the exception fram the Persanal
Firewall Exceptian List. Cansult the anline Help far mare

3. Block access from the offending computer. In Trend o
Micro’s Internet security program, shown in Figure 8-15,
click the Add Exception button to block the computer.

Figure 8-15: Click Add Exception fo block
Blocking an intruder using an Infernet security program installed on out this computer.
a specific computer does protect the data on your computer, hut it
does not block the intruder from the rest of your network.
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DrdWsoiireing Network —
erformance Chapter

If you want to keep your wireless network running fast and efficient,

you need to continuously monitor its performance. The speed of a Wi-Fi
network is measured in megabits per second, or Mbps. Ideally, your Wi-Fi
gear should be running at 54 Mbps — the speed of 802.11g Wi-Fi gear — or

better. However, some components may cause your network to slow down
to 802.11b speed, which is 11 Mbps. At this slower speed, transferring files Get ready to...
takes longer, multimedia plays poorly, and downloading e-mail and Web w=» Review Wireless Bandwidth Statistics .......... 84

pages takes longer.
= Receive Router Logs by E-Mail.................... 85

In this chapter, you find out how to measure the speed and range of your
Wi-Fi network, and how to determine the IP address of each computer on w= |dentify Computers on Your Network........... 85
your network. Knowing each computer’s IP address helps you troubleshoot . . ,

various network problems and identify potential bottlenecks. »= Determine a Windows PC’s IP Address .......86

Most manufacturers of Wi-Fi gear now offer special speed boosting technologies designed = Determine o Mac's IP Address ............... 86
to let you network at speeds even faster than 54 Mbps. Keep in mind, however, that w= Determine a Pocket PC's IP Address............. 87
these speed-boosting technologies are usually proprietary. Therefore, to take advantage )

of the faster speeds all of your networking gear has to be from the same manufacturer. w= (heck the Speed of a Wireless PC ............. 87
A 102 Mbps Wi-Fi card from Manufacturer A probably won't work at 102 Mbps if it's con- = Measure Your Wi-Fi Range ................. 88

necting fo a 102 Mbps access point from Manufacturer B.



Chapter 9: Monitoring Network Performance

D ro E)eﬁ w Wlizagss Bandwidth

1. Log in to your access point using a Web browser.

2. Locate the traffic statistics screen in the access point’s
control panel. Look for a Traffic or Stats button or link
(see Figure 9-1).

3. Review statistics for the wireless portion of your network
and compare it to other network traffic.

WAN stands for wide area network, and LAN stands for focal area
network. The WAN is usually your Internet connection, and the LAN
is your local network. LAN traffic includes wireless traffic, so if you
don't have any Ethernet wired computers the LAN and wireless sta-
tistics should be about the same.

Reset the counters and then check them 24 hours later. Do this on
a regular basis to get an idea of your normal daily bandwidth. An
abnormal surge in wireless traffic may indicate that an unauthor-
ized user is on your network.

4. Locate the list of wireless clients and make sure that
each device belongs to you (see Figure 9-2).

| discuss how to identify wireless users in Chapter 8. Even if all of
the devices belong to you, disabling unused wireless devices (such
as game consoles or printers that are not currently in use) can help
speed up your network.

84

DI-624 l
Home  Advanced  Tools LT Help |
'i'raﬁ’l: Statistics display Receive and Transmit packets passing through the DFG24.
‘ Device Info Refresh 0
= Help
[T Log Receaiva Transmit
WAN 1810907 Packets 2103784 Packete
LAN 2210848 Packets 2252685 Packets
Stats WIRELESS 11g 187655 Packets B32705 Packets
Wireless
o . .
Figure 9-1: Monitor bandwidth.
DI-624 t
Home Advanced  Tools Status m

“, - Connected Wireless

J Device Info

(Access Point).

Connected Time MAC Address
- Now 1272005 13:13:40

g s Now7 72005 10:14:46
" Log

The Wireless Client table below displays Wireless clients Connected to the AP 0

Help

Iode

00-08-20-82-1E-31 24
00-0D-3A-17-08-D9 24

GHz
GHz

Figure 9-2: Check the number of wireless clients on your network.




Identify Computers on Your Network

Identify Computers on Your Network

1.

Receiye Rwﬁr Logs by E-Mail

Drop

2.

i=10]0

browser.

& control panel using a Web

Open the Logs screen of the router control panel and
click the Log Settings button or link.

In the log settings, select the type of information you
want e-mailed to you (see Figure 9-3).

System activity indudes DHCP requests, which occur when a com-
puter joins your network.

Enter the SMTP Server for outgoing mail and your
e-mail address and click OK or Apply.

You can obtain the address for your SMTP mail server from your
ISP. SMTP servers are used for outgoing mail.

Log in to the router’s control panel using a Web
browser.

Open the DHCP screen in the router control panel and

locate the list of DHCP clients (see Figure 9-4).
Note how many computers are using your network.
Each computer on your network must have a unique IP address,

which is assigned by the router's DHCP server. The DHCP client list
lists computers currently or recently acfive on your network.

SMITP Senver { IP Address mad myisp com

isp Com

Syetem Actiity

[r— (] Dobug Informeati

T
B Attacks

[ —

7 Drapped Packots

Bl motice

DI-624
l Home _ Advanced Too (TR Help |
Logs can be savad by sending it to an admin emai address
Device Info

Sand Mail How |

@ 00

Apply Cancel Help

Figure 9-3: Set up your router to e-mail the logs o you.

e
L1, Advanced DG Status Help
The DHE24 can be setup as 3 DHCP Sarer o distribute 1P addrassas to 1he LAN
e notwark
DHCP Server & Enablod Disablod
P— Starting IP Addrens 192 163 0 100
Wireless E e =
nding IP Addiess 192 168 0 199
Lot Timo 1Wook [
WAN
— Static DHCP is used to alow DHCP server to assign sam 1P address to speciic MAC
LAN addness
O Enabind & Disablod
| DHCP I Name
e ® 192 1680
MAC Address
DHCP Clent WM_The_Asbiler 10-09-20-821E-31 || [ Clone |
2 OO0
Apply Cancel Help
Host Nama IP Address MALC Address
Hhast Name 1P Address WAL Adiress Expred Tim
W_The_Asbater 19216800100 00.03-ZD-82-1E-31 MNewl22/2005 182542
nle-mackame 1921680101 00-11-50.96-10.596 Mew222005 183015
SOYOPA 192 168.0.105 D0-50-20-07-B3.25 Neowf2272005 060840

Figure 9-4: Use the DHCP client lists to identify computers on your network.
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D (o l’))e%g Jz éVindouls PC’s

1. Choose Start=>All Programs=>Accessoriest>
Communication=>Network Connections.

2. In the resulting Network Connections window, click
your current network connection once to select it.

3. Note the IP address and other information under
Details on the left side of the Network Connections
window (see Figure 9-5).

You can use the Network Connections window to check the IP address
of any Windows network adapter, whether it is a wireless adapter
(such as the one shown in Figure 9-5), or an Ethernet adapter.

If you have an older version of Windows, open the MS-DOS
Command Prompt from the Windows Start menu. At the command
prompt, type IPCONFIG and press Enter. The computer’s IP address
and other network information will be listed in the Command
Prompt window.

Determine a Mac’s 1P Address

1. Open System Preferences from the Apple menu.

2. Click the Network icon in the System Preferences
window.

3. Select your current network connection in the Show
menu, and then note the IP address that is listed (see
Figure 9-6).
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W Network Connections =1 |
File Edih View Fawvorltes Tools Advanced Help i
¥ search | Folders [T~
| access W8 Network Connections «| £ Ga
- - Name Typa Status |
mﬁ'ﬂ- =] Intermet Gateway
Uther Mlaces ¥ “Jintemet Connectlen Internat Gateway Disabled
el & LAM or High Spaad Intermat
Wireless Network L1394 Connectlon LAH or High-Spaed Int... Connected
Connectinn ? U \Wiraless Natwork Connection 2 LAN or High Speed Int... Connected
Connected
1P Address: 192.160.0.101
Tubred Wik: 755755 355 1
Aszgned by DHCE
TP Enabiled
Arcess Pk
Postwork: SErent 118t
Ercryphion: Ensbind
Shandl srength; Loselent
| - 4] 2
[l 02, 1 1 Mok Ao
o . 1
Figure 9-5: Determine a PC’s IP Address.
86 E Network (=

Location: = Automatic

Show: | Built-in Ethernet | :!

[repsip | peroe | AppleTalk | Proxies |

Configure: | Using DHCP

H

DNS Servers

(Optional)

IP Address: 192.168.0.106
(Provided by DHCP Servery

Subnet Mask: 255.255.255.0

Router: 192.168.0.10

Search Domains

(Optional)

DHCP Client ID:
(Optional}

Ethernet Address: 00:30:65:6d:el:fc

.
é'/ Click the lock to prevent further changes.

Example: apple.com

earthlink.net

Apply Now

Figure 9-6: Check the IP address for your current network connection.
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Check the Speed of a Wireless PC

Deterpine a, Pocket PC’s 1P Address
00kS

screen.

tion icon on the Pocket PC’s Today

2. In the wireless LAN utility, tap the Advanced tab (see
Figure 9-7).

3. Note the IP address listed on the Advanced tab.

If your Pocket PC was connected to a deskiop computer using
ActiveSync, it may have obtained an IP address from the deskiop
PCinstead of the router. The steps here assume that your Pocke PC
is connected through Wi-Fi to your wireless router/WAP.

Check the Speed of a Wireless PC

1. Double-click the system tray icon for your wireless
connection.

Remember that the Windows system tray is the area in the lower-right
corner next to the dock. If you don't have a system tray icon for
your wireless connection, choose Start=>All Programse>Accessories=s>
Communications=>Network Connections and then double-dlick the
listing for your wireless network connection.

2. Note the speed shown for the connection (see
Figure 9-8).

Most wireless connection management utilities have a speed meas-
urement similar to the one shown here. Simply open the connec-
tion’s status window 1o review a current graph of connection speed.

WLAN Utility
Authentication:  |Open System
MAC Address: 00-09-2D0-82-1E-31
Netwerk Inf
Net. Mask: 255.255.255.0
Gateway: 152.168.0.10
IP Address: 192.168.0.100
Main | Site | Cmﬁg| TDBE:| Advanced 4 »

Figure 9-7: Note the Pocket PC's IP address.

1 Wireless Network Connection 2 Status 3]
| General ‘gupp'o}{\
Connection
Status: Connected
Nehwork: SEren1TYv46
Duration: 01:14:28
Speed 54.0 Mbps
Signal Stiength: IIMH
Acivily
Sent — -:J§| — Recsived
i (]
Packets: 4,002 | 4231
[ Propeties ] [ Dizable ] [ Wiew Wwireless Metworks ]
Close

Figure 9-8: Check the speed of your connection.
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Droﬁ.

88

ure Vour Wi-Fi Range

thQs a indow for your wireless connection.
(If you're using a Pocket PC, open the Config tab of
the wireless LAN utility, as shown in Figure 9-9.)

Move the computer to different locations and note the
signal strength.

Note the signal strength in different locations. In
Windows, right-click the wireless connection icon in
the system tray to see the Wi-Fi signal strength (see
Figure 9-10).

Geographic distance isn't the only factor that affects the range of
your Wi-Fi network. Brick walls, heavy furniture, and other objects
can create additional interference. Just because the signal strength
is poor in your living room doesnt mean that a neighbor two
houses away can't receive your network’s signal.

Some Wi-Fi antennas are stronger than others. If you have more
than one wireless computer, fest your Wi-Fi range using every
device, noting which unit seems to get the best recepfion. Use the
unit with the best reception o test the range of your network.

WLAN Utility

Current Configuration —888
Pref S5Id: SEreniTY46

BSS Type: Infrastructure

BSSId: 00-0D-88-BD-F4-53

Tx Rate:
Signal Quality

[ Poor -63/0

Main Ete Ccnﬁg|TDuh|Ad‘vamai REI

Figure 9-9: A poor Wi-Fi signal.

Speed: 54,0 Mbps
Signal Strength: Excellent
f———|Skatus: Connected

‘Wireless Metwork Connection 2 (SErenl T46)

Q”@@_,?E 10:34 PM

Figure 9-10: An excellent connection.



DrdpptsgKing the Speed
and Range of Your Chapter

Network " o

Wreless networks make it easier to use technology throughout your

home or small office. However, you may find that your wireless net- Get ready to...
work doesn’t perform quite as well as you'd hoped. Performance problems
with wireless networks can usually be divided into two categories: w= |dentify Wi-Fi Bottlenecks ..............ccccconne. 90
w= Speed: Sometimes your wireless network may seem to operate very = Adjust Access Point Speed Settings............... 90
slowly. You're not likely to notice slow Wi-Fi speeds when browsing
the Internet wirelessly, but you may notice it if you are copying large == Network Faster than the Speed of G ........ 91

files over Wi-Fi or trying to stream high-quality audio and video. You

ey Pocit .
may be able speed up your network by identifying speed bottlenecks Positon the Access Point for Best Range ...92

and removing slow devices from the network. w= Eliminate Wi-Fi Interference ..................... 92
w= Range: Wi-Fi range is unpredictable. If you want to increase the range of w= Add a Range Extending Antenna
your wireless network, you can do a number of things. Some things — 1o Your Access Point 93
like range-extending antennas and Wi-Fi repeaters — cost money, while
others don't. w= Use a High Gain Antenna
with a Wi-Fi Adapter 93

This chapter helps you improve the speed and range of your wireless net-
work by avoiding interference, using high-gain antennas, and using special w= |ncrease Range with a Wi-Fi Repeater ........94
devices designed specifically to boost Wi-Fi range.
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Idrg‘lg ujiéFi Bottlenecks
D ro p Q ox®lentation or labeling for wireless

devices to make sure that they are compatible with the
802.11g Wi-Fi standard.

2. Open wireless networking utilities on suspect devices
and check the transmission rate (see Figure 10-1).

In Figure 10-1, the Tx Rate is 11Mbps, which is the speed of
802.11b network gear. If this device is only compatible with
802.11b, installing it could cause your entire network to slow down
t0 802.11h speeds.

3. Disable 802.11b gear when maximum Wi-Fi speed is
needed.

Adjust Access Point Speed Settings
1. Login to your access point using a Web browser.
(For just the steps to do so, refer to Chapter 1.)
Locate the performance controls (see Figure 10-2).

3. Select the Enabled radio button by the 802.11g Only
Mode option and click OK or Apply.

Adjusting this setfing forces your wireless network to perform at the
faster 802.11g speed, but 802.11h gear may be unable to access
the network.

90

WLAN Utility

Current Configuration —8M8M8
Pref SSId: SEreniTY46

BSS Type: Infrastructure

BSSId: 00-0D-88-BD-F4-53

T Rate:
Signal Quality

[—]  Good -31/0

Main | " Conﬁg| Tmt:| Advanced REI

Figure 10-1: This device is networking
at 802.11h speeds.

Firewall

[l

DMZ

Performance

S8ID Broadcast

CTS Mode
Super G Mode

Preamble Type :

802.11g Only Mode :

D624 |
" Home BWYICLTLER Tools Status Help
s‘ : Wireless Performan
These are the Wireless Performance features for the AP(Access Point) Portion,
] Virtual Server
TX Rate: | Auto [w|(Mdbps)
] Beacon interval ; 100 (msec, range:20~1000, default:100)
Applications RTS Thieshold (2348 | (range: 1~2346, default:2345)
Fragmentation : 2396 {range: 256~234B, default: 2348, even number only)
Filters DTIM interval - 1 {range: 1~255, default:1)

® Short Preamble O Long Preamble
© Enabled @ Disabled

(&l Enapled O Disabled

© None O Always @ Auto

Super G with Dynamic Turbo [v]

2 ©0

Apply Cancel Help

Figure 10-2: Enable the 802.11g Only mode.




Network Faster than the Speed of G

These are the Wireless P features for the AP( Point) Portion.

Netﬂ'k Faiter than the Speed of G T T agvanced ST
D ro p Q Qa C oint and wireless adapters that use Rictwatserver

. . Ti Rate : Auto [v|(Mdbps)
the same wireless acceleration technology.

Beacon interval - 100 | (msec, range:20~1000, default: 100}
Applcations RTS Threshold : (2346 | (range: 1~234, default:Z346)
Fragmentation - 2346 | (range: 2556~2346, default 2346, even number anly)
Filters DTIM intereal : 1 (range: 1~255, default:1)
Preamble Type : @ Short Preamble © Long Preamble
SSID Broadeast : O Enabled @ Disabled
802119 Only Mode © & Enabled O Disabled

Belkin, D-Link, Linksys, Neigear, and most other manufacturers of
Wi-Fi gear offer accelerator technology that allows connections
even faster than 802.11g gear. However, these accelerator tech-
nologies are usually proprietary, which means that to actually use L o

the higher speeds the access point and all Wi-Fi adapters must be of e

the same brand and have the same accelerator technology. e nouums 2 O O

Super G with Dynamic Turbo
Super G vith Stalic Turbo Apply Cancel Help

Firewall

iy

2. Log in to the access point’s control panel and enable the
accelerator technology (see Figure 10-3).

Acceleration controls are usually found on the Wireless, Advanced,
or Performance screens. Keep in mind that some accelerator tech-
nologies may be incompatible with networking gear from other
manufacturers. If some of your devices are unable to access the

Figure 10-3: Enable the access point's accelerator technology.

[+] D-Link AirPlus Xtreme G Wireless Utility 2E]

network after you turn on acceleration features, you may need to NN ot [EeccasaBssiD-0000 6 B0 EAS)
disable the acceleration. . S0 [indehome
Encryption = o Mips
. . Channel & Ri
3. Launch the wireless adapter software on the client com- o Burvey =
. r Link Quality/Signal Strength
puter (see Flgure 10-4). Link Quality 100% Sigrial Shrength 100%

Itis usually necessary fo use the adapter's proprietary software to —
take advantage of accleration technology. The Windows wireless T L ee [
connection manager can only manage 802.11a/b/g networks.

4. Make sure that the client software uses the same acceler-

ation settings as the access point. Figure 10-4: The wireless adapter’s utility program.
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Position the Access Point
Drop.ﬁf

Choose a location that is central to your wireless clients,
as shown in Figure 10-5.

Mount the access point high and away from obstructions.

Try to mount the access point away from heavy furniture and other
large obstacles. Avoid placing the access points near brick, cement,
or plaster walls. Windows, mirrors, and other reflective surfaces can
also reduce signal range.

Experiment with different locations to see which gives the best
@ range.

Eliminate Wi-Fi Interference

1.

92

Do not position the access point near appliances that
cause interference on the 2.4 GHz band (see Figure 10-6).

Microwaves and baby monitors often cause interference on the
2.4 GHz band.

Try to use cordless phones that use the 900 MHz or 5.8
GHz bands.

In the unlikely event that you have an 802.11a network, you may
want to avoid 5.8 GHz phones because 802.11a gear uses the
5 GHz band.

Separate Bluetooth and Wi-Fi gear, if possible. Bluetooth
signals can cause minor inference with 802.11b/g gear.

camera

Ty

-

-

=

Figure 10-5: Choose a central location for your access point.

T

Figure 10-6: Microwave ovens cause Wi-Fi inferference.
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Use a High Gain Antenna with a Wi-Fi Adapter

opBOSkS "

1.

2.
3.

Choose a directional or omni-directional antenna (see
Figure 10-7).

Directional antennas like the one on the left can be imed to con-
cenfrate the range in a specific direction. Omni-directional antennas
like the one on the right increase range in any direction.

Connect the antenna to your access point.

If you have a directional antenna, point it in the direc-
tion where you want to most boost your Wi-Fi range.

Use a High Gain Antenna
with a Wi-Fi Adapter

1.

Obtain an antenna that is compatible with your Wi-Fi
adapter.

Connect the high gain antenna to the adapter.

Position the antenna as high as possible for best
reception (see Figure 10-8).

Generally speaking, you can only add a high gain anfenna to a Wi-
Fi adapter if the adapter has a removable antenna. USB and card-
bus adapters usually do not have removable antennas, but PCl card
Wi-Fi adapters usually do have removable antennas.

Figure 10-8: Place the Wi-Fi client antenna on top of your desk.
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Drolprivgﬁfe liznge with a Wi-Fi

1.
2.

3

5.

94

Obtain a Wi-Fi repeater or range extender.

Use an Ethernet cable to connect the repeater to your
router/access point, or directly to a computer.

Log in to the repeater’s control panel using a Web
browser, just as you would log in to your regular
access point.

Configure the repeater to use the same SSID and encryp-
tion settings as your regular access point.

After configuration is complete, disconnect the Ethernet
cable and position the repeater about halfway between
the access point and the most distant computer, as
shown in Figure 10-9.

When positioning a repeater, it must be within range of your regu-
lar access point.

L e e

i

Figure 10-9: A range extender increases the range of your Wi-Fi network.
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etwork Problems

Wreless networking is only cool and convenient when it works right.
Networking problems can — and probably will — occur at some
point. You've probably been there before; you try to log on and you can’t
download e-mail, print a picture, or copy files over the network.

The causes of networking problems are many and varied, but they can
usually be solved by following a methodical troubleshooting process. In
this chapter, I take you through the troubleshooting process in order from
the simplest solutions to the more complex:

m= Restart: When you contact a software company for technical support,
often the first thing they tell you to do is restart your computer. You
do this first because it's easy, and (more often than not) it works.
Network problems are also sometimes solved by restarting a connec-
tion or the router.

w= Update: Computer software is ever changing. An update of Windows
or the Macintosh OS may also require you to update other programs.
I show you which updates often solve networking problems and how
to perform those updates.

w= Identify: If restarting and updating don't solve the problem, then you
need to identify the source of the problem. Is a defective access point
the culprit, or is the problem on one of your computers?

N R
Chapter

1l

Getready to. ..

w= Refresh a PC's Wireless Connection ............ 96
w= Refresh a Pocket PC's Wireless Connection....96
we Restart DHCP Service ........oovvveeervreereennens 97
= Reboot the Access Point............ccceecceernn. 97
= Troubleshoot a Bad Wireless Connecfion......98
w= Update the Access Point's Firmware............ 99
w= Update Driver Software

for Wireless Devices ..............cuurrrrrrrrnnee 100
= Ping a Network Computer ...........cccooe..... 101

w= Troubleshoot Network Access Problems ....102
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Re sh a C’s Wireless Connection

D ro ystem tray icon for the computer’s

WlI'GlESS connection manager Utlllty to open it.

2. In the resulting dialog box, click the Repair button (see
Figure 11-1) to disable the wireless connection.

If you use the Windows wireless connection manager, simply right-
click the wireless connection icon in the system tray (the area in the
lower-right corner next to the clock) and choose Repair. Windows will
automatically disable and then reconnect the wireless connection.

If refreshing the wireless connection does not restore your wireless
connectivity, try restarting the computer. If that does not work, your
next step is to restart DHCP or reboot the access point as described
later in this chapter.

Refresh a Pocket PC’s Wireless
Connection

1. Tap the Wi-Fi icon in the lower-right corner of the Today
screen to open the WLAN utility.

Tap Turn Off (see Figure 11-2).
Wait about five seconds and then tap Turn On to reacti-

vate the wireless connection.

Generally speaking, if your wireless connection icon shows green it
is not necessary fo refresh the connection. Green suggests an active
and successful wireless connection, and that your connectivity prob-
lem is caused by something else.

96

" Wireless Network Connection 2 Status 2]

| General | Support |

Cannection status
|

F) Addess Type Assigned by DHCF

o |

= 1P Address 192.168.0.100
Subriet Mask: MG | |
Disfault Gateway 192168010 |

Mindows did not detect problems with this
connection, If pou cannat connect, click |

Repair.

Clase

Figure 11-1: Refresh the wireless connection.

WLAN Utility
Power
WLAN ON % Power save mode:
O Enable
Disable
Turn Off 8 -
St [[] Disable WiLAN to
5 consenve power
Setting when battery is
lowi.
Main | Site: | Config | Tools| Advanced | REE

Figure 11-2: Refresh the connection
on a Pocket PC.



Reboot the Access Point

< DI-624
Restart DHCP Service — l Home [T P
.ﬂ-.a DI-G:'; can be sstup a2 3 DHCP Server to distnbute IP sddresses 1o ihe LAN
D ro pL . rQ Ql I 5{ or wireless access point (WAP) N R
using a Web browser (see Chapter 1). FWireless SenglP M IR0 L
Ending IP Address 192 168 .0 199
2. Click the DHCP button or tab (depending on your — Lt ek g
router) to open the DHCP server controls. Static DIEE
'T :;;T:S[:HC“ 18 used to aliow OHCP sever to as#ign eame IP address to SFE{"{ MaC
DHCP stands for Dynamic Host Control Protocol, and is what assigns © Erstind © Disshing
unique IP addresses to every computer on the network. Restarting o o
DHCP can help resolve IP conflicts or other DHCP problems. MAC Adirss
DOHCP Clisnt WH_The_Adbior (10-08-20-02-1E-31 ] [Clana
3. Select the Disabled radio button for the DHCP server, 9 00
and then click OK or Apply to turn off the DHCP server Apply Cancel Help
(See Figllre 11_3). Host ;u‘IME — IP Address MAL Address
4. Return to the DHCP controls, choose the Enabled radio S e
button, and click OK or Apply again to re-activate DHCP. e 192 1680100 00 e

Figure 11-3: The DHCP server conirols.
You may need to reboot other computers on your network to com-

plete the re-assigning of IP addresses.

DI-624 [ )
ISR Siotus  Help

Ping Test is sed 10 send “Ping” packets 10 test if a computer is on the Intemet

Host Name or IP |
address

Reboot the Access Point

1. Log in to your router/WAP using a Web browser
(described in Chapter 1). Firmware

Rebaots the DHE24

Systom Reboot |

When you “Block WAN Ping”, you are causing the public WAN IP addrezs an the DIEM
ta not respend 1o ping commands. Pinging public WAN IP addressss i & common
mithad uaad by hackaes 1o 1651 whothor your WA IP address is valid

2. Locate the control for rebooting the WAP, as shown in
Figure 11-4, and click it to reboot the WAP.

Digcaed PING from WAN side ) Enabled Desabled

]+ HEEE

If you are unable to locate a control for rebooting the WAP, simply I ® Ensbied © Diastind
unplug the WAP's power cord, wait about five seconds, and then ® Enaind O Dissind
plug the power back in. s o
Alows VPN connections to work Through the DHE24.
FPTP @ Enabled © Disablod
IFSec @ Ernsbled O Dissbled

Figure 11-4: Rehoot the WAP.
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[E]%]

System Properties
leshogt a Bad Wireless : .
ystem Restore Automatic Updates 1L Remate
D rO General fomputerName | Hardwate | Advanced

Device Manager

1. Refresh the wireless connection that is giving you trou- DB Fici e gt D s o
tigs of devi
ble, as I describe earlier in this chapter. i :
These steps help you troubleshoot a bad connection. Stop follow- Diivare

@ Diriver Signing lets you make sure that installed drivers are
compatible with WWindows, Windows Update lets you set up
how windows connects ta Windows Update for drivers.

ing the steps when the connection problem is solved.

[ Driver Signing l [ ‘windows Update
2. Temporarily disable the firewall or Internet security soft- L
ware on the computer that is having connection trou- P e
bles (see Chapter 7).
. .
3. Open the wireless connection manager and make sure
that the SSID is correct. Also make sure that encryption
settings and keys match the settings in your WAP.
4. Restart DHCP on your WAP; if necessary reboot the WAP. Figure 11-5: The System Properfies dialog box.
5. 1If the troublesome Wi-Fi adapter‘ls removable — such Y ey =55
as a USB, cardbus, or Ethernet bridge adapter — remove File RIS RMRSNOER
or disconnect it and disconnect any power cords. Then N EFS 2 A =8
reconnect the device. = & NLE- MACHINE
+ ¢ Computer
6. Right-click the My Computer icon in the Windows Start e g:::l‘;:"::amm
menu and choose Properties. + . DVD/CD-ROM drives
+ =) Floppy disk controllers
7. In the System Properties dialog box, click the Hardware - lappyidekiie=s i
. . +-5 Human Interface Devices
tab and then click the Device Manager button (see + 2 IDE ATA/ATAPI controllers
Figure 11_5) +-42 |[EEE 1394 Bus host controllers
. + < Keyboards
8. In the Device Manager window, click the plus-sign next ER e g 0 devicer
to Network Adapters (see Figure 11-6). 758 Network adapters

HS 1394 Net Adapter
E2 Belkin 802.11g Network Adapter

If you see a yellow exclamation mark next to the name of the @3 Ports [COM & LPT)
. . . . . . + %% Processors
adapter, something is wrong. Right-click it and choose Uninstall, + @ Sound, videa and game controllers

+'d System devices
+ & Universal Serial Bus controllers

restart Windows, and then re-install the driver software as
described in the manufacturer’s instructions.

98 Figure 11-6: Check the status of your wireless adapter in the Device Manager.



Update the Access Point’s Firmware

nologies that weren't available when the router/WAP was first produced. For

rQ Ql A 'S( or WAP using a Web browser example, | had to update the firmware in my WAP to use the Xbox Live service.
(refer to Chapter 1).

u gge th e Access po "n tls F"rm ware Firmware updates may add features, fix problems, or add support for new tech-
Drop

. . ; LV Status  Help |
Always perform firmware updates using a wired Ethernet connec- it o |
tion fo the router/WAP. Upgrading firmware over a Wi-Fi connec-

tion may cause damage to the WAP.

ings To Local Hard Dive

Load Setbnigs From Locsl Hard Dive

DI-624 l
®©
Admin
Mime
2. Find the screen that allows you to back up your router = )
or WAP settings (see Figure 11-7). -
|
—

Restore Ta Factary Default Settings

3. Click Save and then save the settings file to a hard drive i
on your computer. - esire | o

Saving your router/WAP settings will make it easier to recover if
a problem occurs during the update.

4. Find the screen that helps you update your firmware
(see Figure 11-8).

Figure 11-7: Back up your settings.

5. Right-click the link to check for updates and choose the
Open in New Window option to open the link in a new
browser window.

Follow the instructions to download the firmware update.
After the update file is downloaded, click the Browse but-

ton to locate the update and then click OK or Apply to Flomneae Don: e, 1 et £03
install it. Sy |
8. Return to the screen for loading settings and reload your S'h ;?w “?D
settings. ?
Usually, when you update firmware the SSID, encryption, and CoteTost

other security settings are restored fo factory defauls.

Figure 11-8: Check for and install firmware updates.



Chapter 11: Troubleshooting Network Problems

Dro p{% IZeSr Software for Wireless

100

Right-click the My Computer icon in the Windows Start
menu and choose Properties.

In the System Properties dialog box, click the Hardware
tab and then click the Device Manager button.

In the Device Manager window, click the plus-sign next
to Network Adapters to expand the list of adapters.

Right-click the network adapter you want to update and
choose Update Driver from the menu that appears.

In the Hardware Update Wizard, choose whether or not
you want to connect to Windows Update to check for an
update, as shown in Figure 11-9, and then click Next.

If you already downloaded an updated driver from the
manufacturer’s Web site, select the Install From a List or
Specific Location option. Otherwise, choose the first
option. Click Next.

If you chose the first option, Windows Update will check for and
automatically install an update, if one is found. In this case, no fur-
ther steps are necessary.

If you are installing from a specific location, choose the
Don'’t Search option in the following dialog box and
click Next.

Choose the appropriate driver as shown in Figure 11-10,
or click the Have Disk button and browse to the loca-
tion containing the updated driver.

Hardware Update Wizard

Welcome to the Hardware Update
Wizard
“windows will search for current and updated software by

Inoking on your computer. on the hardware installation CO, or on
the Windows Lpdate Weh site [with your permission)

Can Windows connect to Windows Update to search far
software?

@) ez, this time only
B tol i sy line [oorinect & devica

) No, not this tims

Click Next to continue.

Figure 11-9: Check for an update.

Hardware Update Wizard

Select Network Adapter o
Which netwark adapter da wou want to install?

g Click the Mebwark Adapter that matches pour hardware, then click OK. If you have an
ﬂﬁ] installation disk for this component, click Have Disk.

Show compatible hardware

Metwork Adapter.
Belkin 802.11g Metwark Adapter

| « Back l[ Mext > ][ Cancel ]

Figure 11-10: Choose your driver or browse.



Ping a Network Computer

<C> Copyright 1985-2081 Microsoft G
S C:\Documents and Settings\The Arbiter.CELERON>ping 192.168.9.183
dress of the computer you want IPinging 192.168.8.103 with 32 bytes of data:

to plng. : -168. 3 tine139ns TTL-128

D r p’n Net‘k k Computer uft-!l ®P [Uersion 5.1.2688 ;@%

In Chapter 9, | go over how to determine a computer’s IP address.
You can also ping your router/WAP which usually has the IP

uddress 192.168.0.1. C:\Documents and Settings\The Avbiter_ CELERON>_

Hanimim = Siis . Maxinuin = 130noMRIIEHENENE 90,

2. In Windows choose Start=>All Programs=Accessories=>
Command Prompt.

3. At the command prompt, type (see Figure 11-11):
ping 192.168.0.1

Replace the IP address above (192.168.0.1) with the address you
want to ping. A successful ping results in four replies.

192.168.0.103
L=

st |[12.168.00 -
4. Type Exit at the command prompt and press Enter to Test Result
. Finging 192.168.0.10 with 32 bytes of data:
close the Command Prompt window. Reply from 192.168,0.10; bytes=32

time=82ms TTL=127

5. Repeat the ping process from other computers. You can Renly fuom ¥ LU
also ping from a computer other than a Windows PC: e TR R estr

time=93ms TTL=127
. . Reply from 192.168.0.10: bytes=32
e Pocket PC: Tap Startr>Settings, tap the Connections s e TTL=127 =

tab, and then tap the WLAN Utility icon. Tap Settings Main] e | Config| ool | Advanced | <)

and open the Tools tab. Type the IP address you want h——

to pi d tap Start. Fi 11-12 sh ful y )

p‘;nl;l.ng e iab Sttt HEE SHOWS @ SUCCessi Figure 11-12: Ping from a Pocket PC.
e Mac: Open the Applications folder on your hard

drive, and then open the Utilities sub folder. Double-

click the Network Utility and click the Ping tab to

bring it to the front. Type the IP address address you
want to ping in the space provided and click Ping.

101
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_ System Restore | Automatic Updates Remate
General | Computer Name Hardware | Advanced |

leshogt Network Access Problems SETPRENE ]
DropBook

&le the firewall or Internet security soft-

ware on the computer that is having connection troubles. B o e e omaton okent youkcompte
Cormputer description; Feith's Main PC
These steps help you troubleshoot a bad network connection. Stop For s it Loyt o Mo
. . omputer.
following the steps when the problem is solved. M i
‘wharkgroup: FREELANCE
2. Ping the router from the computer that is giving trouble, igc?o”‘u:iz?:dbi?g;‘o""kal&igt‘iﬁ“cg'ioa%:{?émﬁin:‘Wk sk
and alSO tI’y to plng another Computer on the network. Taorename this computer or join a domain, click Change. @

Likewise, ping the troublesome computer from another
computer on the network.

A ping test tells you if the computers are able to connect to each
other on the most hasic level over the network.

) i . Figure 11-13: The System Properties dialog box,
3. Make sure that the computer is set to automatically obtain Computer Name fab.
an IP address from the DHCP server in your router/ WAP.
4. Restart DHCP on your WAP, and then if necessary reboot | show how fo set up computers as DHCP clients in Chapter 2.

the WAP.

5. Make sure each computer on the network has the same
workgroup name. In Windows, right-click My Computer
and choose Properties.

6. In the resulting System Properties dialog box, click the
Computer Name tab (see Figure 11-13). Each computer
on the network should have the same workgroup name.

7. Update the driver software for the offending network
adapter.
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DrdfiBding and Using e
ublic Hotspots Chapter

M ost of this book is about home networking. Wireless networking tech-
nologies make home networks a lot more fun and easy to use, but
you don't have to leave Wi-Fi behind when you leave home. Hotspots are

another popular way to use wireless networking. Hotspots are open net-

works that hotels, coffee shops, libraries, universities, airports, and other
establishments make available for anyone with a Wi-Fi-equipped portable Get ready to...
computer. When you connect to a hotspot, you can browse the Internet, we> Protect Your Files from Network Access ....106
check e-mail, or perform other online tasks. Hotspots generally fall into i
two categories: w= Find Hotspots 107
w= Free: You may not be able to get a free lunch, but you can take advan- w= Search for a Wi-Fi Signal.......................... 108
tage of lots of free hotspots. Free hotspots are usually found at public b k
institutions or at businesses (such as hotels) where Internet access is == Connec fo the Network.........ooc..... 108
considered an incidental peric w= Monitor the Connection ..........ooooccccccocce. 109
m= Subscription: Most hotspots require a service fee or subscription to an = D ; -
access service. Companies such as T-Mobile and iPass run nationwide = Disable Automatic Connection .............. 10
hotspot networks that you can access when you pay a single monthly w= Protect Your Computer
subscription fee. from Public Access 11
In this chapter, I go over how to find and use hotspots, as well as how to = Leave the Public Network .........coooe...... 112

disconnect from hotspots when you are no longer using them.



Chapter 12: Finding and Using Public Hotspots

D rOI&}ﬁ@ I«(r Files from Network

106

Choose Starte>Control Panel and then click the
Windows Firewall icon.

If your Windows Control Panel is set to Category view, click the
Security Center icon and then click Windows Firewall.

Make sure that the Windows Firewall is turned on and
then click the Exceptions tab (see Figure 12-1).

Click the box next to File and Printer Sharing to deselect
the option and click OK.

Blocking File and Printer Sharing prevent other network users
from accessing files on your computer.

In the Windows Control Panel, click the Network
Connections icon.

Right-click the network connection you use to connect
to the company network and choose Properties.

In the Network Connection Properties dialog box, dese-
lect the File and Printer Sharing for Microsoft Networks
option (see Figure 12-2).

Click OK to close the Network Connection Properties
dialog box.

Follow these steps again to reactivate file sharing later when you
are disconnected from the corporate network.

& Windows Firewall

General | Exceplions | Advanced |

indows Firewall is blocking incoming network connections, except for the
programs and services selected below. Adding exceptions allows some programs
ta work better but might increase pour security sk,

Programs and Services

Hame

I File and Frinter Sharing

Peer Name Resolution Pratacol [PNRP)
Femote Assistance

[ Remote Desktop

UPnP Framewark

‘windows Peer-to-Peer Grouping

[ AddProgiam.. | [ AddPor. | [ Ed

Display a notification when ‘Windows Firewall blocks a program

hat are the nisks of sllowing exceptions?

_L. Wireless Network Connection 2 Properties 2] %]

| Connect using;

General | wireless Metworks | Advanced|

E@ Belkin 802 11g MNetwork Adapter

This connection uses the following items:
vl gﬁhent for Microsoft Metworks A
BF"E and Printer Sharing for Microsoft Networks
I =1 055 Packet Scheduler |
| Ml %= AEGIS Protocol (IEEE 802.141+3.20.3 |
sl

[ Insial ) [ Uninstal

Description

Allaws ather computers b access resauIces on pour computer
uzing a Microsoft netwark,

Show icon in natification area when cannested
[C] Motifty me when this cannection has limited or na connectivity

Figure 12-2: Disable File and Printer Sharing.

Figure 12-1: Windows Firewall dialog box, Exceptions tab.




Find Hotspots

0t$EOE$
aQ 13 § locator Web site.

JiWire.com is one of several hotspot locator Web sites available on
the Internet. To find others, search for “Wi-Fi hotspots” on any
major Infernet search engine.

Search for hotspots using your address, city, or postal
code, as shown in Figure 12-3.

Most hotspot locators let you refine your search to a specific range.
You can also usually specify whether you want to find free or pay
hotspots.

Check additional local resources including:

e Local schools and city governments sometimes offer
wireless Internet access. In Figure 12-4, the Web site
of the City of Lebanon, Oregon provides details on a
local free and low-cost wireless network.

e Local businesses may offer hotspots. Some promote
their hotspots vigorously, and some don't.

e Subscribe to a national hotspot network service
provider, such as iPass or T-Mobile. If you subscribe
to T-Mobile’s hotspot service, for example, you can
access hotspots in Starbucks, Borders, Kinkos, and
many other popular businesses.

@1 Search for widi hatspo CEE
File Fdit View Favorites Tools  Help :?]
Qeack - © - ¥ 2 S - search Sl Favarites € (0= L [3 3
nddress iG] Wt [y hotspotdocations.him v E oo ek ®
Wi-Fi Hotspot Directory Jiiire = Seanch .
STOP HACKERS! Swarch for Wii| hotspots by nan 1, loation tme, provider, and mose
" - 3 Address or Arpert Cooe
.
" ay
Courtry o
Urited States | 1
08 G =
Zip 1 Pont Code
730
Prozedy (Mies) N
e
& e s detndlone, e  @wee —
Figure 12-3: JiWire.com is an excellent online hotspot locator.
o WiGrotaH Tatarma Taplarer =
File Edit View Favorites Tools Help i
@Back - ) - (%) [2) €0 O search SeFaveries ) (3 L3 B !
&) hitpeiwww el lebanon.or.us node 112 i

City of Lebanon, Oregon

' to Lebanon Online

Public Safety Hame
® palicy Departmont

® Code Enforcement

® Municipal Courl

® Cmergency Management

Upcoming events
Free Cibywide Wi-Fi L) ;"" Council {cabmpder
Throwgh an agresment with local ISP Valnet, the City (11 days)

of Lebanon is pleased 1o announce th construction mure
of a dtywida wirelass natwark, The

ntwork, utilizing new Wi-Fi mesh hardwar fram
Building and Planning  cisco Systems, is the First of £5 type in the state.
* nuilding Division with construction sxptacted to be completed by

* planning Division Jaruary 2006, the system s currently operational in * Clty Departments
roughly farty parcant of Labanon. Anybody with an @ City Feos

802.11 b/ compliant dewee may use the system to B City Lien Information
connect to the intemet for ten hours permanth atne  ® ity Ondinances
Services charge. Those users desiring mone than ten hours per~ ® Contact Infarmatian
¥ Dublic Library manth of cann may purchase plans from valnet  ® Fmalovment

¥ Senlor Centor sTaMting at $19.95 par month

City Government
® Clty Council

Library and Senior

A-bus

Economic
Development

In order to use the system, you simply need
to associaty your Wi-Ei dovice to the “lebanon®

Water and Sewer AECWark and open your web browser. A sipn-up

Serice servor will Allow you to ereate an account and bagn
s enjoying wirless web access, Please watch this site

SR SR and lacal madia outiats for mare information as the
" Payments

matwork nears completion
® Water Quallty "

| €] v o lbaron.or uninodefi 13 j © termet

Figure 12-4: Businesses, schools, and cities somefimes offer free Wi-Fi.
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h for,a Wl Fi Signal

D ro g ess connection utility.

You can usually launch your connection utility by double-clicking
your wireless connection icon in the Windows system fray (the area
in the lower-right corner of the screen next fo the clock).

2. Open the list of available wireless networks, as shown in
Figure 12-5.

If you let Windows manage your wireless connections, right-click
the wireless connection icon in the system tray and choose View
Available Wireless Networks.

3. If the wireless network you want to use doesn’t appear
in the list, click the Refresh button.

Connect to the Network

1. Open the list of available wireless networks in your con-
nection utility.

2. Select the network to which you want to connect, as
shown in Figure 12-6, and click Connect or Configure
(depending on your connection utility).

You may need to follow additional steps to join the network, par-
ticularly if the network requires a subscription. Usually, once you
purchase a subscription you can log in fo the network through a
Web browser.
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& Belkin Wireless Utility
Site Maritor Diagnastics Infarmation
*Wireless Nebworks Link Status |, Statistics

[T] Let this tool manage your wireless settings:

[¥] Enable Radio
Awailable networks
| To connect to an available network, click Configurs.

[ serentvas

| ‘ Fefrash

Freferred networks

[§ sEemTras

Add,

Show wirgless icon in spstray,

o]

Figure 12-5: View the list of available networks.

1 Wireless Network Connection 2

NetwarkTatks Choose a wireless network

R Refrash nstwark list Click an item in the list below to connect to a wireless network in range or to get more

informatior.
S e ! : KeithsADhoc12 Connected 77
Far & home ar smal office jj " Caal
T R sl

This network requires a network key, You are currently connected to this

Related Tasks network, To disconnect From this network, dlick Disconnect below,

dJ Learn about wirsless

networking
¢ Change the order of A SErenl1TY46 d
prefierred networks (\ﬁ)) o
95 Changs advanced i Security-enabled wireless network. iiﬂ!ﬂ
Settings

Figure 12-6: Choose a nefwork to which you want to connect.



Monitor the Connection

Monﬂr the Connection
D ro p QlQKSeless connection icon in the
Windows system tray.
2. If Windows manages your wireless connection,

check the link status on the General tab (see
Figure 12-7).

If you use a different program to manage your wireless connection,
find the fab or screen which shows the status of your wireless link.

3. Make a note of the speed and signal strength.

If the quality of the connection is poor, ry moving your computer
to a different location so that it is closer to the wireless access point
and out of the way of furniture and other large obstructions.

If the hotspot is an 802.11b network, the maximum connection
speed will be 11.0 Mbps, even if your 802.11g wireless adapter is
theoretically capable of faster speeds.

@, @.

4. Check the bandwidth statistics for the connection (see
Figure 12-8).

Bandwidth is usually listed by number of packets sent and received.
Monitoring the bandwidth is a good idea so that you know your typi-
cal usage level. If you observe an unusually high bandwidth, it is
possible that an unauthorized user is accessing your computer.

@.

) Wireless Network Connection 2 Status B3]
.Genela\ Support
Cannection
Status: Connected
Nehwork: SEren1TYvaE
Duration: 02:14:55
Speed: 54.0 Mbps
Signal Shiength: EUBBH
Aotivity
-
Sent — Received
>
T g
Packets: 2,464 1843
|
[ Pmpartlaf_J [ Disable I [ View Wwireless Networks I

Figure 12-7: Monitor the quality of the network connection.

1 Belkin Wireless Utility
Site Monitar Diagnostics __Infarmation
wireless Networks Link Status Staistics
Current activity
Packets senl. 9 &
Pachetsireaelyedit i i s 30 @
| | Packets lost. 1}
Accumlated totals
Total packets sent.......ooooer oo 2570
Tatal packets received. 12560

Figure 12-8: Keep track of your connection bandwidth.
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le Aytomatic Connection

Di
D ro p thQ i § connection utility for your wireless

2.

110

adapter.

Locate the setting that controls whether or not you want
to automatically connect to non-preferred networks.

If you use Windows to manage your connection, go fo the Wireless
Networks tab of the Wireless Network Connection Properties dialog
box and click Advanced to open the Advanced dialog box.

Select the Automatically Connect to Non-Preferred
Networks checkbox and then click Close (see Fig-
ure 12-9).

Select a preferred network in the network list, and then
click Properties.

Clear the setting to automatically connect to the net-
work when it is in range. When using the Windows con-
nection manager, click the Connection tab and then
deselect the Connect When this Network is in Range
checkbox, as shown in Figure 12-10.

Click OK to close all dialog boxes and save your
settings.

Disabling automatic connection is a good idea parficularly if you
pay by the hour for network access.

Advanced &%)

Metworks to access
(%) Any available netwark, (access point prefened)
() Aecess point [infrastucture] networks only

() Computer-to-computer (ad hoo) networks only
[ &wtomatically connect to non-prefered networks

Figure 12-9: Don't let your computer
automatically connect to non-preferred
networks.

SEren1TYd6 properties 6]
Association | Authentication | Connection
Automatic connection
‘Wwhenever this network. is detected, Windows can connect
to it automatically.
[[] Connect when this netwark is in range
[ coea |

Figure 12-10: Disable automatic connection
for preferred networks.



Protect Your Computer from Public Access

Prot mputer 72 Trend Micro PC cillin Internet Security =08
ss PC-cillin” Internet Security 2005
W % Scan for Spyware |
1. Exercise good phy31cal security practices by typing Personal Firewall
paSSWOrdS m peraCy, and by not leaV]ng yOuI' laptop -_ Choose a Personal Firewall profile to help protect your computer against
unauthorized access from the Internet. Enable automatic profile switching to
unattended. automatically change profiles if you change networks
. . . . . . Enable Personal Firewall
Disable file sharing as described earlier in this chapter. o
nose a profile Wireless network |v|
3. Install and use antivirus and firewall programs, such as A Emal B el tehing
the one shown in Figure 12-11. IR RRRRAL
Edit Profile
. Network g oagd # oEdt € Delete
If you don't have another firewall program, at least use the Contral . N
Wiﬂdows Firewu" ih(li iS bUlh in '0 WindOWS XP SP2 ﬂnd |(lIer. Direct connection  Far connection directly to the Internet. |
However, | recommend that you upgrade fo a more powerful third- ' Nevo Ml T roenin o ons el -

puﬂy ﬁrewu" program, uvuiluble from any mmpmer remiler. @ Wirelass network For connection to & wireless network. .

Updates and

4. Disable automatic network connection, as I describe Regiegiinn
earlier in this chapter.

If you leave automatic network connection enabled, your computer
may connect fo rogue wireless access points that mimic the hotspot
to steal your passwords and other sensitive information.

5. Check the SSID of the network you are joining, as .
shown in Figure 12-12, and only connect to networks Al
with a known and trusted SSID. @ SEreniTY46 Unavaiable

The owner of the hotspot should provide you with the proper SSID.
If you don't recognize a network’s SSID, don’t connect to it.

Networks to access:

6. Disable your wireless radio when you are done using the A Ak
wireless network. I describe how to disconnect in the fol-
lowing task.

Wirgless | Network Adapters |

Figure 12-12: Don't connect to unknown
and untrusted networks.
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e the Public Network

Leg
D ro p I'QQ T &e using the wireless network, turn off

112

your wireless radio.

e If you use Windows to manage your wireless connec-
tion, simply right-click the wireless connection icon
in the Windows system tray and choose Disable.

e If you use another wireless connection manager, open
it and turn off the wireless radio (see Figure 12-13).

Turning off the radio profects your computer from unauthorized
access, and it prevents you from racking up hourly access charges
when you aren't actually using the network.

If you don’t plan to use a wireless network again in the
future, select it in your list of preferred networks and
click Remove or Delete.

If you connect o your company’s network using Ethernet, you may
want fo disable the Wi-Fi adapter in your laptop while you're at
work so that other wireless devices in your office don't accidentally
connect to your computer. Right-click the wireless connection icon in
the Windows system fray (the area in the lower-right corner next fo
the dock) and choose Disable from the menu that appears. You can
re-activate the wireless connection later using the Network
Connections icon in the Windows Control Panel.

& Belkin Wireless Utility

Site Manitor
[ Wieless Networks

__ Diagnastics Infarmation

Link Status | Statistics

[T] Let this tool manage your wireless settings:

[[] Enable Radio
Awailable networks
To connect to an available network, click Configurs.

[& sEreniTrss
< KeithsADhool2

i Fefrash

Freferred networks

| § sErentTvas

add.

Show wirgless icon in spstray,

[ ok J[ cameel | sppk | [ Hep

)

Figure 12-13: Disable your wireless radio when
you're done using the network.



Draldabing Ad Hoc
eer-to-Peer Wireless

Connections

M ost of the tasks in this book show you how to create and use wireless
networks using the infrastructure network model. In an infrastructure
network, wireless devices communicate with each other through a wireless

access point (WAP). An infrastructure network is much like a wired Ethernet
network, but without the wires.

You can also network wirelessly without a router or WAP. Wireless com-
puters can connect directly to each other to create an ad hoc network.
Ad hoc networks are useful when:

"= You want to quickly copy files between two wireless computers, and
no WAP is currently available.

»= You only have two computers, and you don’t want to spend the extra
money on a router/ WAP.

If you set up your home network as an ad hoc network, set up Internet Connection
Sharing (see Chapter 2) on the computer that connects o the Internet. Doing so allows
you to share your Internet connection over your ad hoc network.

"= You want to create a temporary network between two Wi-Fi-equipped
game consoles for system-link gaming.

This chapter describes how to quickly set up and use ad hoc networks.

N R
Chapter

Getready to. ..

w= Enable Ad Hoc Networking ...................... 114
w= Set Up Ad Hoc Networking

on a Pocket PC 115
w= Connect to the Ad Hoc Network ................ 116
w= Connect a Pocket PC to an

Ad Hoc Network 116
w= Disable Infrastructure Networking............. 117

w= Share Files on the Ad Hoc Network .......... 118
w= Disconnect from an Ad Hoc Network ........118
w= Remove an Ad Hoc Connetion ... 119
w= Troubleshoot an Ad Hoc Network.............. 120
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Drof)

114

le Ad Hoc Networking

S Network Places and then click View
N etwork Connecuons under Network Tasks on the left
side of the screen.

Right-click the Wireless Network Adapter icon and
choose Properties.

In the Wireless Network Connection Properties dialog
box, click the Wireless Networks tab and then click Add.

On the Association tab of the Wireless Network
Properties dialog box, enter a network name (SSID) for
the ad hoc network, as shown in Figure 13-1.

Enable WEP encryption, deselect The Key is Provided for
Me Automatically check box, and enter a WEP key in
the two spaces provided.

SSIDs and WEP keys are explained in Chapter 6. Your WEP key
should be 10 or 26 characters long and use a combination of the
numbers 0—9 and the letters A—F.

Select the This is a Computer-to-Computer (Ad Hoc)
Network check box.

Click OK. The ad hoc network now appears under
Preferred networks, as shown in Figure 13-2.

Click OK to close the Wireless Network Connection
Properties dialog box.

Repeat these steps on each computer to create the ad hoc
connection.

Wireless network properties 2]%]

Association | Authentication | Connection

Metwork name (5510) FeithzaDhoc12
Wireless network key

This network requites a key for the following:

Metwark Authentication: | Open |
Data encryption: [\wep |
et ok e oo —

Confirm netwark. key: SEESSEESEEEEEEEEEEIEESS

Keyinder (advanced): 1 | ]

[ The key is provided for me automaticaly

This is @ computerto-computer (ad hos) netwark; wieless
aceess points are not used

Cancel

Figure 13-1: Create a SSID and WEP key for
your ad hoc network.

-L Wireless Network Connection 2 Properties 2[=]

General | Wireless Networks | Advanced
Use Windows to configure my wireless network settings

Available networks:

To connect to, disconnect from, of find out more information
about wireless netwarks in range. click the buttan belaw.

“iew wiireless Networks
Preferred networks:

Automatically connect to available netwarks in the arder listed
beelow:

" § SErenl TT46 [Automatic] |
B KeitheADhoco 2 [Automatic]

l Add.. II Remove H Properties |

Leart about setting up wirsless network Advanced
confiquration

Figure 13-2: The ad hoc network is now a
preferred network.




Set Up Ad Hoc Networking on a Pocket PC

Set

1.

g Ad Hoc Netulorkmq

Tap the Wi-Fi icon in the lower-right corner of the Today
screen to open the WLAN settings.

Alternatively, tap Startc>Settings, tap the Connections tab, and
then tap the WLAN Utility icon.

Tap Setting.
In the list of wireless networks, tap Add New.

On the General tab that appears, enter the SSID for your
ad hoc network next to Network Name and select the
This is a Device-to-Device (Ad Hoc) Connection option.

Tap the Network Key tab (see Figure 13-3).

Choose WEP for the encryption type, and enter the
Network key.

SSIDs and WEP keys are explained in Chapter 6. Your WEP key
should be 10 or 26 characters long and use a combination of the

numbers 0—9 and the letters A—F.

Tap OK to see the ad hoc network listed (see Fig-
ure 13-4).

T 4g 048 ok
Configure Network Authentication e
Authentication:
Data Encryption:
ot
Key index:

General | Network Key | 802.1x
123|1|2|3|4|5|6|?|B|9|I]| [=][®

Tabla[wle[r[t[y[u[i[o[p[L]]
caPlafs[d[f]a[h[j[k[I[/]"]
shift[z[x[c[v[b[n[m[, [. [/]+«
ctfai] " [\ ] [4]t]<]=

Figure 13-3: The Network Key tab.

§; < 9:49 ok
Configure Wireless Networks (7]
Add New...
o default Connecting
P SEren1TY46 Available
ACTIONTEC Unavaiable

Unavailable

Metworks to access:
[all Avaizble M|

‘Wireless | Network Adapters |

Figure 13-4: The ad hoc network is
ready fo use.

115



Chapter 13: Making Ad Hoc Peer-to-Peer Wireless Connections

Droﬁ’.

gect toléhe Ad Hoe Network
QQ,

Q

In the My Network Places window, click View Network
Connections under Network Tasks on the left side of the
screen.

Network Places.

Double-click the Wireless Connection icon to open the
Wireless Network Connection Status dialog box.

Click View Wireless Networks.

If you are currently connected to another network —
such as a WAP-based infrastructure network — select it
in the list of networks, and then click the Disconnect
button.

Select the ad hoc network and click Connect. The con-
nection acquires a network address and then connects,
as shown in Figure 13-5.

If the ad hoc network doesn't appear in your list of available net-
works, click Change Advanced Settings under Related Tasks on the
left side of the screen. This should reveal any ad hoc networks that
you have configured on the computer.

Connect a Pocket PC to an Ad Hoc
Network

1.

116

Tap the Wi-Fi icon in the lower-right corner of the Today
screen.

In the WLAN utility, tap Setting.

Tap-and-hold on the ad hoc network and then choose
Connect from the menu that appears, as shown in
Figure 13-6.

157 Wireless Network Connection 2
Kbark Tk Choose a wireless network
ﬂ Refresh network list Click an item in the list below ta connect to a wireless network inrange or ko get mare
information,
<2 Set up 3 wireless netwotk L FKeithsADhoc12 Connected ¢
For & home or small office 4://“_ _
-_) i Security-enabled compuiter-fo-compliter netwark lll!ﬂ
This nebwark requires a network key, You are currently connected to this
REStediiass netwark, To disconnect From this nabwork, cick Diseonnact below,
A Learn about wireless
nietworking
Change the order of SEren1TY46 !
% preférred netuorks (i(r) £
g b 5 Security-enabled wireless network il
settings

Figure 13-5: Connect to your ad hoc network.

Remove Settings

@ ACTIONTEC

Unavailable

Networks to access:

All Available

‘Wireless | Network Adapters |

Figure 13-6: Connect o an ad hoc
network from a Pocket PC.




Disable Infrastructure Networking

Disa‘ée: Italztmcture Networking
D ro p Ql #reless Connection icon in the

Windows system tray.

The system tray is the area in the lower-right corner next to the
clock.

In the resulting Wireless Network Connection Status
dialog box, click Properties.

In the Wireless Network Connection Properties dialog
box, click the Wireless Networks tab and then click the
Advanced button.

In the Advanced dialog box shown in Figure 13-7, select
the Computer-to-Computer (Ad Hoc) Networks Only
option and click the Close button.

In the Wireless Network Connection Properties dialog
box, make sure that only ad hoc networks are listed
(see Figure 13-8).

Click OK and then click the Close button to close all
open dialog boxes.

Choosing ad hoc networks prevents your computer from automatically
connecting to available infrastructure networks, thereby simplifying
the process of making ad hoc connections.

Advanced &%)

Networks to access
() &y available network (access point prefermed)

() fecess point [infrastiucture] networks only

(&)Computer-to-computer (ad hoe] networks onli

[ éwtomatically connect to non-prefermed networks

Close:

Figure 13-7: The Advanced dialog box.

B

L. Wireless Network Connection 2 Properties

(%

General | Wirsless Networks | Advanced
Uze Windows to configure my wireless netwark settings
Auvailable networks:

To connect to, disconnect from, o find out mare infarmation
about wireless networks in range, click the button below.

Vievs Wireless Metworks
Fretemed netwarks:

Automaticaly connect to available networks in the order listed
below;

| | & keithsadhoe [On Demand) |

&> KeithsADhool 2 (On Demand) |
Move down

| [ Remove | [ Propetties |

[ Add

Learn about setting up wireless network
configuration

Figure 13-8: Only ad hoc networks are listed.
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Chapter 13: Making Ad Hoc Peer-to-Peer Wireless Connections

e Fileg on the Ad Hoc Network
D ro g kaplorer or My Computer.

In the Address bar, enter two back slashes and then the
name of the other computer, as shown in Figure 13-9.

Press the Enter key. A list of shared folders and resources
appears. Open a shared folder to access it.

Use the Edit menu to cut, copy, and paste files over the
network.

To determine the name of a computer, right-click the My Computer
icon and choose Properties. Click the Computer Name tab, and note
the name listed next to Full Computer Name.

Disconnect from an Ad Hoc Network

1.
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Right-click the Wireless Connection icon in the
Windows system tray.

Choose Disable from the menu shown in Figure 13-10.

Disabling the wireless connection disables all wireless connections to
the computer. If you want to disconnect from an ad hoc network
and connect fo an infrastructure network, double-click the Wireless
Connection icon and click View Wireless Networks. Select the Ad Hoc
Network and click Disconnect. Then choose an infrastructure net-
work and click Connect.

On a Pocket PC, tap the Wi-Fi Connection icon on the
Today screen, and then tap Turn Off in the WLAN
Utility. To connect to a different network, tap Setting,
tap-and-hold on the network to which you want to con-
nect, and choose Connect.

©4Printers and Faxes
%« [)Scheduled Tasks

Details £

NLE machine {(Nle-machine)

J NLE machine (Nle-machi BEF]
File Edit View Favorites Tools Help ,','
@ Back ~ () ? /-. !Search || Folders '
Address | 7 \INle-machine b - Go
Name Comments
Network Tasks ¥ . Printer Acrobat Distiller
Lz Printer2 ScanSoft PDF Printer
Dther Places ¥ .7 SharedDocs

Shows installed printers and ...
Schedule computer tasks to r...

S objects

Figure 13-9: Enter the network path of the computer you want to access.

Disable
Status
Repair

View Available Wireless Networks
Change Windows Firewall settings

Open Network Connections

™% 1% 1253 P

Figure 13-10: Disable the ad hoc connection.




Remove an Ad Hoc Connection

Drop

2.

m(g:ban d Hoc Connection

etwork Places.

Click View Network Connections under Network Tasks
on the left side of the screen.

Right-click the wireless network adapter and choose
Properties from the menu shown in Figure 13-11.

In the Wireless Network Connection Properties dialog
box, click the Wireless Networks tab.

Select the ad hoc network, as shown in Figure 13-12.

Click Remove.

If you know that you won't be connecting to any ad hoc connections
for the foreseeable future, click Advanced and choose Access Point
(Infrastructure) Networks Only to keep your computer secure from
unauthorized ad hoc networks.

To delete an ad hoc network from a Pocket PC, open the list of wire-
less networks in the Pocket PC WLAN utility. Tap-and-hold on the
network you want fo delete, and then choose Remove Settings from
menu that appears.

W Netwark Connoctions
File Edil View Favarites Tooks Advancod Help

(D Back - T ) Seach [ Foldes [T~
& Hetwerk Conneclions
— _Name
| etwnet T 9 nemat Gateway
nher Places #  Sdlnternet Connectlon
Octolls ¥ LAN ar HighSpeed Inlernet

L Local Area Conneclion &
Wineless Netwark Con

L1384 Connection 2 Disable

Status
Repair

Croate Shorteun

Rename

Propenies

3|

L Wireless Network Connection 2 Properties 2%

&

General | Wireless Networks | Advanced
Use Windows to configure my wireless netwark settings
Auvailable networks:

To connect to, disconnect from, o find out mare infarmation
about wireless networks in range, click the button below.

Vievs Wirsless Metworks
Fretemed netwarks:

Automaticaly connect bo available networks in the order listed
below;

§ SErentTY46 [Autamatic] |
£ KeithsADhoc] 2 (Manusl] |

[ add. | [ Remove | [ Propeties |

Advanced

Figure 13-12: Remove unused ad hoc networks.

< ElGe

Type

Intammaet Gatwway

LAN or High-Speed Int...

W
View Available Wireless Hetworks 1

Bridge Connactions

J Vs o chaneys settings o thvs conection, sueh, s adapler, PIDIDET, o medem cond R ation s

o

Ce

|

Figure 13-11: Right-click the wireless adapter and choose Properties.
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Chapter 13: Making Ad Hoc Peer-to-Peer Wireless Connections

Drop

120

lesha&f an Ad Hoc Network
wireless adapter is active.

Right-click the Network Connection icon in the system
tray and choose Repair from the menu shown in Fig-
ure 13-13.

Check that you are not currently connected to an infra-
structure network. (If you are connected to an infrastruc-
ture network, disconnect from it.)

Make sure the SSID is correct and that each computer
has the same SSID set.

The SSID is usually case sensitive. If the SSID is incorrect, delete the
ad hoc connection and make a new connection using the correct
SSID.

Re-enter the WEP key (see Figure 13-14). Like SSIDs, the
WEP key may be case sensitive.
Temporarily disable WEP encryption.

Temporarily disable your firewall/Internet security
program.

These troubleshooting steps help you resolve connectivity prob-
lems. Stop following the steps when the problem is resolved.

For more information on how to disable WEP encryption, turn to
Chapter 6. | go over how to disable a firewall in Chapter 7.

Disable
Status
Repair

Open Network Connections

View Available Wireless Networks

Change Windows Firewall settings

=& znsem

Figure 13-13: Repair the connecfion.

KeithsADhoc12 properties

(2]

Association |Authent\cation‘ Connection |

Metwark name (5510
Wireless netwark kep

This network. requires a key for the fallowing:

[ The key is provided for me autamaticaly

Network Authentication: IEEH | ~|
Data encryption: IWEp .,.
Metwark ke ssssssas

Key index (advanced): 1 ':.

(s

Figure 13-14: Double-check the WEP key and SSID.




DrdbsiagiBluetooth SN
evices Chapter

M ost wireless networks use 802.11b/g technologies, more commonly
referred to as Wi-Fi (short for Wireless Fidelity). Bluetooth is another
wireless networking technology that is increasing in popularity. Bluetooth

signals usually have a maximum range of about 10 meters, making the
technology less useful than Wi-Fi for creating wireless computer networks.
However, Bluetooth is a great way to connect other kinds of devices, Get ready to...

including: w= Add Bluetooth to Your Windows PC .......... 122
w=  Cell phones

w=  Headsets

= Set Bluetooth Discovery Opfions .............. 124

w= Connect to a Bluetooth Device

w=  PDAs from Windows 125
= GPS receivers w= Add Bluetooth to Your Mac ...................... 126
= Printers

w= Connect a Bluetooth Device to Your Mac....127
w= Make Your Pocket PC Discoverable .......... 128

m= Keyboards and mice

These are just a few examples. New Bluetooth-compatible devices are becom- w= (reate a Pocket PC Partnership ............... 128
ing available. In this chapter, I show you how to connect to and use several ] .
common types of Bluetooth devices. w= Talk Wirelessly with a Bluetooth Headset.....129

ference and improve the performance of both Wi-Fi and Bluetooth gear, try to position Bluetooth and GPS Receiver 130
Wi-Fi antennas os far apart from each other as possible.

s Bluetooth radio waves can cause slight interference with 802.11h/g Wi-Fi signals. To reduce inter- »= Get Directions from a Bluetooth



Chapter 14: Using Bluetooth Devices

Iuet th to Vour Windows PC

already have built-in Bluetooth,
obtaln a Bluetooth adapter (see Figure 14-1).

The device should be compatible with your computer and easy to
install. The USB adapter shown in Figure 14-1 easily connects to the
USB port on any Windows PC.

Drop

2. Follow the device’s instructions to install the drive soft-

ware (see Figure 14-2).

Usually you must install the driver software before you install or
connect the Bluetooth adapter. | also strongly recommend that you
check the Web site of the Bluetooth adapter’s manufacturer 1o see
if there are any updates. If your Bluetooth adapter is an internal
expansion card, shut down the computer and install the card as
described in the manufacturer's instructions. If your Bluetooth
adapter connects to a USB port or cardbus slot, connect the adapter.

3. After Windows has finished updating and installing
drivers, restart your computer.

4. After the computer is restarted, double-click the
My Bluetooth Places icon on your Windows desktop,
or double-click the Bluetooth icon in the Windows
system tray.

The system tray is the area in the lower-right corner of the screen
next fo the clock. The Bluetooth icon is (surprise) blue, with a white
design on it that looks sort of like the letter B.
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Figure 14-1: This Bluetooth adapter plugs into a USB port.

D-Link

ULaINg Networks Tor ple AI}I -’
Wireless Network @ i
USB Bluetooth Adapter

Lifdle ¥ BJ throughthe installation
from using
At OFMIM Product

Thank You for Purchasing Your D-Link Product

Install Driver
»  View Quick Installation Guide

B View Manual
- Acrobat Reader

Yahoo! Premium Services
~ This service s available for US Customers Only

- Visit support.diink.com

Installer
Figure 14-2: Install the driver software before connecting the Bluetooth adapter.




Add Bluetooth to Vour Windows PC

&) General %]

Device Hame and Type: L—
Y'ou must select a narme far this computer and indicate what type of computer it is.

In the initial Bluetooth Configuration Wizard that

” ch o e re you want Bluetooth icons to
DropBooKS: =

You can have Bluetooth icons in the Windows Start menu, the
Programs menu, and My Computer. o

WIDCOMM Blustooth Software 1.4.2 Build 10

----- Enter a unigue name for this computer.  This name will be displayed to other
Blustooth devices if this computer is corfigured to allow itself to be discovered.

Select a computer type from the drop-down menu. This selection determines the
icon that represents this computer on remate devices.

6. Enter a name for the computer, as shown in Figure 14-3,
select the computer type, and click the Next button
twice.

Computer name: S0TOP4

Computer pe! | Personal Computer |8

The computer’s name should be descriptive so that you can easily
identify it from other Bluetooth-enabled devices.

[ < Back I[ Nesxt > ][ Cancel ]

Figure 14-3: Give your computer a descriptive name.

7. In the next Bluetooth Service Selection screen, select = L
' Bluetooth Service Selection %]

services that will be offered by this computer by e
. Choose the services that this computer will offer: L
BluetO Oth (See Flgure 1 4'4) o To enable a service, place a check in the box next to the service name. @
To display the properties panel for a service, click Configure. =
If you're not sure about the purpose of a particular service, dlick it L1424 P Teem Transfer (]
to view a description. In Figure 14-4, | am viewing a description of 2 P Synchverization
the File Transfer service. You can also customize notification settings Gk,
and other options for most services by clicking the Configure bution 1
next fo each respective service. '
%, Metwork Access
. . . 1'%} Dial-up Networking
8. Click the Next button and then click the Skip button to .
close the Bluetooth configuration wizard. i v
I < Back I[ MNext > ] [ Cahcel ]

Figure 14-4: Select the services you will offer.
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Chapter 14: Using Bluetooth Devices

General | Accessibilty | Discovery | Local Services | Client Applications | Hardware

Let ather Blustooth devices discover this computer,

. . Bluetooth Configurati (2%
D Seglueto th Discovery Options okt
rO p' C h ﬁ‘etOOth icon in the Windows SYS‘ Devices allowed to connect to this computer
tem tray and choose Advanced Configuration from Akw Al dovices =
the menu. Select the devices that may access this computer.

2. In the Bluetooth Configuration screen, click the
Accessibility tab (see Figure 14-5).

3. Select the Let Other Bluetooth Devices Discover this
Computer option.

If you enable discovery, other Bluetooth computers will be able to L el ee—r—

see your computer. However, you can control access using the Allow

men below. .
4. Click the Discovery tab (see Figure 14-6). Figure 14-5: Enable Bluetooth discovery.

Select the Look for Other Bluetooth Devices option and
choose how often you want to perform a check.

Bluetooth Configuration [2]%]

.Genela\ Accessibiliy | DiSCUVEL‘:"! Lacal Sevices | Client Applications i Hardware
6. Click the Apply button and then click OK to close the S RIS . s of covices Wil
. a @l cess that this computer should discover and reporl
Bluetooth Configuration dialog box.

Look for other Blustooth devices Every 10| mirutes

If you are going to be using your computer in public, you should
turn off Bluetooth discovery (both incoming and outgoing) fo
prevent strangers from accessing your computer. Bluetooth sniffer Rleeatlet
programs — programs that scan for and identify active Bluetooth
signals — are becoming increasingly popular. In fad, if you don't
need your Bluetooth radio you should disable it or (if possible)
remove any USB or cardbus Bluetooth adapters.

| Report all Bluetooth devices []

Figure 14-6: Let your computer discover other Bluetooth devices.
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Connect to a Bluetooth Device from Windows

Con

t to Bluetooth
dow's

Double-click the My Bluetooth Places desktop icon
or double-click the Bluetooth icon in the Windows
system tray.

Click Search for Devices in Range under Bluetooth Tasks
on the left side of the My Bluetooth Places window.

In the resulting list of Bluetooth devices that are
currently active and in range, double-click a device
to reveal a list of services available for that device
(see Figure 14-7).

Double-click a service to start using it. (To create a direct
connection for most devices, double-click the Serial Port
service.)

Windows make take a few seconds to configure port drivers for
the device.

In the resulting Bluetooth PIN Code request dialog box
(see Figure 14-8), enter a four-digit PIN code and then
click OK.

Enter the same four-digit PIN on the other computer or
device, if necessary.

In some cases, a device’s manufacturer tells you to use a specific
PIN code such as 0000. Otherwise, make up your own PIN code.
After you click OK in Windows, you may need to enter the same PIN
code on the other device fo create the partnership.

& My BI h Places\Entire Bl h Neighborhood =)=
File Edit View Bluetooth Favorites Tools Help i
eBack T s |7’ /.-'Sean:h || Folders 7

BEE

Address @ fly Bluetooth Places\Entire Bluetooth Neighborhood

Keith Underdahl

=}

¥ Bluetooth Tasks

Blugtooth Setup Wizard
% ‘igw My Bluetooth services

&7 Search For devices in range

G’ view or modify configuration

Other Places

Details

Bluetooth Devices

ersonal Digital Assistant

Entire Bluetooth Neighborhood

Figure 14-7: Bluetooth devices within range.

Bluetooth PIN Code Request [2]%]

Q}Eﬁ Device Name: Keith Underdahl

Betare & connectian can be established, this computer and the device
above must be "paired.”"

The Bluetoath paiing procedure creates a secret key that is uzed in all
future cannections between these twao devices to establish identity and
enciypt the data that these devices exchange.

To create the paired relationship, enter the PIN code and click OK.

Bluetocth PIN Code: sene

[ OK ] [ Cancel ] [ Help ]

Figure 14-8: Enter a PIN code for the devices to share.

125



Chapter 14: Using Bluetooth Devices

th to Vour Mac

AdéBIuet 0
D ro p }Q Qk@a USB Bluetooth adapter, start up your

126

computer and then connect the adapter to an open USB
port (see Figure 14-9).

A Bluetooth icon appears on the menu bar in the lower-right cor-
ner next fo the clock.

Click the Bluetooth icon in the menu bar and choose

Open Bluetooth Preferences from the menu that appears.

On the Settings tab of the Bluetooth window, shown in
Figure 14-10, select the Discoverable check box to allow
other devices to discover your Mac.

If you're using your iBook or PowerBook in a public location, it's a
good idea to turn off Bluetooth to prevent strangers from accessing
your computer. Click Turn Bluetooth Off to temporarily disable
Bluetooth.

Choose whether you want to require authentication for
connecting Bluetooth devices. Doing so enables you to
use Bluetooth while keeping your computer more secure.

Choose whether you want the Bluetooth Setup Assistant
to appear when no input device — such as a keyboard
or mouse — is detected. This setting makes it easier to
use Bluetooth input devices.

Close the Bluetooth window.

Many newer Macs come with built-in Bluetooth adapters. Check your
computer's documentation if you're not sure. Mac 05 10.2 or bet-
ter is required for Bluetooth compatibility. With 05 10.2 or better,
Bluetooth software is built-in to the operating system so no special
installation is required.

Figure 14-9: Many Mac keyboards have a spare USB port.

8686 Bluetooth

'—h!ﬁhgs4 File Exchange ] Devices l‘

: )
Bluetooth Power: On f Turn Bluetooth Off
Bluetooth Device Name: iMac
The device name is the same as the Computer Name in Sharing preferences.

EDiscaverable

This will allow other Bluetooth devices to find your computer. If this is disabled,
other devices will still be able to connect to your computer.

|| Require Authentication

] Use Encryption
This will require Bluetooth devices to authenticate before making connections to
your computer. This will alsa secure all data sent over Bluetooth.

|| Support Non-Conforming Phones
This provides better connections with older Bluetooth phones.
_ | Allow Bluetooth devices to wake this computer
EOpen Bluetooth Setup Assistant at startup when no input device is present.
Eshuw Bluetooth status in the menu bar

Figure 14-10: Setting up Bluetooth on your Mac is easy.




Connect a Bluetooth Device to Vour Mac

Connect a Bluetooth Device

(ap S

Click the Bluetooth icon in the menu bar and choose

Open Bluetooth Preferences from the menu that appears.

Click the Devices tab.
Click Pair New Device.

In the Pair with a Bluetooth Device dialog box, click the
device with which you want to pair (see Figure 14-11).

If you don't see the desired device listed, make sure it's turned on
and in Pairing mode, and then click Search Again in the Pair with a
Bluetooth Device dialog box. The device’s documentation should
include instructions for enabling pairing mode on the device.

Click the Pair button.

6. In the dialog box shown in Figure 14-12, enter a
passkey and then click OK. The paired device is now
listed on the Devices tab of your Bluetooth Preferences
dialog box.

In some cases, a device's manufacturer fells you to use a specific
PIN code such as 0000. Otherwise, make up your own PIN code.
You may also need fo enter the same PIN code on the other device
to create the partnership.

Pair with a Bluetooth Device
Select a Bluetooth Device and click the Pair button.
Ta find devices in range of your computer to pair with, click the Search

button. If your device is not found make sure it is “discoverable® and
search again.

Show only: _.AH Devices v

Device Category: | All Categories

Device
Keith Underdahl

TeleType BT 01
M2500 by Plantronics |

( Search Again { Cancel ) . Pair )

Figure 14-11: Pair your Mac to a Bluetooth device.

To unpair a device, open the Bluetooth Preferences dialog box, open the
Devices tab, select the device, and click Delete Pairing.

Please enter a Passkey to use with this device

Passkeys are required to pair with a Bluetooth device. The same
passkey must be entered on the device as well as this computer.
Most devices allow you to create your own Passkey, but some
devices require a fixed ane.

M2500 by Plantronics

sensl

[ Cancel f 0K 3

Figure 14-12: Enter a passkey.
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Chapter 14: Using Bluetooth Devices

l’ocket PC Discoverable
D ro p 5 icon on the Today screen to open the

Bluetooth settlngs

Alternatively, choose StarteoSetfings, tap the Connections tab, and
then tap Bluetooth.

2. Select the Turn on Bluetooth and Make this Device
Discoverable to Other Devices option, as shown in
Figure 14-13.

3. Tap OK to close the Settings screen.

Create a Pocket PC Partnership

1. Tap the Bluetooth icon on the Today screen to open the
Bluetooth settings and then tap the Devices tab.

Make sure the other device is on and in pairing mode.

Tap New Partnership.

Tap the name of the device to which you want to con-
nect and then tap Next.

4. Enter a passkey (see Figure 14-14), and then tap Next.

Select services you want to use with the device and
tap Save.
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Bluetooth

Turn on Blustooth

Make this device discoverable to other
devices

r~1cde Devices | COM PDFIS|

Figure 14-13: Enable the Bluetooth
radio and discovery.

Enter Passkey e

Enter a passkey to establish a secure
connection with M2500 by Plantronics.

e
123|1|2|3|4|5|5|?|3|9|u| [=][@
Tabla[wle[r[t[y[uli[o[p[[]]
caPla[s[d[fla[n]j[k[1[:]" |

Shlft|z| | [¥*[b[n[m],
\|

“—

[.1/
|¢|1

Figure 14-14: Enter a passkey.



Talk Wirelessly with a Bluetooth Headset

Ik lrele with
Business Card Exchange
dset Bluetooth Serial Port 4
Dial-up Networking ¢
Create a partnership between your computer and the L — i
headset, as I describe earlier in this chapter. PIM Synchronization  » | EXP1ore My Bluctoath Places
. . ) 4 ) Notw: K Accoss b Bluetooth Setup lea.rd
Right-click the Bluetooth icon in the Windows system Headset . fdvanced Cenfiguration
tray and choose Quick Connect=>Headset and then Ao Gateway ! duick Conlices ;
choose the name of your headset (see Figure 14-15). SR oF the BlistmolnDevics
0RD 1050am
Launch the program with which you want to use the Figure 14-15: Quick-connect to your Bluetooth headset.
Bluetooth headset and then open the Options dialog
box for that program (see Figure 14-16). Y Ty T
In the example shown here, | am setting up my Bluetooth headset B Generd : -
for use with Skype. Choose Tools=>Options to open the Skype - putioTn [Bhetooth fuo [¥]
Options dialog box. B e Ot ehetoath Aud m
P notifcations Ringing incdows defalt device [v]

Select Bluetooth Audio for your input and output audio

(A Sound Alerts [“IRing PC spesker
hardware. IS

=~ Enable automating sound device settings adjustment
[&'1 sound Devices

Enable ringing on your PC speakers, if an option is

aVailable. @ Hotkeys

Place a test call to make sure that everything is working. 7 Connection

To disconnect the headset, right-click the Bluetooth Bk acharced el el

System tray iCOn again, ChOOSe Quick Connectt:> (@ — @ Learn mors how bo set up vour sudio settings.
Headset>the name of your headset, and then click

Yes when you are asked to confirm that you want to

break the connection. Figure 14-16: Choose Bluetooth Audio as your audio device.

In Skype, click the Make a Test Call to Skype Answering Machine
link at the bottom of the Skype Options dialog box. See Chapter 24
for more on voice chatting with Skype.
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Dro

130

lrectlzg from a Bluetooth

Tap the Bluetooth icon on the Today screen to open the
Bluetooth settings and then tap the Devices tab.

Tap New Partnership and create a partnership with the
GPS receiver, as I describe earlier in this chapter.

s The passkey for a GPS receiver is usually 0000.

In the Bluetooth settings, tap the COM Ports tab to bring
it to the front, and then tap New Outgoing Port.

Select the GPS receiver and tap Next.

In the Port drop-down menu (see Figure 14-17), choose
a COM port for the GPS receiver. Do not check the
Secure Connection option. Tap Finish and OK to close
Bluetooth settings.

The exact COM port you use varies depending on both the GPS
receiver and the Pocket PC you are using. Check the GPS manufac-
turer's documentation for COM port recommendations. In my
example shown here, COM8 is the port to use to connect my Teletype

Bluetooth GPS receiver to my Dell Axim X51. You may have to
experiment with several COM poris before you find one that works.

Install your GPS mapping software, and then open the
GPS settings in the mapping program.

Make sure that the mapping program has the correct
COM port set for the GPS receiver (see Figure 14-18).

[[] s=cure Connection

Back ] Finish
Figure 14-17: Select a COM port for
the GPS receiver.

[t
Pause | Startlog [ClssPort] Tme |
coms: ~[4800 bps ][ Find GPS Port

sGEVIG, 317 .23,T,,,0.00,8,0.00,E, 57| o
-

|- Position

4

Position ficed.
Satellt

TETRCLITI

7 8 1117 19 26 27 25 NA NA NA

mews| 7 Q4 2 @

Figure 14-18: Choose the correct
COM port.




Get Directions from a Bluetooth GPS Receiver

8. Position the GPS receiver so that it is still and has a
DropBgok

GQecelvers Usually cannot get an initial fix on your posifion

inside a building or under the metal roof of your car. However, after

the position is fixed, you may have more flexibility on where you
position the receiver.

9. Open your mapping program (see Figure 14-19), load
some maps, and start navigating!

i 2T

hye
"K&\Me

m & }
i
. . | g2
These instructions assume you are using a Bluetooth GPS receiver \ gt
with a Pocket PC. Most GPS receivers such as the Teletype receiver - __W Lo /L
hown here can aso be used with Windows PCs such as | 3 o
shown here can also be used with Windows PCs such as laptops ,m,u| mAaAf @
Figure 14-19: The GPS receiver shows
your current posifion.
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DropBooks
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ing Wirelessly
with Your Pocket PC

Iprobably don’t have to tell you how rapidly computers have advanced
in the last couple of decades, while at the same time getting smaller and
easier to use. Nowhere is this more evident than in the latest Pocket PCs,
which pack more computing power than Apollo astronauts took to the moon.
Believe it or not, even the computer running the modern International Space
Station is far less powerful than the typical Pocket PC. With a Pocket PC,
you can check e-mail, browse the Web, store contacts, run PowerPoint pre-

sentations, navigate with GPS mapping programs, and more.

Many new Pocket PCs also contain Wi-Fi or Bluetooth wireless networking
technologies. This chapter shows you how to use your Pocket PC untethered
from cradles and synchronization cables. I go over how to:

w= Make Bluetooth connections between your Pocket PC and other com-
puters (including other Pocket PCs).

m= Beam files or use ActiveSync with Bluetooth.

m= Set up and use wireless network connections between your Pocket PC
and Wi-Fi networks.

w= Ensure that wireless networking doesn’t put too much of a strain on
your Pocket PC's battery.

S The steps in this chapter assume you have a Pocket PC running the Windows Mobile 5

operating system or newer.

-
Chapter

Getready to. ..

= Make a Bluetooth Connection .................. 134
w= Beam Files with Bluetooth........................ 135
w= Use ActiveSync with Bluetooth.................. 136
= Make a Wi-Fi Connection.............ccoeee..... 136
w=> Share Files with a Network Computer ......138
w= Browse the Web ot a Hotspot ................. 139
> Adjust Power Options ............ceeeeeereneen. 140
= Keep Your Pocket PC Secure .................... 140



Chapter 15: Networking Wirelessly with Your Pocket PC

Dropﬁ

134

a Bl etooth Connection

and then tap the Connections tab.

Tap the Bluetooth icon to open the Bluetooth connec-
tion panel.

Turn on Bluetooth and enable discovery, as shown in
Figure 15-1.

Tap the Devices tab and then tap New Partnership.

In the list of devices that appears (see Figure 15-2), tap
the name of the device to which you want to connect,
and then tap Next.

If the desired computer or device isn't listed, make sure it is dis-
coverable or in pairing mode and then tap Refresh.

Enter a passkey and then tap Next.
Computers usually require a unique passkey, but devices like

headsets and GPS receivers usually use the passkey 0000.

Select services you want to use with the device and
tap Save.

Bluetooth

[] Turn on Blustooth

[w] Make this device discoverable to other
devices

ModeDeUiDm|COMPDrIS|
(=]

Figure 15-1: Enable Bluetooth and
Bluetooth discovery.

7 2 | settings P> wx 11:45
Select a Bluetooth Device e
Select a device to connect with and tap
Mext.

(@) TeleType BT 01
Zsovop4
Refresh

Figure 15-2: Choose the device to which
you want fo connect.



Beam Files with Bluetooth

BemBFiIes ith Bluetooth

D ro pL tgl §rou want to beam.

You can select contacts in your contacts list, appointments in your
calendar, images in the picture viewer, files in File Explorer, and
many other ifems.

2. Choose Menu=>Beam (see Figure 15-3). The Pocket PC
searches for a device to which the item can be beamed.

©)

3. In the resulting list, tap the device to which you want to
beam the item (see Figure 15-4). The file is beamed to
the device.

®
®

In Figure 15-3, the menu option says Beam Picture because | am
preparing to beam a picture. The Beam selection is contextual and
changes depending on the type of item you are beaming.

Beaming is most useful for quickly sending items between
Pocket PGs.

To beam files from a desktop PC o a Pocket PC, use the Bluetooth
Exchange folder in your Windows My Documents folder.

Zoom
Play Slide Show
Set as Today Background...

Save

| Edit

Properties
Options...

Figure 15-3: Choose Beam from the
program's menu.

[) DscFo437.3PG

To beam, select a device.

2 Infrared
il SOYOP4 Tap to send

Align ports

N e

Figure 15-4: Select the device fo which
you want to beam the item.
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Msg‘lctil/ ne with Bluetooth

D ro p SQ Q C '§ync software on a desktop or laptop
computer that is equipped with a Bluetooth receiver.
On your Pocket PC, tap Start=>Programs.

Tap the ActiveSync icon to open the ActiveSync
program.

4. Choose Menu=>Connect via Bluetooth, as shown in
Figure 15-5.

Make a Wi-Fi Connection

1. Tap Start=>Settings and then tap the Connections tab.
Tap the icon for the WLAN utility and then tap Setting.

Tap the Network Adapters tab and then tap the name of
your Pocket PC’s wireless adapter.

4. On the IP Address tab, select Use Server-Assigned IP
Address, as shown in Figure 15-6.

The network’s DHCP server will assign an IP address fo your
Pocket PC when you connect fo the wireless network.

Tap OK to close the wireless adapter settings window.

6. Tap the Wireless tab to bring it to the front.
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Windows PC
Synchronzed: 111705 12:13 PM

Options...

Status...

Add Server Source...

Connections...
Connect via IR
Connect via Bluetooth

Sync m Menu

Figure 15-5: Configure ActiveSync to
connect via Bluetooth.

7 2 | settings F> x 12:50 ok
Dell Axim X51 WLAN Wireless Adapter

{® |Use server-assigned IP address|
() Use specific IP address

192.168.0.103

[PAddrms|NaneServers
123[1[2[3[4[s[e[7[8][0]0]-[=]+«
Tabla[wle[r[t]y[ulilo[p[[[]
caP[a[s[alfla[n[j[k[I];]"
shitt[z [ [c[¥[b[n[m][,[. [/]

ctfail - [\ ] [L]1]<]=

Figure 15-6: Let the server assign an
IP address to your Pocket PC.



Make a Wi-Fi Connection

7.

DropB

10.

11.
12.

13.

Tap the name of the Wireless network to which you

Iﬁektwo%n’t listed, tap Add New. In the Windows Mobile 5

operating system, the configuration window that opens does not
have a Cancel button or link. Therefore, if you tap Add New but
then do not have a network SSID or other information fo add, you
must soft-reset the Pocket PC to get rid of the window. Most Pocket
PCs have a soft reset button on the back; check the manufacturer’s
documentation for soft reset instructions.

On the General tab, enter the network’s SSID in the
Network Name field, if it isn't already filled in.

Tap the Network Key tab and choose WEP in the Data
Encryption menu if the network uses WEP encryption.
If the network doesn’t use any encryption, skip ahead to
Step 11.

If the network uses WEP encryption, enter the network
key (see Figure 15-7).

Tap OK to save your settings.

Close all open windows. If you have a successful connec-
tion you will see a green stair-step wireless connection
icon in the lower-right corner of the Today screen.

Tap the Wireless Connection icon 1o quickly open Wi-Fi setfings.

If you're not sure which wireless network your Pocket
PC is connected to, tap the Connectivity icon on the
menu bar, as shown in Figure 15-8.

ﬁ_‘a #{x 12:55 [ok

Configure Network Authentication e

|:| The key is automatically provided

oo
o

General | Network Key | 802.1x
iz3(1[2[3[a[s5]e][7][8]0[0]-[=]«
Tabla[wle[r[t[y[uli[o[p[[[]
caPla[s[affla[h]j[k[I[;]"
shift| 2 [x [c[v[b[n[m], i
ctfaii] ~ [\ ] |

Authentication:

Data Encryption:

|
[«
|

[. ]
NG

Figure 15-7: Enter network encryption
seftings.

HE Start i o 1:22
[geap———________ |

| Connectivity
urn on flight mode( |
i SEren1TY46 (Wi-Fi) Al

Settings

Figure 15-8: Tap the Connectivity icon.
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Share Files with a Network
DropBesks
1

Use File Explorer to locate a file you want to copy.

To open File Explorer, tap Start=>Programs and then tap the File
Explorer icon.

2. Select the file you want to copy and choose Menur>
Edit=>Copy.

Tap Menu=>Open Path=>New Path.

Type the name of a network computer to which you
want to connect, as shown in Figure 15-9.

The name of the computer should be preceded by two back
slashes, as shown in Figure 15-9.

Tap OK.

6. Enter a valid user name and password for a user account
on the computer to which you are trying to connect,
and tap OK again.

If you just want to connect to shared public folders on the computer,
leave the user name and password fields blank. After tapping OK
you may be asked whether you want to save the password.

7. In the list of available folders and items, tap a folder or
other item to open it (see Figure 15-10).

8. Choose Menu>Edit>Paste to copy the file from your
Pocket PC to the network computer.
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D9 Open path:

gi [\isovops -
- o] [cancl
] =4

€] waterfall 7/1/05 29.4K
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Figure 15-10: Tap a folder name to
open it.



Browse the Web at a Hotspot

Browse the (Web at a Hotspot

D ro p l'Q\Q tion icon in the lower-right corner

of the Today screen.

.}
Configure Wireless Networks e

Add New...

Plyankes Availzble
@ SEren1TY46 Unavalable
If the Wi-Fi adapter is not enabled, tap Turn On.

2. Tap Setting and wait for the hotspot’s signal to appear in
the list of networks (see Figure 15-11).

Networks to access:
(20 Avaiable -

3. Tap the connection and enter a network key if one is Virekess | Network Adapters
required.

4. Tap OK until all of the settings dialog boxes are closed.

When the Wi-Fi Connection icon turns green, tap Start=>
Internet Explorer.

2t 1p waw dumrmes com,"W'v ﬁ

6. If you are required to log into the hotspot, type the log
in URL in the Address bar and tap Enter. Follow the
hotspot’s instructions to log in.

7. Once logged in, browse the Web normally, as shown in

Figure 15-12. Find Dummies Books & Articles
Some hotspots require you to pay for access, so the log-in URL may
have instructions and payment options. Public hotspots often .
require no log-in, although some do require that you create a free [ EverydayComputing | [
account and log-in because free access is limited.

Remember, when you use a public hotspot anyone else using the :

hotspot could access your computer. If you use hotspots frequently Figure ]5 12: Browsing 'he W‘*b from
and your computer contains sensitive data, consider installing a 0 hotspot is easy!

security program specifically designed for Pocket PCs.
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D r06déigag

St l’mker Options

§S, and then tap the Connections tab.
Tap the icon for the WLAN utility.
Choose a WLAN power save mode:

¢ Enable: Wi-Fi radio power is reduced to preserve bat-
tery power.

e Disable: Wi-Fi radio power is used at the greatest
possible power for best range.

e Auto: Wi-Fi radio power changes dynamically based
on your usage.

To prevent lost data, select the Disable WLAN to con-
serve power when battery is low option, as shown in
Figure 15-13.

Keep Your Pocket PC Secure

1.

3.

140

Tap Start>Settings and then tap the Password icon.
Create a password that must be entered after a period of
inactivity, as shown in Figure 15-14.

A password prevents someone else from using the Pocket PC to
access your network, in the unfortunate event that the Pocket PCis
lost or stolen.

Install a security program specifically designed for your
version of the Windows Mobile operating system.

Disable Bluetooth and Wi-Fi when not in use.

WLAN Utility
Fower
WLAN ON g‘ G Power save mode:
18 (") Enable
Disable
Turn Off Q
@ Auto
Seifon Disable WLAN to
3 conserve power
Setting when battery is
low.

Main | Site. Config | Teols | Advanced | 41|

Figure 15-13: Adjust Wi-Fi settings to
sireich the life of your battery.

7 ;| settings Gs dx 353 Bk
Password

Prompt if device unused
for

Password type: [Strong alphanumeric -
o
G

Pasmmrd|}{mt|
123[1]2[3[4[s[e[7[8][9]0]-[=]+«
Tabla[wle[r[t]y[ulilo[p[[[]
caP[a[s[alfla[n[j[k[I];]"
shitt[z [ [c[¥[b[n[m][,[. [/]
ctfail - [\ ] [L]1]<]=

Figure 15-14: Secure your Pocket PC
with a password.



Part V
DropBooks  Practical Applications

The 5th Wave By Rich Tennant

ORICATENNANT

“That’s it ! We’re getting a wireless network
for the house.”
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DrdfiBigats Creating
a Network Bridge

For thousands of years, people have built bridges to connect separated
land areas. When you create a home network, you can build a bridge
between two different kinds of networks, namely wired and wireless
networks.

Suppose you already have an established Ethernet wired network, and you
have just purchased a single Wi-Fi-equipped laptop that you want to use
with your network. You could buy a new router/wireless access point (WAP),
but that's expensive and complicated to set up. Alternatively, you could just
add a wireless adapter to one of your existing Ethernet wired computers, and
then use this computer as a virtual bridge between your Wi-Fi laptop and
your Ethernet network.

In this chapter, you find out how to:
w= Turn a computer into a network bridge.
w= Add a wireless adapter to a computer.

m= Set up the adapters to create the bridge.

s For more details on basic wireless network settings, see Chapters 1. Chapter 2 covers

wireless adapter settings, and Chapter 6 shows how to set up wireless network security.

N R
Chapter
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w= Configure the Wireless Adapter ................ 145
w= Bridge the Connections ..............ccccccceens 146
we Adjust Bridge Settings .........oooooeeesesssscrees 147
w= Tear Down a Network Bridge.................... 148
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Il a

ireless Adapter

1
Dl’Oﬁngﬁ) g Computer

1.
2.
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Shut down your computer and unplug its power cable.

Determine whether your computer can support an inter-
nal Wi-Fi card. You should have at least one open PCI
slot. The computer shown in Figure 16-1 has four open
PCI slots.

The slofs in Figure 16-1 are PCl slofs. If you are not familiar with
computer hardware or if your computer is still under warranty, have
a computer professional check your computer and perform the
installation. Computer hardware is fragile and easily damaged.

If you have an open PCI slot and are willing to install
an internal card, purchase and install an internal Wi-Fi
card. Don't remove your Ethernet card; when you're
done your computer should have both Ethernet and
wireless network adapters, as shown in Figure 16-2.

If your computer does not have an empty PCI slot, or if
you don’t want to open the case and install an internal

card, purchase an external Wi-Fi adapter that plugs into
a USB port.

©)
©)

Some external Wi-Fi adapters plug into a computer's Ethernet port.
Don't get one of these unless your computer already has two Ethernet
ports. Remember, you need at least one Ethernet port fo connect to
the rest of the Ethernet network and create your network bridge.

Alaptop can also be used as a network bridge. Connect the laptop’s
Ethernet port to the Ethernet network; then install a cardbus Wi-Fi
adapter or use the laptop’s built-in Wi-Fi if it is so equipped.

i‘igure 16-2: The bridging computer should have both Ethernet and Wi-Fi adapter

ai

S.



Configure the Wireless Adapter

Configure the
DropBook

Wireless Adapter

ter’s driver software.

See Chapter 3 for defails on how to install the Wi-Fi adapter’s
driver software.

Choose Start>My Network Places.

On the left side of the My Network Places window, click
View Network Connections.

Right-click the Wireless Network Connection and
choose Properties from the menu that appears, as
shown in Figure 16-3.

In the Wireless Network Connection Properties dialog
box, click the Wireless Networks tab to bring it to the
front.

If you don't see the Wireless Networks tab, you may need to close
the Properties dialog box and activate the wireless network con-
nection. To activate the connection, right-click the connection in the
Network Connections window and choose Enable.

Click Advanced.

Select Computer-to-computer (ad hoc) networks only,
as shown in Figure 16-4 and click Close.

Set up an ad hoc network connection between the
bridge computer and your other wireless computer, as
described in Chapter 13.

Enable

Create Shortcut

Rename

Properties

aj

& Network Connections 9[=%]
File Edit View Favorites Tools Advanced Help »
e Back -~ ¥ /7 ) Search |- Folders | [TTf]+
Address | @ Network Connections v’ Go

Name Type Status
@‘“‘"‘ & 9 Internet Gateway
Other Places ¥ %JInternet Connection Internet Gateway Disabled
Details A LAN or High-Speed Internet
wireless Network L Local Area Connection 6 LAN or High-Speed Int... Connected
Connection 2 <L.1394 Connection LAN or High-Speed Int... Connected
Disabled (T\Mireless N-=-=-t ©-~-i-ma LAN or High-Speed Int... Disabled

¢ view or change settings for this connection, such as adapter, protocal, or modem configuration settings.

Advanced [2]%]

Networks to access
() iy available network (access point prefermed)
() Access point [infrastucture] networks only

(%) Computer-to-computer [ad hoo] netwarks anly

[ Automatically connect to non-prefered netwarks

Cloze

Figure 16-4: Choose ad hoc networks only.

Figure 16-3: Open the Properties dialog box for the wireless connection.
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3.

4.
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e the, Connections
00k

On the left side of the My Network Places window, click
View Network Connections.

Hold down the CTRL key on your keyboard and click
once on your Ethernet network connection and then
click once on your wireless connection so that both are
selected, as shown in Figure 16-5.

Network Places.

You can bridge any two or more network connections that are not
being used for Internet connection sharing. For example, if one net-
work connection connedis directly to a broadband modem, you can-
not bridge it to other network connections. In that case, you can
simply use Internet Connection Sharing (described in Chapter 2)
to share the broadband Internet connection with the rest of your
network.

Right-click the computer’s Ethernet network connec-
tion and choose Bridge Connections, as shown in
Figure 16-6.

The bridging process takes a few seconds. When the process is com-
plete, a new Network Bridge category appears in your list of network
connections. The Network Bridge category contains the network
bridge as well as the two bridged connections.

2 items selected.

JL.1394 Connection
L Local Area Connection 6

=l

\},Nelwurk Connections =[E]x]
File Edit View Favorites Tools Advanced Help »
e Back - ‘ﬁ /-- !Search || Folders EEA
Address | @ Network Connections V . Go

Name Type Stati
9 Internet Gateway
Other Places ¥ “Jinternet Connection Internet Gateway Disal
Details rs LAN or High-Speed Internet

LAN or High-Speed Int... Conn|
LAN or High-Speed Int... Conn|
LAN or High-Speed Int... Not ¢|

2 objects selected

Figure 16-5: Select both of the network connections that you want to bridge.

2 items selected.

L. 1394 Connection
L Local fre= Coannacian @
7 Wirele:

Repair

Bridge Connections

1%

& Network Connections =/@Ed
File Edit View Favorites Tools Advanced Help ,',’
@sBack - ) (T | [Dsearch [ Folders [Tfv

o, Network Connections V . Go
Name Type Stat
9 Internet Gateway
Other Places ¥ &JInternet Connection Internet Gateway Disal
Details s LAN or High-Speed Internet

LAN or High-Speed Int... Conn
LAN or High-Speed Int... Conn|
LAN or High-Speed Int... Not c|

+f Connect multiple netwark cannections to form & network bridge.

Figure 16-6: Bridge connections.



Adjust Bridge Settings

tE@Bn Settings
D ro Q‘kSetwork Places.

2.

On the left side of the My Network Places window, click
View Network Connections.

Right-click the Network Bridge listing and choose
Properties, as shown in Figure 16-7.

In the Properties dialog box, add or remove a network
adapter from the bridge (select or deselect) in the
Adapters list, as shown in Figure 16-8.

If a network adapter is installed on your computer but does not
appear in the Adapters list, that adapter is not eligible for bridging.

In the lower portion of the General tab of the Network
Bridge Properties dialog box, select which services you
want to use with the bridge.

For example, if you do not want fo allow file sharing over the
bridge, uncheck File and Printer Sharing for Microsoft Networks.

Click OK to save your changes and close the Network
Bridge Properties dialog box.

& Network Connections
Fils  Edit View Faverites Took Advanced Help

¥ Swearch

=
J Falders  [T31] =

& Notwork Connections v B 6o
_ Mame Type Status
S LAN or High-Speed Intemet
L1394 Connectlon LAN or High-Spead Int... Connected
B +  Hotwaik Hidge
L lLocal Area Conneclion & Network Hiidge Connected, Hridged
Network Bridge (Network
Bridge) 7 " Wireless Network Connaction 2 Network Bridge Connected, Bridged
[ - Natwork Bridge (Nerwork Bridge) 2 Motwork Bridas Connactad
Corrmted Disable
MAT Briige Megeet Status
1 Address: 192, 160.0.106 Repalr
Subrek Mask: 255 255, 255.0
BNy Create Shortcut
Dalate
Ronama
Propedies
== e o 21
._“\‘r—wmwhﬂﬁm.m&m.mﬂ“iam«mwmm IE

Figure 16-7: The bridge is listed with other network connections.

_L Network Bridge (Network Bridge) 2 Properties  (2/3

| General | Authentication | #dvanced
|
Adapters:

Select the adapters you want to use to connect to computers
on your local netwark.

¥ [B] ol Area Connection &

I} |:|W|reless Metwaork Connection 2

(71 211394 Connection

This connection uzes the following items:
B Client for Micrasoft Networks ~
[w] S File and Frinter Sharing for Miciosoft Metworks
W = 005 Packet Scheduer

e R ISR bt
3] im >
[ Ipstall... ] [ Uninstall ] I Properties ]
] Show icon in natification area when connected

Figure 16-8: Network bridges have many of the

same settings as other network connections.
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5 Network Places.

On the left side of the My Network Places window, click
View Network Connections.

Do one of the following:

¢ To remove a single network adapter from a bridge,
open the Properties dialog box for the network
bridge and uncheck the desired connection as
described in the previous section.

e To temporarily disable a bridge, right-click the bridge
and choose Disable as shown in Figure 16-9.

e To permanently remove the bridge from your list of
network connections, right-click the Network Bridge
and choose Delete.

Figure 16-9: Disable or delete the bridge.

& Netwark Connections
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& Network Connections
- Hame Type
| etmork Task Z LA or High-Speed Intemnet
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Connected
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Drdfiigats Networking

a Game Console

Wreless networking isn't just for computers. Another increasingly pop-
ular use for wireless networks is gaming with video game consoles,

such as the Xbox or PlayStation. Modern game consoles can network with
each other for linked-system play, and with a service like Xbox Live they can
even connect to the Internet where you can play against people from all over
the world.

Most modern game consoles have a built-in Ethernet port for networking.
But if you don’t want to run Ethernet cables all over your house, you can
buy a Wi-Fi bridge that connects to your console and allows the console to
use your wireless network.

In this chapter, you discover how to add wireless networking capabilities to
an Xbox and then use it to play with other Xbox consoles in your home or
online using Xbox Live.

s To add a game console fo your wireless network, you need to know the SSID, encryption

seftings, and security keys for your network. See Chapter 1 for information on logging
in to your wireless access point and collection network information, and see Chapter 6
for more on wireless network security.

| I-A

Chapter
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= Adjust Wireless Network Settings............... 152
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between Consoles 153
e Connect 10 Xbox Live .......eveeeeveerrreene 154
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Add.a Wirgless Adapter
DropBocks:
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150

Select a wireless adapter specifically designed for your
game console.

In theory, any Wi-Fi bridge that connects o an Ethernet port should
work with your game console. In practice, however, if the adapter
doesn't come with a setup disc to help you install and configure
wireless network settings on the console, you may find it difficult or
impossible to use.

Collect the SSID, encryption format, and encryption
keys for your network and keep them handy.

You need this information when you configure your wireless game
adapter. See Chapters 1 and 2 for more information on how to obtain
this information around your network.

Turn on the power on your game console and remove
any game discs.

Connect the power cable to the wireless adapter; then
connect an Ethernet cable between the adapter and the
game console’s Ethernet port.

Insert the wireless adapter’s setup disc in the game con-
sole and close the tray.

If your wireless network is detected (see Figure 17-1),
choose it and press A. Otherwise, choose Other and
press A.

Enter your network’s SSID as the network name
(see Figure 17-2).

The SSID is case sensitive, so make sure you enter it correctly here.

Figure 17-1: Choose your network if it appears in the list.

Figure 17-2: Enter your network's SSID.



Add a Wireless Adapter to Vour Console

8. On the Wireless Settings screen, shown in Figure 17-3,

DropBotks, . .,
rop gype used by your network (see

Figure 17-4) and then press A.

s Most game console adapters are not compatible with WPA encryption.

10. Enter the encryption key and then choose Done.

11.  On the Wireless Settings screen, choose Save and
press A.

12. Check the status of your connection on the Wireless
Status screen.

The Wireless Status screen shows your connection speed and signal
strength. If the signal strength is poor, iry repositioning the wireless
adapter so that it is high and not blocked by large furniture or other

obstructions.

If you are unable to create a successful connection, double-check
that the SSID, encryption format, and encryption keys are entered
correctly. In your router, temporarily disable WPA or WPA-PSK
encryption if it is enabled.

Figure 17-3: Adjust network security setfings.

Figure 17-4: Choose your network's security type.
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empty.

Choose Settings, as shown in Figure 17-5, and press A.

If you have Xbox Live installed, choose Main Menu on the Xbox
Live menu to reveal the menu shown in Figure 17-5.

In the Settings menu, choose Network Settings and
press A.

In Network Settings, choose Advanced and press A.

Choose Wireless and press A to reveal the Wireless
Status screen shown in Figure 17-6.

Choose Settings to open the Wireless Settings screen.
There you can change the SSID, security type, and
encryption key used by your network.

When you are done, choose Save on the Wireless
Settings screen and press A to save your changes.

If you ever change your network's SSID or encryption key, you will
need to adjust wireless settings in your game console as well.

Figure 17-5: Choose Setfings on the console’s main menu.

Figure 17-6: Choose Settings o change the wireless SSID and encryption keys.



Create an Ad Hoc Network between Consoles

C
Drog

an Ad Hoe Network

D

Turn on your game console, but make sure that the disc
is empty.

Choose Settings (refer to Figure 17-5) and press A.

If you have Xbox Live installed, choose Main Menu on the Xbox
Live menu to reveal the menu shown in Figure 17-5.

In the Settings menu, choose Network Settings and
press A, and then in Network Settings, choose
Advanced and press A again.

Choose Wireless and press A to reveal the Wireless
Status screen. Choose Network Mode and press A.

Choose Ad Hoc as shown in Figure 17-7 and press A.

On the Wireless Status screen, choose Network Name
and enter a name (SSID) for your ad hoc network.

Each console must have the same network name. The network
name should be different from the SSID for any other wireless net-
work in broadcast range.

Select Security Type and choose No Security as your
security type.

Data encryption generally is not necessary when creating an ad hoc
network hetween game consoles since no personal information or
sensitive data is stored on the consoles.

On the Wireless Status screen, choose Apply (see
Figure 17-8) and press A. Make sure each console
has the same settings.

Figure 17-8: Apply the same settings on each console.
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Eect ta Xbox Live
Qagi 'Sall an Xbox Live subscription kit.

Xbox Live subscription kits are available at most electronics and
video game retailers. You need a valid credit card when you create
an Xbox live account, even though you won't need to make an
online purchase if your subscription kit contains a valid subscription.

If your Xbox doesn’t log in to Xbox Live automatically
when you turn it on, remove any disc from the tray and
choose Xbox Live from the main menu, as shown in
Figure 17-9.

Choose your Xbox Live account, as shown in Figure 17-10,
or choose New Account if you want to create a new
account.

In the Xbox Live menu, choose Account Management to
update your subscription or change other account settings.

XBox Live requires a broadband (DSL or better) Internet connec-
tion. Make sure that you have a broadband Infernet connection and
a means to connect your Xbox to your network to share the Internet
connection before buying and installing Xbox Live.

If a game is compatible with XBox Live, it should log in and allow
online play automafically. If XBox Live doesn't work, check the status
of your XBox's network connection as shown earlier in this chapter,
and also double-check that your XBox Live subscription is up to
date. Subscriptions must usually be renewed annually.

Figure 17-9: Choose Xbox Live from the main Xbox menu.

Figure 17-10: Select your current account here, or create a new account.
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your high-tech, Wi-Fi-equipped home just isn't complete without a wire-

less media center. With a wireless media center, you can use one com- Gef ready to...

puter to store and organize all of your music and video, and then stream that ) ]

media wirelessly to any location in your home. With the right hardware, a w= Build a Media Center Computer ................ 156
irel di t Iso: c

WITEIESS Thecia centel call a1so w= Connect a TV to the Media Center ........... 157
m=  Act as a TV tuner, allowing you to watch your favorite broadcast, satel-

lite, or cable shows. = Watch DVDs 158

m= Serve as a digital video recorder (DVR), recording shows onto a hard > Orgunize Media Files .........cooeererrrrrrveeeees 159

drive where they can be retrieved and watched later. = Share Media with the Network

w= Integrate with your TV and home entertainment system to provide an from Windows 160
advanced, high-fidelity multimedia entertainment center.

w= Share Media with the Network

This chapter shows you how to set up and use a computer as a wireless from Mac 0S X 161
media center. Of course, the easiest way to set up a media center is to buy i
a purpose-built Media center PC running Windows Media Center Edition. = Access Shared Media...........oveveveee 162

But if you want to set up a computer yourself, the first section of this = Watch TV on the Computer 163
chapter provides general guidance on how to choose components (ora T TR
computer with the right components) and how to get the computer ready w= Record Live TV 164

for multimedia.
= Play Recorded TV 165
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2 GHZ

Try to stick with an Intel Pentium 4 or better, or AMD Athlon XP or
better. If you prefer Macs, most modern PowerMacs, iMacs, or
MacMinis with a G4 or better processor should be adequate.

Choose a case that is attractive and designed for quiet
operation. You don't want to listen to noisy computer
fans while you try to watch DVD movies.

Make sure that the power supply provides at least
300 watts of power. High-quality display adapters,
hard drives, and TV tuner cards use a lot of power.

Several companies now offer fanless power supplies. A fanless
power supply makes the computer a lot quieter.

Choose a motherboard with plenty of available PCI
slots. The motherboard shown in Figure 18-1 has four
open PCI slots.

Choose a high-quality video card with lots of dedicated
video memory and video outputs that is compatible
with your TV monitor.

The next fask in this chapter shows how fo connect a TV to your
video card.

Install TV tuner cards for both analog and HDTV sig-
nals. Some TV tuner cards support both HD and analog
signals, such as the ADS Tech Instant HDTV PCI card
shown in Figure 18-2.

Figure 18-2: The ADS Tech Instant HDTV PCl card.
Photo courtesy ADS Tech Inc., USA.



Connect a TU to the Media Center

7. Select a high-quality sound card that supports 6.1 or 7.1

DropBook
rop tﬁa 'Sutput on your sound card to the

audio inputs on your home theater receiver to control
the speakers, (see Figure 18-3).

©)
©)

Most electronics stores sell cables that connect the mini-jack outputs
on your sound card to the R(A-style analog audio inputs on a home
theater receiver.

This section provides only a basic overview of the features you want
when you buy or build a media center computer. For detailed instruc-
tions on building and upgrading computers check out Upgrading &
Fixing PCs For Dummies by Andy Rathbone (Wiley Publishing, Inc.).

Connect a TU to the Media Center

1.

Determine the type of input cable that your TV will

accept.

Connect one of the following types of cables between
the TV’s video input and the computer’s video output:

e Component: These consist of three RCA-like connec-
tors colored red, green, and blue and provide the best
possible video quality.

¢ S-Video: This connector (see Figure 18-4) is more
common and provides a high quality image.

¢ Composite: This yellow RCA-style connector (see
Figure 18-4) provides good video quality, but is
inferior to Component or S-Video.

©)

S-Video connectors carry only video images, and no sound. S-Video
is preferable to composite video because S-Video offers higher pic-
ture quality.

mini-jack
RCA jacks —— [5—[5

Figure 18-3: Connect fo a home theater receiver.

O @®

Figure 18-4: Connect your TV to the video card’s Composite (left) or S-Video

connector (right).
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h DUDs

ie into your computer’s DVD-ROM
drive.

When the auto-play window appears, shown in Figure
18-5, choose Play DVD Video using Windows Media
Player and click OK.

If the auto-play window doesn’t appear, open Windows Media
Player from the Start menu. When Windows Media Player opens,
choose Play=>DVD.

If the DVD is recognized by Windows Media Player and begins to
play, skip ahead fo Step 8.

If Windows Media Player does not recognize the DVD,
choose Tools=>Download=>Plug-ins.

On the Microsoft Web site, click the link for DVD
Decoder Plug-ins, and then click the link to install
the Windows XP Video Decoder Checkup Utility.

Follow the instructions on the Microsoft Web site to
download and install the Windows XP Video Decoder
Checkup Utility.

Choose Start=>All Programs=>Windows Media=>
Microsoft Windows XP Video Decoder Checkup Utility.

Make sure your computer has at least one DVD decoder
installed. Figure 18-6 shows that the computer has four
DVD decoders installed.

If your computer doesn’t have a DVD decoder, return to
the Microsoft Windows Media Player Plug-ins page as
described in Step 3, and then download and install one
of the DVD decoder programs listed on the Web site.

Pinnacle Systems DVD (D:)

a disk or connect a device with this kind of file;
'_f_) DWD movie
“wihat do you want "windaws to da?

") Play DVD Video
using Windows Media Player

'y Open folder ta wisw files
// using Windows Explorer

‘Windows can perform the same action sach time you insert

[ Always do the selected action

Figure 18-5: Play the DVD.

(=) Windows XP Video Decoder Checkup Utility [=E

Installed MPEG-2 decoders:

MP10 Compatible = Decoder Yendor | Decoder File Name Decoder Version MCE Compatible Preferred Decoc

Sonic Cinemaster® DS Yideo D, Cinemastervideo, di 2,5.3.806
6 RAYWISENT Cinemaster DS Yide...  DSCinemidsoDec... 2.0.2.654 e
‘3 MainConcept {Adobez) MPEG V.., ADZMCD~1 A% 1.0.0.74 Q
|63 MainConcept MPEG Video Deco, . medsmpeg.ax 1.0.0.55 @
3 (=]
This decoder is not compatible with the synchronization Feature of Windows Media Player 10, We recommend against setting this decoder as
the preferred decoder,
Set as Preferred | o it J |

Figure 18-6: Make sure your computer has a DVD decoder installed.




Organize Media Files

To play the movie at full-screen, press Alt+Enter.

9.
A (or press Esc) to leave the
DropBd
10.

Use the DVD controls at the bottom of the screen (see
Figure 18-7) to control playback.

The menu har at the top of the screen and the toolbar at the hottom
of the screen only appear when you move the computer’s mouse.
If you leave the mouse still for several seconds, the bars will disap-
pear, leaving only the movie image on the screen.

11. To gain access to DVD features such as language tracks
or the DVD root menu, right-click the image, as shown
in Figure 18-7.

If you have a Macintosh with a DVD-ROM drive, your computer
already has a built-in DVD decoder. No other decoder installation is
necessary fo watch DVDs.

Organize Media Files

1. Store all of your media files on a second hard drive.
(If your computer has only one hard drive, use the
Shared (Mac OS X) or Shared Documents (Windows)
folder to store your media.)

2. Create root-level folders for storing audio, video,
images, and other media, as shown in Figure 18-8.

3. Within each folder, create subfolders to further organize
your media.

For audio, create subfolders for each artist. For still images, create
subfolders by subject or a given time period.

4. Copy and paste media into appropriate folders on the
hard drive.

- _———
Audie and Langusge Tracks

Captions and Subtittes.
Flug ins
Wolume

PlayPause

oA g L i L Paissd

Figure 18-7: Access DVD features.

3 DISKZ_VOL1 (E3)

File Edit View Favorites Tools Help

@Back - () [F O search E-Folders‘ Gl

%
a2 E

Address ‘v E:\

HGn

Folders 2 , =y
[ Desktop ’J L'J
® IE] My Documents Audio Images
= 4 My Computer
# & 3% Floppy (A3 J
i# < Local Disk (C:) <
® 2 DVD-RW Drive (D:) Video
= < DISK2_VOLT (E)
# () Audio
# 3 Images
® () Misc
® 3 Video
® [ Control Panel
# G Shared Documents
# [ Dean’s Documents
# () Keith's Documents
® %3 My Network Places
# Recycle Bin

Misc

4 objects (Disk free space: 48.6 GB) Obytes

“d My Computer

Figure 18-8: Organize all of your media.
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e Media with the Network

7

In My Computer or Windows Explorer, right-click the
root-level folder in which you store all of your media,
and choose Sharing and Security from the menu that
appears.

If you use a separate hard drive exclusively for storing media,
right-click the drive letter in My Computer or Windows Explorer. Do
not share an entire hard drive if it contains program files or docu-
ments that you don't want to share.

Under Network Sharing and Security, select the Share
This Folder on the Network check box, as shown in
Figure 18-9.

Give the folder a share name. Other network computers
see this name when they access the shared disk or
folder.

Do not select the Allow Network Users to Change My Files option.
This prevents others from accidentally deleting your songs and
other media.

Click OK to apply your changes and close the Properties
dialog box.

In My Computer or Windows Explorer, make sure that
the shared folder or disk has a hand on its icon, as
shown in Figure 18-10. The hand indicates that the
folder is shared.

DISK2 VOL1 (E:) Properties 2%

| General | Tools | Hardware| Sharing | Quots |

Local sharing and security
| 7 1@ To share this folder with other users of this computer
33 only. dhag it to the 5haied Documen = folder

To make this folder and its subfolders privale so that
arly you have acoess, select the folowing check box. | |

Metwork sharing and security
To share this folder with both network users and other
L. users of this computer, select the first check box below
= and type a share name.

Share this folder on the network |
Share name:  Media Bucke
[] Allows network users to change my files

Learn mare about sharing and security.

jlj ‘windows Firewall iz configured ta allow this folder to be shared
with other computers an the netwark.

Wiew your Windows Firewall settings

ok ][ cence || App-\y ]

Figure 18-9: Share your media store folder
with the nefwork.

4 My Computer =] ]
File Edit View Favorites Tools Help w

QBack L > | ,3" /7.'Search‘ Folders '

fciress| 1§ My Computer

[v| B3 Ge
[o] ) e
Views system = i

information

L) Add ar remave
programs -
=

[ Change a setting
Local Disk (C:)  DISKZ_VOL1 (E)

2

System Tasks

| OtherPlages & ™| o2

7 objects j Iy Computer

Figure 18-10: The disk is shared with your network.



Share Media with the Network from Mac 0S X

Share Medi

Drepbeoe

with the Network

Choose Appler>System Preferences and then open the
Sharing icon.

Select Personal File Sharing (see Figure 18-11) to allow
file sharing with other computers. If you plan to share
media with Windows PCs, also perform the following:

e Select Windows Sharing.

e (Click the Enable Accounts button and then select the
user account or accounts that you want to use when
accessing your Mac from a Windows PC.

If you see a yellow warning triangle next fo Windows Sharing, as
shown in Figure 18-11, you still need to enable at least one user
account fo log-in from Windows. See Chapter 4 for more on sharing
files between Windows and Mac 0S X.

Close System Preferences.

Open the Finder, and then browse to the folder contain-
ing the media you want to share.

Select the folder you want to share and press CMD+1.

In the Info dialog box that appears for the folder,
click the arrow next to Ownership and Permissions
(see Figure 18-12), and then click the arrow next to
Details Under Ownership and Permissions.

Choose Everyone in the Group menu and then choose
Read Only in the Access menu.

Click Apply to enclosed items and then close the Info
dialog box.

een Sharing
o= | [ Showall qQ

Computer Name:  Kaith L

Dther comp

veur campate: k- g4 incal Edit

I Services | Firewall  Internet
Select a service to change its settings.

On  Servce Windaws Sharing On
@ Personal Fie Sharing  Swe

—
PFersanal Web Sharing

Remente Legin

FTP Acgess

Anple Remate Deskrop

Remate Apple Events

Printer Sharing

(<]

Cligk Stop 1o prevest Wimdows users from
BEEe31ng Shared feidery en this cOmBDULE.
This will ahbo prevent Windows wiers bram
printing 15 shared printers

Yeul must enzbie an AccOUnt 10 e
Windows Sharing

grid ( Enable Accounts

Windows LbErS £a0 BECLS Our EOmpuUter 3t 11192168 0. 1081 kethunderdah

i i Click the lock to pravent fusthar changes.

Figure 18-11: Enable file sharing on your computer.
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! Lotked
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b Porview
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Yousan [ Besd BWrne 3]
¥ Denally
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Access. | Read & write ]

|
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Aczess: | Read ealy

4

Others. | Ko Aceess

[ Aoghy to enciosed iterns . )

Figure 18-12: Press (MD+l
to sef folder permissions.
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Shqred Media

ﬁ)se Start=>My Network Places.

Double-click the network place that contains your
media files (see Figure 18-13).

If you don't see the network folder containing your media, dick
View Workgroup Computers on the left side of the My Network
Places window, and then open the icon for the workgroup computer
which contains the media. Remember, the media server computer
must be on and connected to the network.

Open the folder and subfolder containing the media

you want to play.

To play a song or movie, double-click it (see Fig-
ure 18-14).

To play multiple files or folder, hold down the Ctrl key
and click once on each file or folder that you want to
play, and then click Play All or Play Selection under Video
Tasks or Audio Tasks on the left side of the window.

When you play music on a Macintosh from a network location,
iTunes first copies the song to the local computer before playing it.
To change this behavior, open iTunes and choose iTunese>
Preferences. Click Advanced at the fop of the Preferences window,
and then deselect the Copy files to iTunes Music folder when adding
to library option.

Disable power-saving settings on the media server. If the server
shuts down its hard drives or goes to sleep after a period of inac-
tivity, other network computers won't be able to access media files
stored on the server.

~ office network
2 .
o Setup awireless
network for & home ar
small office:

gty View workgroup
computers

% MYDOCUMENTS on CJ and Cole's
...—/ PC (Kids)

% SharedDocs on Keith's Main PC
Shiowe icons For

2 networked UPRP | ___‘.J (Soyopd)

devices

'.J SharedDocs on NLE machine

Other Places # (Mle-machine)

[ Desktop

[

‘-)J My Network Places B[]
File Edit View Favorites Tools Help Hy
. 2 ? /7 ' Search || Folders E'v
Address | My hetwark Places Iv| B 6o
~
Network Tasks £ Keith's Pictures on Keith's Main PC
o/ (Goyopt)
g Add & netwark place -
° X;":.gi:;ﬂk Iedia Bucket on NLE machine
£ set up a home or smal ¢ (Nle-machine]

\ANLE-MACHINE\Media Bucket

Figure 18-13: Locate the network folder containing your media files.

'_71The Common ===

File Edit View Favorites Tools Help

OEack S > | ‘? /._‘Search; Falders Elv

Address HQ Whle-machineiMedia Bucket\Aud\n\The Cnmmnn v, Go

P Flayal

& Shop for music online Iahc mp3
&) Copy to audio <D The Camman

Nothmg |_Do.mp3

nimon

Thoroughbred. mp3

File and Folder Tasks The Comman

Dther Places

Details &

Thoroughbred.mp3

Size: 4.01 MB
MP3 audio File (mp3)

Artist: The Common
Duration: 0:04:23

Type: MP3 audio file (mp3) Size: .01 MB  4.01 MB %J Local intranet

Figure 18-14: Double-click some media fo play it locally.



Watch TV on the Computer

Wat

T(/ o the Computer

Sd that supports the type of TV sig-
nal you want to watch.

Some TV tuner cards support newer HD (High Definition) TV signals,
while others support analog TV. Most over-the-air broadcast signals
are analog, although many TV stations now also offer HD broadcast
as well. If you have cable or satellite TV, check the provider’s docu-
mentation fo find out what technologies are available to you. In this
example | am using an ADS Tech (www.adstech.com) InstantHDTV
card which supports both HD and analog signals.

Connect all appropriate antennas or cables to the
tuner card.

Install tuner software such as SnapStream’s Beyond TV
(www . snapstream.com).

When you install the software, the setup program should gather infor-
mation about your location and cable system. This information is then
used to provide a program guide which is accurate for your location.

Launch the tuner software and enter the program guide
(see Figure 18-15).

Select a program and click it to watch it (see Fig-
ure 18-16).

If you have a media center remote, use its controls to manipulate the
program guide and playback. Press Info on the media center remote
to view details about the current program.

“ SnapStream.Net Guide
3 Days Only

12/28 1:13 PM

12:30 PM 1:30 PM

All My
KATU Children

6 The Bold and
KOIN the Beautiful

T You Can Best of Joy Lidia's

KOAC Draw of Painting Family Table
8 NW Access Paid

KGW Newschann... Hollywood Programming
] All My

KEZI Children

Best of Joy of Painting: Wed 12/28 1:00 PM - 1:30 PM
(Repeat)

1:00 PM

One Life to Live

As the World Turns

One Life to Live

Figure 18-15: A live program guide for broadcast TV

Wed, December

'/0 1:19 PM

Best of Joy of Painting
| (Repeat)

1:00 PM - 1:30 PM

Figure 18-16: View program details.
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érd Li(/E 14
lQth it program on your media center com-

puter and open the program guide.

Locate a show in the program guide that you want to
record.

Click the show you want to record and choose the Record
This Episode option, as shown in Figure 18-17.

To manage recordings, return to the main menu and
click Setup Recordings.

Click Setup Recordings in the Recordings menu, and
then click Upcoming Recordings to review a list of
upcoming recordings.

Click a show to view recording commands (see
Figure 18-18). Choose the Do Not Record option
to cancel a scheduled recording.

To immediately begin recording a show that you are currently
watching, either press the Record button on your media center
remote, or click on the live TV display and then dick the Record but-
ton that appears in the control menu. In SnapStream Beyond TV, the
control menu is in the upper-right corner.

Other tuner programs may differ slightly, but the basic concept and
controls should be the same.

FaRRys Oonly 12/28 1:41 PM
8:30 PM

7:30 PM 8:00 PM

The S .
KOAC View upcoming episodes

H‘.C‘:'I."\.f
9 cord al
KEZI
10
KOPB Cancel

2 : That '70s
KPTV Seinfeld Show (2/2)
Holiday Bow Ved 12/28 8:00 PM - 9:00 PM
"Oklahoma v: - (New)

Record this epr
all ne

Stacked

Upcoming Recordings

Cklahoma vs. Oregon Chg We 00 PM

3 8:00 PM

View details

View upcoming episodes

Do not recordthis episodeatinisitime

Cancel

Fred visits the Empire Brass Quintet

Figure 18-18: Manage scheduled recordings.



Play Recorded TV

Play Recorded TV biyand ty Recorded Shows
D ro QQ i v I,nn : g 8 ho Aol
i u of your TV tuner and recording L ' ZEGUELIN S8 hotiE et
program. Best of Joy of Painting Ned 1
Ch R ded Sh in th R Best of Joy of Painting
00se kecorde Ows 1n the main menu. Mister Rogers' Neighborhood Wed 12/28
Select a program in the list of recorded shows (see Mister Rogers’ Neighborhood Wed 12/28

N | : ap
Flgure 18-19). # Welcome to SnapStream Beyond TV! Fri 12131

4. Click Play to play the program (see Figure 18-20).
Click Delete to delete the program.
By default, recorded shows are kept on the hard drive unfil space

is needed. If you want o save a show indefinitely, click Keep Until Best of Yoy of Painting (Windows Media)
and then choose Keep Until | Delete It in the menu that appears.

Figure 18-19: Choose Recorded Shows from the main menu.

Recorded Shows

Painting

Channel: 7 KOAC p Flay
Date: Wed 12/28/2005 - =
Delete File
Airtime: 1: v

d: Sat ]

< Keep until...
@ Back to Recorded Shows

Figure 18-20: Play or delete the recording. 165
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Storage "9

Networks enable you to easily share resources with all of your comput-

ers. The most commonly shared resources are Internet connections, Get ready to...
printers, and files. Throughout this book, I show how to share all of these )
things, including files that are stored on individual computers. w= Choose a Network Storage Device ............ 168
If you do a lot of file sharing, you should consider a dedicated network w= Install a Hard Drive eooeeeeeeeeeeeeeeeeennen. 168
storage drive. Many companies now offer hard drive enclosures that con-
nect directly to your network, either wirelessly or by Ethernet connection. = Install the Management Software .......... 169
The benefits of network storage ifEERS w= Configure the Network Drive.................... 170
m=  All of your computers can easily share commonly used files such as i
music, videos, and photos. = Create User Accounts 7
w You don’t have to leave unused computers turned on simply because w= Control Access to Folders............ccuurrens 172
you may want to access files that are stored on their hard drives. e Access the Network Drive from Windows ....173
In this chapter, you find out how to set up and use a wireless network stor- w= Access the Network Drive from a Mac ......173

age drive on your home network.
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Chpgse a Network Storage Device
DropBa0

u want a network storage drive with
built-in W1 Fi (see Figure 19-1).

Most network storage drives connect to the network via Ethernet.
Ethernet connections are usually easy to configure and offer greater
data transfer speed, but wireless storage drives provide a hit more
flexibility in where you position and how you use the drive.

2. Choose whether or not you need a network storage
device with a built-in hard drive.

Most network storage devices have a built-in hard drive, but some
devices are simply enclosures info which you can install your own
hard drive. In the following task, | go over how to install a hard
drive in a network storage enclosure.

Install a Hard Drive

1. Open the enclosure as described in the manufacturer’s
instructions.

These instructions only apply if you purchased a network storage
enclosure that does not include a hard drive. Consult the documen-
tation that came with your storage enclosure for special instructions
and requirements.

Prepare the hard drive for installation in the enclosure.

Connect a hard drive cable (the connector looks like
Figure 19-2) between the hard drive and the hard drive
enclosure.

168

netwark

,I: '1 drive

Figure 19-1: Some network storage devices connect to the network wirelessly.

ﬂlllllllllllli@@!lll
ENEEEEEEEEEEEEEEEEER

Figure 19-2: Hard drive cables usually use EIDE connectors.

Most network storage enclosures use EIDE drives. Only install a new,
blank drive in the enclosure. If it has a jumper for sefing the drive
mode, set the jumper to Master. The next section of this chapter shows
how to format the hard drive.




Dr

Install the Management Software

Inst

Op

2. Connect an Ethernet cable between the network drive

the Management Software

QtQ Sable to your network storage drive

and then turn on its power.

and your router.

Even if your network drive has built-in wireless capability, it is nec-
essary to connect an Ethernet cable for inifial setup. When you are
done configuring the drive, you can disconnect the Ethernet cable
and reposition the drive. Make sure that the DHCP server in your
router is configured and running properly, so it can assign an IP
address fo the network drive.

Insert the drive’s setup utility disc in the CD-ROM drive
of one of your network computers, and run the utility
(see Figure 19-3).

Follow the on-screen instructions to complete the setup.

If the hard drive needs to be formatted, open the net-
work drive’s management utility.

The manufacturer's documentation should provide instructions on
how to access the management utility. You may see a deskiop icon
or a link in the Windows Start menu, or you may need to access the
drive by entering its IP address in your Web browser.

Click the link to open the administration controls (see
Figure 19-4).

Click HD Format and follow the on-screen instructions
to format the hard drive. Any data currently on the drive
will be lost.

NAS Drive Kit Configuration and Setup Utility - Step 0

s

NAS Drive Kit

Wliome

O Provide the best fresformance and guality

| Thank you for using NAS Drive Iit. Make sure your Hard Drive is properly mounted
inside the NAS Drive Kit unit before continuing. This Program will assist you with setting
up your NAS Drive kit Hard Drive's network configuration and create shaortcuts for
hanagement and Access from your PC's desktop. Please click Mext to praceed

Version 1.0 2005/05/26

Figure 19-3: Run the drive’s setup utility.

|Administration

System Restart
Reboat Metwark HD
HD Format
Format Metwark HD
Factory Default Reset
Restore Metwork HD to factory default configuration
Firmware Upgrade
Upgrade Metwark HD firmware
System Time
Adjust the systern time
Character Set
Supports the correct character set code pages in SAMBA

Figure 19-4: Your hard drive may need to be formatted.
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qure he Network Drive

anagement screen.

Change the default password to a password of your own
creation.

Changing the password will help protect your data from access by
Infernet-hased infruders.

Open the Host Name controls and enter a host name,
workgroup name, and description for the drive, as
shown in Figure 19-5.

The host name should be descriptive enough that network users will
recognize it as the network storage drive. The workgroup name
should be the same workgroup name used by your Windows
computers.

Click the link to open the IP address controls and make
sure that DHCP is enabled (see Figure 19-6).

Networking - Host Name

Notes: 1. Host name and workgroup name are limited to 15 characters.
2. Space character, control character, and " * * are not allowed.

Host Name: MetworkDrive
Workgroup: |UNDERHOME
Description: MulimediaStorage|

| Ay ] Cancel || Reset

Figure 19-5: The Host Name controls.

Networking - IP Address

Please provide IP Address, Subnet Mask, and Gateway

DHCP Enable: @Yes ORMo

IP Address: 192.168.0.112
Subnet Mask: 255.255.255.0
Gateway: 192.168.0.10]
DNS Server:
Apply H Cancel || Back

Figure 19-6: Enable DHCP.

If you enable DHCP, you can leave the IP address and other fields blank,
because the DHCP server in your router will automatically assign the
drive an IP address.



Create User Accounts

Cre user ccounts |Share - User Configuration

Samba Users

Srive's management utility and then
open the Share screen.

2. Click the link for User Configuration or User Accounts, powerll  guest ¥

depending on your drive.
Samba & FTP Users

3. In the User Configuration screen, select the type of

account that you want to create and click the Add @
button (see Figure 19-7). s
all(l
A power user has full read and write access to all folders of the Caca J[ Dol ) Back )

drive. The All user type can read and write to the drive’s shared
folders. A guest user can only read files in shared folders, and is not
allowed to change or delete any files.

Figure 19-7: The User configuration screen.

4. Enter a user name and password for the new user (see Ehare_Add S
Figlll'e 19'8) User Name: Chirista
. . New P! d:
5. Decide whether or not the user will be allowed access by e T
Way Of FTP. User Description: Christa's Music
T FTP Access: OYes Flko

FTP access should be disabled unless you know that a specific user

. .
will be using FTP.

Figure 19-8: Enter a user name and password for the new user.

6. Click Apply to create the user account.

To delete an account, select it in the User Configuration window and
click Delete.
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Bo0

ess to Folders
drive’s management utility and then
open the Share screen.

Click the link for Folder Configuration or Folder Access,
depending on your drive, and perform one of the fol-
lowing actions:

e To add a folder to the drive, click Add (see
Figure 19-9).

e To delete a folder, select it and click Delete.

e To edit folder access privileges, click the folder’s
name.

In the screen shown in Figure 19-10, set global privi-

leges for all users and control access for individual users.

The Non-Access setting means the user will not be able fo see or
access the folder at all. The Read Only setting means users can see
and access files in the folder, but not change or delete them.

Click Apply to apply your changes.

|Share - Folder Configuration

Share Share to All
O WEB WEB

Click "Add” to add a new folder.
Click "Delete” to remove the folder you select from the list.
Click the folder icon to change the folder name, d ipti

Figure 19-9: Add a new folder to the drive.

and user authority.

[Share - Folder - "Share" limits of authority

Folder Name: Share

feldey Shareto Al e =

Description:

Please set users’ limits for this folder

® Authentication Free Access

O Mo access for all users

O Only Read access for all users
O Readhrite access for all users

CNon-access O Read only @ Readwrite

OnMorn-access ORead only © Read&write
power

ONon-access ©Read only O Readwrite

quest

€c € €< €<

O Mon-access O Read only & Readwrite

Christa

[ Appty || Back |
Figure 19-10: Manage folder access privileges.
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Access the Network Drive from a Mac

Access the Network Drive

@

1.

0

If the setup utility for the network drive created a desk-
top icon, double-click it and then proceed to Step 3.
Otherwise, choose Start>My Network Places.

Click View Workgroup Computers under Network Tasks

on the left side of the My Network Places window.
Double-click the icon for the network drive when it
appears.

Log in to the drive using an account name and pass-
word, as shown in Figure 19-11.

Remember, you must use an account name and password for a valid
user account on the network drive, not your local computer. After
you are logged in, browse the drive using the Windows Explorer
windows just as you would any other drive.

Access the Network Drive
from a Mac

1.

Open the Finder and then click the Network icon to
access network locations.

Double-click the network drive’s icon.

Log in to the drive using an account name and pass-
word (see Figure 19-12).

Choose a folder which you want to authenticate and
click OK. You can now browse the drive using the
Finder window.

Connect to 192.168.0.112 8]
=

2

)

Connecting
User name: lﬁ all w
Password: wesf

[ remember my passward

Figure 19-11: Log in fo the drive.

SMB/CIFS File System Authentication

- I
(.'q: Enter the workgroup or domain and your user name
e | and password to access the server "SOYOP4."

Workgroup or Domain
FREELANCE

Name

all

Password

1 Remember this password in my keychain

Cancel ) (—9&-9

Figure 19-12: Log in fo the drive.

Remember, you must use an account name and password for a valid
user account on the network drive, not your local computer.
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DrdfiBigats Connecting

to a Digital Media
Receiver

Fe line between personal computers and home entertainment centers
has been getting increasingly blurry in recent years, to the point where
today that line is essentially gone. In Chapter 18, I discuss how to build

a wireless media center based around a computer. But even if you don't
want to dedicate a whole computer to home entertainment, you can still
connect your home theater to your wireless network using a digital media
receiver (DMR).

A DMR is a small device that connects directly to your home theater and
offers a connection to your computer network. Most modern DMRs offer
Wi-Fi connection, meaning you won't have to string messy Ethernet cables
all over your living room. With a DMR you can use your home theater to
play media that is stored on your PC in another room. Virtually all DMRs

can play music, and most can also be used to watch movies or view photos.

This chapter shows how to use a DMR with your home network.

| “*\apter

Getready to. ..
w= Configure the Digital Media Receiver........176

w= [nstall Windows Media Connet ................ 176
w= Enable the Receiver in Windows

Media Connect 178
= Share a Windows Media Folder ................ 179
w= Share your iTunes Library ........................ 180
w= Play Media 181

w= Stream Internet Radio to the Receiver ......181
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iqure e Digital Media Receiver

QQd ﬁnedla receiver that supports the type of

media you want to play.

C
Drop

Some DMRs only play audio, while others can also show pictures
and video. If you are accessing Windows Media files, try fo choose
a DMR that displays the Windows Media PlaysForSure logo. This
logo indicates that the manufacturer has tested the device and cer-
tified it to work with Windows Media Player. Likewise, if you have
an iTunes library make sure you buy a DMR that displays the iTunes
logo. Some DMRs can play both Windows Media and iTunes media.

2. Connect the receiver to an Ethernet port on your router
and follow the manufacturer’s instructions to configure
the DMR’s network settings.

3. If the DMR has built-in Wi-Fi, disconnect the Ethernet
cable to use the device wirelessly (see Figure 20-1).

Install Windows Media Connect

1. Download the latest version of the Windows Media
Connect software from Microsoft.

Windows Media Connect is required to make connections between
Windows Media files on your computer and a DMR. To down-
load Windows Media Connedt, visit www . microsoft.
com/windows/windowsmedia/
devices/wmconnect/.

2. Locate the downloaded installation file and double-click
it to begin installation (see Figure 20-2).

176

II‘-E\/\ osr @
@
OhF_ cm—

Figure 20-1: The DMR can get media wirelessly from
your computer.

e

Tl
)
- @

Software Update Installation Wizard

Uz this wizard to install the following software update:

Windows Media Connect

Betore you install this update. we recommend that you:

- Back up your spstem
- Cloze all open pragrams

“You might need ta restart pour computer after pou complete
this update. To continue, click Mest.

Newt > Cancel |

Figure 20-2: Begin the Windows Media Connect Installation.




Install Windows Media Connect

3. Follow the on-screen instructions to complete % Windows Media Connact BEE)

i l i (0] - Select the device you want to allow access to your computer
DropBO0ks...... - =
grams=>Windows Media Connect

to launch Windows Media Connect.

5. If you see your digital media receiver listed in the
screen shown in Figure 20-3, select it. Otherwise,
just click Next.

6. In the screen, choose whether or not you want to share
the listed folders (see Figure 20-4). Then you can

e Click Finish to close the wizard, unless you chose
Let Me Choose Which Folders for Folder Sharing, in
which case you should click Next. |

¢ Click Add and browse to the folder or folders you

want to share. When you are done selecting folders, .
click Finish.

Figure 20-3: If your DMR is listed here, select it before clicking Next.
The default choice shares the My Pictures, My Music, and My Video
folders in your My Documents folder, as well as the equivalent folders N T . CC A SE
in the Shared Documents folder. e

A)‘ Choose which folders you want to share with your devices

=
Only share folders that you use for storing pictures, music, and A e
move files. (@ shar e ot fokdrs:
_:5 My Music fj My Pictures ﬁ My Videos
After you finish running the wizard, you should see a Windows » _ - _ > _
Media Connect icon in the Windows system tray, which is the area [ e gy L e
in the lower-right corner of the screen next fo the clock. Double- Otet me chuose phich focers
dick the Windows Media Connect icon fo adjust media connect o ok share any Flders
seffings. IF yau share Folders, all digital media receivers that you have sekected willbe able to play files in the Falder nless you

deny them access, You wil not be notified when a device plays a file,

[] wtomatically start Folder sharing when Windows starts.

<Frev ] [ Finish ] [ Cancel ]

Figure 20-4: Select folders to share. 177
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Enable the Receiver in Window's
Dropﬁm‘k&

178

Make sure that your digital media receiver is turned on
and connected to your network.

Double-click the Windows Media Connect icon in the
Windows system tray.

You can also open Windows Media Connect from the Start menu.
Choose Start=DAll Programs=>Windows Media Connect fo launch
the program.

In the Windows Media Connect window, click Devices
(see Figure 20-5).
Click a device to select it, and then click Allow.

To block a device from accessing media on your com-
puter, select the device in the list and then click Deny.

Click Settings.

If you want to automatically allow new devices to con-
nect to your media, select the Automatically Allow New
Devices check box (see Figure 20-6).

Read the warning message that appears and dlick Yes to accept
the change.

Click Close to close the Windows Media Connect
window.

%, SOYOP4: 1: Windows Media Connect ===

%‘,,Windows Media Connect

SO¥OP4: Rudea
Fuden Consulting
allovserd

Unknouin Device (52-00-60-0F-e8-00)

Allowed

SOYOP4: Rudeo

Qqgs® Rudso Comuting

Allowed

Settings

Allowy Remove

) Learn more about configuring devices

Figure 20-5: Allow or deny access for media devices.

%, SOYOP4: 1 : Windows Media Connect BEx)

3'te‘_,_.Wim:Iows Media Connect

o Falder Sharing

g Automatically start folder sharing

Devices

Folder sharing is not started, Clidk hete to configure Folder sharing.

w Firewsal

Sharing To restare Windows Firewall settings, dick Reset,

Device Authorization

automatically allow new devices,

) Learn more about customizing settings

Figure 20-6: Allow new DMRs to connect fo your computer automatically.
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Share a Windows Media Folder

ows Media Folder

ShmE:r Wi
O p QIQ &dows Media Connect icon in the

Windows system tray to open Windows Media Connect.

You can also open Windows Media Connect from the Start menu.
Choose Start=DAll Programs=>Windows Media Connect fo launch
the program.

In the Windows Media Connect window, click Settings.

If folder sharing has not started, an on-screen message
tells you the status of folder sharing click Start.)

Click Sharing to open the folder sharing screen (see
Figure 20-7).

To add a folder, click the Add button.

In the Add Sharing Information window, click the

Browse button and browse to a folder that you want
to share.

Give the folder a descriptive name (see Figure 20-8) and
then click OK.

To stop sharing a specific folder, select it in the list of
currently shared folders in the Windows Media Connect
window and then click Remove.

Click Close to close the Windows Media Connect
window.

#, SOYOP4: 1 : Windows Media Connect =@

%\,,Windows Media Connect

Currently shared Folders:

- Name Shared With Shared When Location
Devices [E My Music All Devices Anyone is logged on C+\Documents and Setting. ..
grrmssssnnens | (L My Videos Al Devices Anyone s logged on C\Documents and Setting.
: + | [Dshared pictures all Devices Amyone is logged on C:\Documents and Setting. ..
@ | | [ 5hared Videos Al Devices Anyone s logged on Ci\Documents and Setting. ..
¢ My Pictures All Devices Anyone s logged on C\Documents and Setting.
Sharing [Z shared Music Al Devices Anyane is loaged on Ci\Documents and Setting. .

Settings

) Learn more about sharing folders

Figure 20-7: Decide which folders you want to share.

Add Sharing Information

( B J Choose a folder to share. and then select when the folder should be
/n"‘ shared and which devices should have access to it

Folder: CiiDocuments and SettingsiThe ArbiteriMy Documents!,

Browse. ..

Mame: Keith's Music

Privacy Settings

(%) Make this content available to all devices

cantent av

Figure 20-8: Browse to additional folders that you want o share.
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oug iTunes Library

QKS

Open the Preferences window by following these steps:
e Mac: Choose iTunes= Preferences.
o Windows: Choose Edit=>Preferences.

On a Mac, click the Sharing button at the top of the
preferences dialog box to reveal sharing options, as
shown in Figure 20-9. In Windows, click the Sharing tab
(see Figure 20-10).

Select Share My Music.

Choose whether you want to share your entire library,
or just certain playlists. If you only want to share some
playlists, select Share Selected Playlists and place a check
mark next to each playlist that you want to share.

Enter a descriptive name for the shared media library in
the Shared Name field.

If you want to password protect your computer, place a check mark
next to Require Password and enter a password. Keep in mind,
however, that many DMRs will not be able fo access password-pro-
tected media.

Click OK to close iTunes preferences and save your
changes.

Leave iTunes running on your computer. Most DMRs cannot access
music shared from an iTunes library if iTunes is not running the host
computer.

Sharing
al g H @

[ @ BE @

General iPod Audio Importing Burning | Sharing | Store Advanced

@ Look for shared music
@ Share my music
@ Share entire library
() Share selected playlists:
__90's Music
My Top Rated
_ Recently Added
__ Recently Played
__ Top 25 Most Played

Shared name: Keith Underdahl's Music

[ Require password:

Status: Off

\7 Cancel ') @

Figure 20-9: iTunes sharing options.

HiTunes

General | Pod | Podcasts | Playback | Shaing | Stre | Advanced | Parental Control |

Look for shared music
Share my music
(&) Share entire library |
() Share selected playlists

Shared name: | Ksith Underdshl's Music

[[] Requirs passward:

Figure 20-10: The Windows version of iTunes sharing options.




Stream Internet Radio to the Receiver

l’(a

edia

KIS media receiver and make sure it is

connected to your network.

When the DMR connects to your network, it should automatically
detect media folders that you shared earlier in this chapter.

Use the DMR’s remote control to select a shared media
folder (see Figure 20-11).

Use the DMR’s menu to browse folders and select media
to play.

If the DMR is unable fo locate some of your media, make sure that
the missing media is shared properly, and that the computer storing
the media is turned on and connected to the network. Also double-
check that the media is in a format that is supported by your DMR.

Stream Internet Radio
to the Receiver

1.

Open your media player program and create a playlist
for radio stations. Give the playlist a descriptive name,
such as Radio Stations or Internet Radio.

Open the Internet radio tuner and click and drag radio
stations to your radio playlist. The playlist in Figure 20-12
includes five Internet radio stations.

On your DMR, select the radio station playlist and
choose a radio station to which you want to listen.

e il

Figure 20-11: Use the DMR's remote fo select folders.

800 iTunes
/ http://www.radiocave .com \
u—@‘m@ (-] Elapsed Time: 5:57 -]

i — [ 1

.
Q- a
Search Burn Disc

Source, 4| Song Name Time  Artist

Album

I3 Library # = RightOnReggae Contin...

& Party Shuffie # = Classic Blues Radio Contin..
= Radio o 7 Beatles-A-Rama Contin...

I Music Store # = Rockabilly Radio Contin..

&) 90 Music @ = Dimensions in Jazz Contin...
& My Top Rated

|8 Recently Added

[#] Recently Played

& Top 25 Most Played

B Radio Stations ]

[PRF SN

[*) Selected Song

—

. :

mEE

Figure 20-12: Create a playlist for Internet radio stafions.
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DrdfiBigats Turning pres—

Vour Pocket PC into Chapter
a Remote Control

If you've recently purchased a modern Pocket PC equipped with Wi-Fi and

Bluetooth, you probably spent a fair sum of money on it, and now you're Get ready tfo...
looking for new things to do with the Pocket PC to justify its purchase price.
Meanwhile, in your living room are three or four different remotes, all w= Install Remote Control Software .............. 184

designed to control different pieces of gear, with none of them able to con-

trol your wireless media server computer. w= Connect the Remote fo the Media Server-....185

You are in luck, because media remote programs can turn your Pocket PC = Build the Media Library ...........ccocvc.. 186
into a powerful and versatile remote control. Some programs — like Rudeo = Play Media 187
Play & Control (www . rudeo.com) — allow you to control the media
player software on your media server computer from anywhere in range of
your Wi-Fi network. This chapter shows you how to install and use remote
control software on your Pocket PC.

S Chapter 15 covers setting up and using wireless network connections on a Pocket PC.
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(I Remote Control Software

Inﬁ
D ro p SQ Qn edia Connect on your media server

184

computer. (For just the steps on how to do so, refer to
Chapter 20.)

Install the latest version of Windows Media Player both
on your media server and your Pocket PC.

Most remote control programs require Windows Media Player 9
or hetter; check the software producer’s documentation for specific
requirements. You can download Windows Media Player for
free from www .microsoft.com/windows/
windowsmedia/.

Connect your Pocket PC to your computer using a sync
cable and ActiveSync. (Make sure that the Pocket PC is
powered-on.)

Launch the installer for the remote control program.

Review any special instructions in the installer. In
Figure 21-1, for example, the Rudeo Play & Control
program requires .NET Framework software to be
installed on both the desktop PC and Pocket PC.

When you see the message shown in Figure 21-2, check

the screen of the Pocket PC for special installation steps.

In most cases, you will have to confirm installation and
choose an installation location.

If possible, install the remote software on the Pocket PC's infernal
memory, and not on removable storage media such as an SD card.

7 Rudeo Play & Control 2.1.4 Setup &

Important Product Information - Pleas Read
Rudeo may not work without required components i 0 7

e may have a newer wersion of Rudeo Play & Cantral available
{click link belaw ko check)

Other components may be required For operation, such as
MET Framewark For your PC, and/or

MET Compact Framework update For Pocket PC.

To Play music on Pocket PC a UPNP Media Server is required.

Rudeo-Enhanced UPrP Experience is when you can turn off Pocket PC
and Ruden Server controls UPRP Players. Include Rudea Server bo use It

Please see more information and links on our product information page:

Click to visit Rudeo Play & Control information pags

[ < Back ” Mext = ][ Cancel ]

Figure 21-1: Heed special instructions provided by the installer.

Appli D loading Compl
Please check your mobile device screen to see if additional steps are necessary to complete this
installatian,

Figure 21-2: Check the Pocket PC for additional installation steps.



Connect the Remote to the Media Server

Con t the Remote

Dr DKSrver

Make sure that Windows Media Connect is running on
your server PC and folder sharing is enabled.

Chapter 20 covers Windows Media Connect. Rudeo Web/FAQ
Activation/About
Setup..
Update Library
Rescan Devices
Launch the remote software on your Pocket PC. Disconneet
. % See Target Playlists
Tap the Menu icon and choose Setup (see Figure 21-3). EERT+sSAP
In the Setup screen, select the desired media server, as Figure 21-3: Open the remote
program’s setup screen.

shown in Figure 21-4.

5. Tap OK to close Settings and return to the main screen.

/2 | Rudeo Play & Cont & ¢ 6:05 bk

If you have difficulty making a connection between your Pocket P(, P Sodta e e e
you may need to adjust firewall settings on the server PC to allow ® vso R
the remote software fo access the network. () Use Only Checked Servers
() Exclude Checked Servers
Sever [ Model Status

[#]50¥0... Windows Medi... Present

4] i [ e

UPnP Servers

Figure 21-4: Select the server you
want fo control.
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the edia Library
D ro trol program on your Pocket PC, tap | . . . . )

the dev1ce menu (see Figure 21-5) and then choose the
device you want to control.

2. Read the warning message that appears, and then tap
OK to download the library to your Pocket PC.

Don't worry, the actual media files will remain on the server com-
puter. When the remote software downloads the library, it simply
downloads a list of the items that are in your library.

3. After the library is downloaded, tap the Music Note icon EDT+4¥EY
along the top of the remote control program to view
your music library (see Figure 21-6).

Figure 21-5: Choose the device you
want to control.

4. Tap the Film Strip icon to view your list of available
videos. 7 2 | rudeo Play & Conti §* 4% 6:28 [X

5. Tap the Radio icon to browse available Internet radio
stations.

6. Tap the Playlist icon to access playlists that you have cre-
ated in Windows Media Player.

Hawaii 78 Introduction [Facing

Ka Huila Wai [Facing Future/Israel
"Ama‘ama [Facing Future/Israel
Panini Pua Kea [Facing FLrtureiI"mel
Take Me Home, Country R

Kuhio Bay [Facing Future/|

‘White Sandy Beach of Haw
Henehene Kou'aka [Facing
La Elima [Facing FuturefIsrael

Figure 21-6: View your library.
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Play Media

Pla

2.

3.

edia
rlg hat you want to play in the media

11brary (see Figure 21-7).

Tap to place a check mark next to songs that you want
to hear, and then tap the green arrow at the bottom
of the screen to queue the media up for play.

Tap the Play Control icon on the far left side of
the upper toolbar to open the player controls (see
Figure 21-8).

Although the server computer must have Windows Media Connect
running, it is not necessary to launch Windows Media Player on the
server computer. When Windows Media Connect is running, the
media plays automatically.

Use the playback controls to control playback.

The controls include standard playback controls such as Play,
Pause, Stop, Next Track, Previous Track, and a volume slider.

Tap a song in the current playlist and then use the arrow
buttons at the bottom of the screen to move the song
up or down in the playback order.

Songs af the top of the list play first.

« Hawaii 78 Introduction [Facing

+ Ka Huila Wai [Facing Future/Israel
+ "Ama’'ama [Facing Future/Israel
+ Panini Pua Kea [Facing Future/Israel
« Taks Me Home, Country Roads
Kuhio Bay [Facing Future/Israel
Ka Pua U'i [Facing Futu rael
White Sandy Beach of
Henehene Kou'ska [Facing
La "Elima [Facing Future/Israel

Figure 21-7: Place check marks next
to songs you want fo hear.

7 4 | Rudeo Play & Conti 2 44 6:32 [X

Hawaili 78 Introduction [Facing

Ka Huila Wai [Facing Future/Israel
‘Ama‘ama [Facing Future/Israel

Panini Pua Kea [Facing Future(Israel
Take Me Home, Country Roads [Facing

Figure 21-8: Use these buttons
to control playback.
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DrdfiBigats Adding a

Wireless Print Server
to Your Network

One of the main purposes for creating a home network is so that you
can share stuff between your various computers. This stuff can include
files, your Internet connection, and of course, printers. When everything is
properly configured, any computer should be able to use a shared network
printer.

The traditional way to share a printer with a network is to first connect the
printer to one computer, and then set up printer sharing on that computer
so that other PCs could share the printer. But doing this is inconvenient
because it means that the computer connected to the printer has to be
turned on and connected to the network before anyone else can print.
Now, thanks to Wi-Fi, you can share a printer wirelessly using a wireless
print server, a device designed specifically to connect printers to Wi-Fi
networks. When you connect your printer to a wireless print server, any
computer on your network can access the printer directly through the
network. In this chapter, you find out how to set up and use a wireless
print server.

R
Chapter

Getready to. ..

w= Select a Wireless Print Server ................. 190
e Set Up the Hardware .........eeeeeecceceeeene. 191
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gt a uige less Print Server
aQsQ Snt server is a wireless print server.

Determine to which type of port your printer connects:
e Centronics parallel port (see Figure 22-1).
e DB-25 parallel port (see Figure 22-2).
e USB port (see Figure 22-3).
Most modern printers connect directly to a USB port, so a print
server with USB port is a safe bet in most cases. If the print server

has a Centronics parallel connector, it's probably designed to plug
directly into the Centronics connector on the priner.

Purchase a print server with enough ports to accommo-
date all of your printers.

If you only have one printer then you probably just need a single-
port print server. But if you have multiple printers, purchase a
multi-port print server with enough ports of the correct type for all
of your printers.

Check the security features supported by the print server.

N\ |

Figure 22-1: A Centronics parallel port.

- -

Figure 22-2: The DB-25 parallel connector.

iy

Figure 22-3: A USB port.

Many print servers support only WEP encryption and not WPA. If you
use WPA encryption on your network, a WEP-only print server will not

be compatible.




Set Up the Hardware

Set

3.

5.

the ardware

ration, connect the print server
to your router/WAP using an Ethernet cable (see
Figure 22-4).

Make sure that the printer’'s power is turned off and
then connect the printer to the print server.

Turn on the printer and then connect the power cord
for the print server.

Configure the print server's Wi-Fi connection (see the
following task).

After you have configured the print server's Wi-Fi
connection, disconnect the Ethernet cable so that the
print server connects to your network wirelessly (see
Figure 22-5).

If the print server becomes unable to connect to the wireless net-
work after you disconnect the Ethernet cable, disconnect the print
server’s power cable for several seconds and then reconnect it. If
the problem persists, try rebooting the router/WAP as well.

[routerwap -1 JL— 3

Figure 22-4: Connect an Ethernet cable between
the print server and router.

Figure 22-5: After setup, the print server can
communicate wirelessly.
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e Print Server

rver utility program on one of your
network computers.

On the computer on which you installed the utility
program, choose Start=>Run.

In the Run dialog box, type CMD and click OK.

At the command prompt, type ipconfig, as shown in
Figure 22-6, and press Enter.

Make a note of the IP address, subnet mask, and default
gateway that appear (see Figure 22-6).

The subnet mask and default gateway are the same for each com-
puter on your network. Each computer also shares the first three
segments of the IP address, but the last segment of the IP address
is unique to each computer and wireless device.

Type EXIT and press Enter to close the command
prompt window.

Run the configuration utility for the print server, as
shown in Figure 22-7.

After the print server utility software is installed, you should be able
to run it from the Start menu.

&8 C:\WINDOWS\system32\cmd.exe

icrosoft Windows XP [Uersion 5.1.26881
(C> Copyright 1985-2081 Microsoft Corp.

C:~\Documents and Settings\The Arbiter.CELERON>ipconfig

indows IP Configuration

Ethernet adapter Local Area Connection:
Connection—specific DN§ Suffix . : domain.actdsltmp
IP Address. . - - . . - « - . . . & 192.168.8.181
Subnet Mask . . . . . . . . . . . : 255.255.255.@
Default Gateway . . . . . . . . . = 192.168.08.10
Ethernet adapter Bluetooth Network:
Media 8tate . . . . . . . . . . . i Media disconnected

C:\Documents and Settings\The Arbiter.CELERON>

Figure 22-6: Write down the IP address, subnet mask, and default gateway.

o2 PS-Utility OF
Device Name Change IP Address ‘ Update Firmware ‘
<3 PS5911A9
Show Web Setup ‘ Factory Reset ‘
[ Information
MAC Address 0003 1b 5911 a9
IP Address 192.168.0.254
Model APSUSBZO1W
Status Running
Firmware 313
UpTime 0 days, 00:02:45
Discover Device ‘ About ‘ Close
:.F{ead.y 1 Devices

Figure 22-7: Run the print server utility program.




Configure the Print Server

8. Click Change IP address. “Change IP Address

D ro p |K18VEI’ utility programs, the IP address settings may & Manually Assign ‘
be Tocated In G menu. Paddress 192 [168 Jo [254

w i
Subnet Mask {ZE {Zﬁ {ZE '-I]_

9. Select the DHCP Automatically Assign option and DelzutiCateavl oo
Click OK " DHCP Assign Automatically
In most cases, having an IP address automatically assigned to the ok | cancer |
print server is preferable. However, if the print server does not -
work with automatic IP assignment, follow the next few steps to set flgure 2_2'& Enter network address
the network addresses manually. Otherwise, skip ahead fo Step 12. information here.
10. Enter the first three segments of your network’s IP #5560 A0 s

address (see Figure 22-8). For the last segment of the IP
address, enter a number between zero and 254.

11. Enter your network’s subnet mask and default gateway
and click OK to save your changes.

12. Open the print server's Web browser configuration
utility. Locate the Wireless settings and enter your
SSID, WEP keys, and other Wi-Fi security settings (see
Figure 22-9).

Figure 22-9: Enter Wi-Fi security settings into the print server.
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Il Prigter Drivers on Network
ks

Insert the setup disc that came with your printer in the
computer from which you want to print.

Use the installation utility to install the printer drivers
(see Figure 22-10).

Repeat the installation on each network computer from
which you plan to print documents.

In some cases it may not be necessary to install printer drivers.
Printer drivers for many modern printers are built-in fo Windows XP
and Mac 0S X.

Print from Windows

1.

194

Open the Windows Control Panel and then double-click
the Printers and Faxes icon.

Click Add a Printer under Printer Tasks on the left side
of the screen.

Click Next in the first screen of the Add Printer Wizard
and then choose Network Printer in the second screen.

Choose to Browse for a printer and then browse to your
print server, as shown in Figure 22-11.

When you are prompted to do so, select the printer driver
for the network printer. You can now print to the network
printer from any application. Simply select the network
printer in the printer selection menu of each program'’s
respective Print dialog box.

Thank you for buying an hp

[jﬂ deskjet printer.

What would you like to
do??

Install printer software

- Remove printer software

Figure 22-10: Install the printer driver on each network computer.

Add Printer Wizard

Browse for Printer

When the list of printers appears, select the one you want to use. :

Printer; | MWPS-5911ASPS-531149-U1

Shared printers

(& “SOYOPhp deskjet 345c hip deskiet 8450 (]
& WSOYDP4NScanSoft POF Printer  ScanSoft PDF Printer
“E| PS-531149

= s e From Printcap
I SOvOPd

[=1 >
Printer information
Comment  printer ok

Status: Ready Diocuments waiting: a

l < Back l[ MNest > ][ Cancel ]

Figure 22-11: Browse to the print server.




Print from Mac 0S X

Drop

Print_from /Kw oS X

QQ m Preferences and then click the

Print & Fax icon in the System Preferences window.
Click the Plus (+) sign in the Print & Fax window.

In the Printer Browser, shown in Figure 22-12, click
Default Browser and then click the name of your
printer using the AppleTalk connection type.

The Printer Name listed in the Printer Browser may actually be the
name of the print server instead of the prinfer.

Choose your printer’s brand in the Print Using menu.

Choose your printer's model from the model menu that
appears (see Figure 22-12).

Click Add. You can now print to the network printer
from any application. Simply select the network printer
in the printer selection menu of each program'’s respec-
tive Print dialog box.

806 Printer Browser =
: 5.
3 s Q-
Default Browser | | IP Printer Search
Printer Name 4| Connection
PS-5911A9-Ul AppleTalk
PS-5911A5-U1 Bonjour
Name: PS-5911A9-U1l
Location: Local Zone
Print Using: ~ HP )
Model -
HP DeskJet 690 series - Gimp-Print v5.0.0-beta2
| HP DeskJet B10C - Gimp-Print v5.0.0-beta2
HP Deskjet 812C - Gimp-Print v5.0.0-beta2 m
HP DeskJet 840C - Gimp~Print v5.0.0-beta2
HP Deskjet 842C - Gimp-Print v5.0.0-beta2
HP DeskJet B45C - Gimp-Print v5.0.0-betaz ]
HP DeskJet 850C - Gimp-Print v5.0.0-beta2 v
-, < ~ [ ~
L5 ( More Printers... ) ( Add )

P

Figure 22-12: Select your network printer.
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Drdi@igses Setting Up

Vour Own Hotspot

W hen you set up a wireless home network, you normally spend a lot
of time making sure that your network is private. But what if you

want friends and family to be able to use your wireless network when they
visit? Or what if you have a small business and want to give your customers
Internet access when they're at your store?

The solution is to create your own hotspot. With a hotspot, your friends or
customers can easily access the Internet while they’re at your home or busi-
ness. If you have a small business such as a coffee shop, motel, or restaurant,
Wi-Fi access may be particularly appealing to your customers and may help
improve your sales. This chapter shows you how to set up a public or semi-
public hotspot of your own.

s Do not connect your husiness computers to your hotspot. People who use your hotspot

could possibly access other computers that are connected to the hotspot, and if your busi-
ness computers are connected your sensifive data could be compromised. Set up a sepa-
rate network to use for your business PCs.

| “*‘mpter

Getready to. ..
w= Choose an Access Point ......eeeeneeeeeennnnee. 198

w= Deal with Your Internet Service Provider ....199

w= Configure the Access Point........................ 200
w= Control Access to the Hotspot.................... 202
w= Deactivate the Hotspot .........ceeeeeeeeeec. 203
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se an Access Point

Ch
D ro él@ Q ccess point (WAP) that supports as

198

many 802.11 Wi-Fi formats as possible.
At a bare minimum, the WAP you choose should support 802.11h
because that is the most widely used format. Some WAPs also sup-
port 802.11a and 802.11g.

Make sure that the WAP also has a built-in router, like
the one shown in Figure 23-1.

Your wireless access point needs to have a built-in router so that
DHCP can automatically assign IP addresses to each computer that
joins the network. The router/WAP in Figure 23-1 was supplied by

my DSL service provider and even has a built-in DSL modem. This
unit would make setting up a hotspof very easy.

Choose an access point designed for outdoor use if you

want to extend your hotspot into harsher environments.

Ensure that the access point conforms to local fire codes.

Consider a WAP with built-in access control, if this is a
feature you need.

Make sure the WAP can accept external, high-gain
antennas. Most WAPs use a standard coaxial antenna
connector.

Figure 23-1: This WAP is also a router and a DSL modem.

©)
®

Most municipalities have special fire safety codes for businesses, and
some of the cheap mass-market WAPs offered fo home users don’t meet
local fire safety codes. Check your local codes and the documentation for
your WAP to ensure that it complies.

Access control allows you to limit hotspot users to your customers. With
access control, customers must enter a user name and password to use
the hotspot.




Deal with Your Internet Service Provider

ealwith Your Internet

D
Dro

1. Review your Internet Service Provider’s (ISP) terms of
service agreement carefully for any limitations that
might prevent you from running a Wi-Fi hotspot.

2. Contact the ISP and tell them that you want to create a
hotspot.

3. If possible, upgrade the speed of your Internet connec-
tion. A 256k DSL connection may be fine for only a few
computers, as shown in Figure 23-2, but if you have
many users, as shown in Figure 23-3, the connection
will be too slow to handle all of the traffic.

4. Find out if your ISP or another company offers hotspot

services that can be used in your business. Figure 23-2: A 256k DSL connection can support a few computers using e-mail and

the Internet.
If you think you'll have a lot of hotspot users and you are con-
cerned about managing it properly or dealing with unforeseen
costs, consider contracting the hofspot service out to your ISP or
another service provider. Keep in mind that generally speaking, the
less hotspot access costs your customers, the more it will cost you.

to Internet —~

Figure 23-3: Add a lot more computers and the bandwidth isn't enough.
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personal network.

Some husiness-oriented WAPs support multiple SSIDs, allowing you
to manage both public and private networks using the same WAP.

Use a Web browser to log in to the WAP'’s control panel.

Change the WAP’s administrator password so that it is
no longer the factory default. Use a strong password
that includes a combination of letters and numbers.

Locate the wireless network controls (see Figure 23-4).

Set an SSID that is recognizable and easy to type.

Choose an SSID that identifies your business or location. Remind
your users that the SSID is case sensitive.

Determine whether or not you want to broadcast
the SSID and adjust broadcast settings.

If you don't broadcast the SSID, you can more easily control who
gets on the network. However, this also makes it a lot harder for
users to log-on. If the SSID is not broadcast, users will have to man-
vally enter the SSID o join your network; it will not show up auto-
matically in their network lists.

Disable proprietary speed boosting technologies, if your
WAP incorporates them.

DI-624 |

LN

| Wizard Wireless Radia & on © Off
S3ID : mainstrestcafe
I Wireless Channel : 11 [»] [ Auto Select
— Super G Mode - Disgbled " 1y
Twan Extended Range Mode © O Enabled @ Disabled

DHCP

LE

1,17, -3 Advanced  Tools Status Help

These are the wireless settings for the AP(Access Point)Partion.

802.11g Only Mode = O Enabled @ Disabled
S5ID Broadcast & Enabled O Disabled
Security - @ nNone O wer © wpa O wpa-psk
Authentication Open System Shared Key
WEP Encryption Key Type
Key1
Key2
Key3
Keyd

*Enabling Extended Range Mode will automatically disable Super G with Static Turba
and SSID Broadeast mode
*Super G with Dynamic Turba and Super G with Static Turbo mode only operates in

9 00

Apply Cancel Help

Figure 23-4: Broadcast the SSID.

Most companies offer proprietary technologies that allow theoretical
networking speeds faster than 54Mbps, which is the speed of 802.11¢.
Most of your users will probably have different brands of equipment,
meaning they can't take advantage of the speed boosting technologies.
In some rare cases the speed boosfing features can cause compafibility
issues with other brands of equipment. Furthermore, you probably don't
want fo encourage the high-bandwidth usage that can result from
speed-hoosting technologies.




Configure the Access Point

8.

DropBg¢

9.

10.

11.

12.

13.

Determine whether you need to use WEP or WPA

61’!( st settings accordingly.

Geferally spedKing, you do not want fo use encrypfion on your
hotspot. For more on configuring and using encryption, see Chapter 6.

Set the transmission (Tx) rate to 11 Mbps if you are con-
cerned about bandwidth, as shown in Figure 23-5.

Using 11Mbps ensures compafibility with 802.11a/b/g devices,
and it should be plenty of speed for e-mail and Web browsing. By
slowing the Wi-Fi network speed down fo 11Mbps, you discourage
high-bandwidth usage such as file downloading. Usually the Tx Rate
can be controlled on the Wireless screen of your WAP's control
panel, or s in the case in Figure 23-5 on the Performance screen.

Locate the DHCP server controls (see Figure 23-6) and
make sure that the DHCP server is enabled.

Set an IP address range that is adequate for the number
of computers you plan to use the network.

The numbers in IP addresses can range hetween 0 and 255. In
Figure 23-6, the range is 100199, meaning that 100 computers
can use the network simultaneously. If you want to limit it fo a
lower number, reduce the allowable range of IP addresses.

Change the IP address Lease Time to a shorter time
period, such as one hour.

Save your settings and close the WAP control panel.

;

Wirtued Sorver

Filters

1

| el
Firewall

Ll

g

i

These are the Wirslezs Performance features for the AP{Access Paing) Portion

TeRate (11 [ (hbps)
Transmit Powes | 100% (%
wal - (100
RTS Threshold - 2346

Beac

o angi 20-1000, defa 100)
i 1=2346, dufa 2346)

25E~2346, dufaul 2348, evin rumber orily)
=265, default 1)

Fragmentation = 2346
OTM irtgreal |1

Preamble Type - ) S5
CTS Modi - © Neno ©

¢ © Lang Preamble
© e

Figure 23-5: S

et the transmission rafe.

Dl-&li

Wircless

JEE

WAN

LAN

d

Home  LXULLI ool Status Help
DHCP Serv
The DIE24 can be satup as & DHCP Sorer to destribute IP addresses to the LAN
network
DHCP Server @ Enabled Drgabled
Stating IP Address 162 168 0 100
Ending IP Address 192 168 0 199
Livasie Timo 1 Hour |»

Static DHCP is used 1o alow DHCP serves 1o assign same 1P addoss to specific MAC

addmss
O Ensbled @ Disabled

Name

" 192 168 .0

MAC Address o + g * T

DHCP Clisnt VDS 00-03 6014 EC-FD >
2 ¢
Apply Cancel Help

Hait Nami 1P A WAL Adiss

Host Name I Addrass WAL Adiress Expirad Tima

EIDs 192 1680104 00.03-6D-14.EC-F0  Dec/1 772005 17:15:20

C5.59CHTE 1521680103 00.03-1B-38-C5.TE  Dec/17/2005 130853
MHN-T40 1921680102 00 3A-20-23-73 Deci 12005 11 32
nle-mackane 1921680106 52-34-00-E6-T3-DF  Dec/17/20

152 1680100 00-0D-34-17-08-DF  Decl 17720
SOYOP4 1921680101 00.50-2C-07-B3.25  Dec/162005 164324

o

Figure 23-6: Adjust DHCP setfings for your hotspot.
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rol Ackess to the Hotspot

omers about good security practices.

Customers should disable file sharing on their computers when
using the hotspot, and turn off their computers or disable the Wi-Fi
adapter when they are done using the network.

Log in to your WAP's control panel.

Review the traffic statistics for your hotspot (see
Figure 23-7).

You should review traffic stafistics at least daily. Excessive wireless
traffic may indicate that your hotspot users are using the connec-
tion to download large files. To discourage this use, reduce the
transmission speed of your WAP as described earlier in this chapter,
or implement more stringent access controls.

During business hours, regularly check the number of
wireless clients currently connected to your hotspot
(see Figure 23-8).

In Figure 23-8, three computers are connected to the network. If |
look around and see that only one person in my store is using a
computer, then it is likely that people outside the business are steal-
ing access.

Stats

1EE

Connected Time

Dec/11/2005 10:28:42
Dec/11/2005 10:21:19
Dec/10/2005 13:12:45

MAC Address Iode

00-11-50-95-10-56 24 GHz
00-0D-3A-17-08-09 2.4 GHz
00-03-1B-58-C9-7E 2.4 GHz

DI-624
I Home Advanced  Tools Status m
i Trafic Statistics Q\splay Receive and Transmit packets passing thraugh the DHE24
Devicelnfo (+]
Help
| Loq Receive Transmit
WAN 528670 Packets 268924 Packets
LAN 352947 Packets 213208 Packets
Stats WIRELESS 11g 205488 Packets 275692 Packets
Figure 23-7: Review traffic statistics for your hotspot frequently.
DI-624
I Home  Advanced  Tools Status m
nnected Wireless
» The Wireless Client table below displays Wireless clients Connected to the AP o
 pseaoa (Access Point) Help

Figure 23-8: Check the number of wireless clients connected to your hotspot.




Deactivate the Hotspot

Droi:)

If your hotspot is only for the use of friends and family,

g@%ﬁ and set up basic encryption, as I
ek 1t .

If tighter access control is required, install and use a
hotspot access control program, as shown in Figure 23-9,
or a dedicated hotspot appliance that serves as a WAP
and log-in controller.

The access control program or appliance should present your users
with a simple Web browser-based log-in screen, such as the one shown
in Figure 23-9. Hotspot access programs include ControlAP (www .
controlap.com) and PatronSoft FirstSpot (www .
patronsoft.com). Hotspot appliances include the
Boingo Hot Spot in a Box (www . boingo . com), Gemtek
P-560 (www . gemtek-systems . com) or Netopia
Hotspot Starter Kit (www . netopia . com).

Deactivate the Hotspot

1
2.
3
4

Log in to your WAP's control panel.
Locate the wireless radio controls (see Figure 23-10).
Turn off the wireless radio.

Save your settings and close the WAP control panel.

You should deactivate your hotspot whenever you are closed for
business or do not otherwise want users accessing the hotspot.

& First Street Cafe Login - Mozilla Firefox =&
File Edit View Go Bookmarks Tools Help [+]
€ - G0 D@
_ = m
First Street Cafe
Hotspot Login:
Login L
Fassword: 3
Eotgot password?
D't have an account? Clisk here to creste an account,
Contadt | Privacy Polisy
[v]
Done

Figure 23-9: Use software that uilizes o browser-based

log-in screen.

Home LN Too Status Help

Theze are the wireless st

ilfe

Wisard Wireless Radwy
Channal

— Supar G Mada
=V Extended Rango Modo
B02 11g Only Mode

551D Broadcast

LAN Sacurity
Authartication

Kayl

Kay2

Hayd

Kayd

and SSI0 Broadeast mod
*Zupur G with Oymami Tud
Charmel &

*Enabling Exténded Rangn M

ings for the AP(Access PoirtiPorion

O on B off

mainsteeicale

11 [ [ auto Seiect

Disablad -

) Ensbled @ Digablad

0 Enabled = Disabled

@ Erabled O Dissbied

@ None O wep O wea O wWeA-PSK
Open System  Shared Key

ey Type

Aodn will sutematically disable Super G with Static Turbo

o and Super G with Stabic Turbo mode only operates m

2 00

Apply Concel Help

Figure 23-10: Turn off the wireless

radio fo deactivate the hotspot.
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Drdfisigats Voice e
hatting with Vour Chapter

Wireless Network

' ext chatting is almost as old as the Internet itself. A more recent develop-

ment, however, is the growing popularity of voice chat over the Internet. Get ready to...
If you have a broadband Internet connection, you can save long distance
phone charges by making your calls online. And if you have a wireless w= [nstall Skype 206
computer, you can use it to make your Internet calls from anywhere in i
your home. = Find Skype Users 207
Several free programs are available that let you make Internet calls. You find = Make a Call with Skype........oovsvrerren 208
out about two of the most popular programs — Skype (www . skype . com) = :
and Google Talk (www.google.com/talk/) — in this chapter. In addi- Call POTS Phone Numbers with Skype .....209
tion to an Internet voice chat program, you also need speakers and a micro- = [nstall Google Talk 210
phone. At the end of this chapter, I show you how to use either Skype or )
Google Talk Wlth a Wireless Bluetooth headset. i Flnd GOOgle T(]"( USGI’S ............................ 2]]

Chapter 14 provides information on configuring Bluetooth headsets and other Bluetooth = Talk with Google Tak ... Al
gear for use with your computer. w= Chat with a Bluetooth Headsef ............... 213
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Il Skype
D ro ﬁ k& com and click the Download link.

206

Follow the links to download a version of Skype appro-
priate for your computer.

Note any special installation instructions on the Web site. As of this
writing, versions of Skype are available for Linux, Mac 0S X, Pocket
PC, and Windows.

When the installation file is downloaded, locate it on
your computer. Double-click the file to begin installation.

Follow the instructions on-screen to install Skype. When
you get to the last screen of the installation program,
select the Launch Skype check box and click Finish.

In the Create Account window that appears the first
time you launch Skype, shown in Figure 24-1, enter a
Skype name and password.

Click Next, fill in the optional information if desired,
and click Next again.

If the Skype name you entered is already being used by someone
else, Skype will automatically recommend some alternatives. You
can also try entering a different name if you wish. The first time you
log into Skype a tour will introduce the key features of the program.

If you already have a Skype account and are simply
installing Skype on a new computer, click the Existing
Users tab in the account creation dialog box (see Fig-
ure 24-2). Enter your account name and password

to log in.

You can create multiple Skype accounts on the same computer.
Simply choose Filec>Log Off, and then choose Filec>Log in as a
New User fo create a new account.

Skype™ - Create Account

@ Create a new Skype Account

Wihat would you like ta do?

M Users - Create a Skype ACCount | Exjsting Users - Log in to Skype
|
# Choose Skype MName  keithunderdahl

Minimurn & characters. Your Skype Mame
must start with 5 letter and cannot
include spaces.

# Password AR

* Repeat Password S ]

Minimum 4 characters

Log this user on sutomatically when Skype starts
[ start Skype when the Computer Starts

* [ves, 1 have read and T accept the Skype End User Licence Adreement

Fields indicated with red asterisk (*) are required

Cancel

Figure 24-1: The Create Account window.

Skype™ - Login to Skype

l"a Log in to Skype

What would you like to da?

| Mew Users - Create a Skype Account | Existing Users - Login to Skype. |

* Skype Mame [keithurderdabl ||

* Password hbskokskoekol

Eorgot wour password?

[ Log this user on automatically when Skype starts
[] start Skype when the Computer Starts

N
%~ Set connection parameters and provies

Figure 24-2: Log in to an account.




Find Skype Users

Dr Find Sk é’/’é sers

If you are not automafically logged in when you launch Skype,
choose Filec>Log In as a New User to log in.

On the Skype toolbar, click Add Contact.

Enter a name, Skype name, or e-mail address and click
Search.

If your search yields too many results, close the Add a Contact win-
dow and click Search in the main Skype window. Doing this opens
a search screen that allows you to tailor your search by location,
gender, and other criteria.

In the list of results (see Figure 24-3), select the name
of the person you want to add to your list of Skype
contacts and click Add Selected Contact.

In the authorization request window that appears (see
Figure 24-4), choose whether or not you want the per-
son to be able to see when you are online.

A default text message appears, but you can customize the mes-
sage if you wish. Simply delete the existing text and type a new
message.

Click OK. After the contact has authorized you, his or
her name appears in your list of contacts in the main
Skype window.

6} Skype™ - Add a Contact 2|=[*]

@ Add a Contact

Enter the Skype Name, full name or e-mail address of the persan you wish ko add to vour contact list,

Christa Underdahl
‘We Found 1 contact,

0 View Profile @ Add Selected Contact

Full Mame | Skype Hame CountryfRegion | Ciby Language
 Christa Underdahl christaunderdahl United States Cregon English

Cancel

Figure 24-3: Add someone to your list of contacts.

&) Skype™ - Request Authorization from Christa Underdahl (chri derdahl)

@ Request Authorization from Christa Underdahl (christaunderdahl)

Send & message ta Christa Underdahl {christaunderdahl)
Qo

Please allow me to see when you are online

Christa Underdahl (christ aundsrdahl) will ses this message when your request is sent

What would you like to do?
(3) Request autharization to see his/her status and allow this user to see when I am online

() Request authorization ta ses hisfher status but do not sllow this user ta see when T am online

Figure 24-4: Contacts must authorize calls from you.
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Il with Skype

Mcée a C
D ro p iQaQ e 'Sour contacts list (see Figure 24-5).

208

You can only place live calls to people who are currently online and
not involved in another call. If a person is online the button next to
his or her name will be green. If the person is offline, you can send
a voice-mail message.

Click the Call button at the bottom of the Skype win-
dow. Skype attempts the call and a ringing phone
sounds in your computer speakers. The ring tone also
sounds in the other person’s speakers and a notification
message appears.

Click the phone button (vertical receiver) in the call
notification window to answer an incoming call (see
Figure 24-6).

During the call, choose Call=>Mute Microphone to tem-
porarily mute your outgoing audio.

Cick the End Call button (horizontal receiver) to end a
call. Either participant can end a call.

You can also conduct conference calls using Skype. To do so, dlick
Conference on the Skype toolbar, and then select conference partici-
pants from your contacts list. Conference calls can have up to five
people (induding the host) although you may find that audio quality
diminishes exponentially with each additional conference participant.

6 Skype™ - keithunderdahl s

File View Tools Call Help
Q &2 % @ :
Add Contact Search Conference | Chat Send File

& Contacts | [#] pial | €% call List
w Skype Contacts (2/2)

) Christa Underdahl
@ Cregon, United States

1 Skype Test Cal

| Mo new events

| B Services

0@

9~ oOnline 2,711,401 Users Online

Figure 24-5: Select someone in your
contacts ist.

Q Skype™ _ chistaunderdahl o)
File View Tools Call Help

Q@ L& = @ o
Add Contact Search Conference | Chat Send File
& Contacts | 7=l Dial L Call List

| @ Keith Underdan eeithunderdanl)

Keith Underdahl (keithunderdahl)

is Calling...

P 1 new event

| Q Services

)

E]L

@~ ¥ Keith Underdahl (keithunderdahl) is Calling

Figure 24-6: Answer or end the call.




Call POTS Phone Numbers with Skype

Call LOTS Phone Numbers

Dra

1.

S

To place calls from Skype to land lines or mobile
phones using POTS (Plain Old Telephone System)
phone numbers, visit www . skype . com and click the
SkypeOut link.

Follow the instructions to purchase Skype Credit online.
In Skype, click the Dial tab.

Enter the country code and phone number to place a
call (see Figure 24-7).

Conduct the call (see Figure 24-8). Click the End Call
button to terminate the call when you're done.

Skype cannot be used to call emergency numbers, such as 911. If
you have an emergency, make sure you use a land line or cell
phone to place the call.

To get a phone number that other people can use to call
you from any land line or mobile phone, visit www .
skype. com and click the Skypeln link.

Follow the instructions on the Web site to subscribe to a
Skypeln number. Skype automatically provides you with
a phone number that others can use to call you from
almost any telephone. Callers incur long distance phone
charges in accordance with the policies of their long dis-
tance carrier.

When you select a country and locale for your Skypeln number,
choose a number that is close to the majority of people who will
be calling you. For example, if people in California call your United
Kingdom-based Skypeln number, they will pay international call
rates to their long distance provider, even if you actually take the
calls using Skype in New York.

) Skype™ - kei dahl =g/t
File View Tools Call Help
@ i ;‘@
Add Contact Search Conference
= Contacts | 2] Dial | €% call List
(4 ===y
e~
SR I S
(* 0+ |#
| No new events
a Services
154155512345 ™
@~ Online 2,688,327 Users Online

Figure 24-7: Call almost any phone
number with SkypeQut.

Flie View Teols Call Help
&2 8 o W “ o
Add Contact Search Conference | Chat Send Flle Profile

g contcs 2 sl b call List
.15 Lo .
| & 15416551234

Call with...

15415551234
Call Durakion 00:03

(| Mo v st

) services

L

Figure 24-8: Conduct the call.

3 Skype™ - kelthunderdahl HaE
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Il Goggle Talk
Dro ﬁ kﬁe com/talk/ and click the

210

Download Google Talk button.

Google Talk requires a Gmail account. If you don't have a Gmail
account, click the Get An Account link on the Google Talk page and
follow the instructions to create a Gmail account. Gmail accounts
are free but typically require that you provide some information
such as a mobile phone number.

When the Google Talk installation file is downloaded,
locate the file and then double-click it to begin
installation.

Follow the instructions on-screen to complete the sim-
ple installation process.

After installation, enter your Gmail username and pass-
word in the login screen, shown in Figure 24-9.

After you are logged in to Google Talk, click the Settings
link near the top of the Google Talk window.

In the Settings window, review the General settings (see
Figure 24-10).

If you don’t want Google Talk to automatically launch
every time you start Windows, deselect Start Automatically
When Starting Windows check box.

Review other settings and click OK when you are done.

Google Talk

ta k(b ‘)Inhn | Settings | Help

@ Signin

Gmail username
|

FPassword

[¥] Remermber pagsward

Forgot your password?

Don't have Gmail?
Sign up using vour mobile phone

Figure 24-9: Log in fo Google Talk.

Settings
General
Blocked || General
Privacy
Notifications
Connection [18kart automatically when starting Windows:

Audio
] open Gmail when 1 click on email links

Friends List
[] 5otk Friznds by name

Hide offline Friends

#dd peaple I communicate with often to my Friends List

Account settings...

[] shiow when T chatting

Enable diagnostic logging | What's this?

Figure 24-10: Adjust Google Talk settings.




Find Google Talk Users

Findéooq(e Talk Users

Dropi

2.

Q@Kﬁif it is not already open.

Click Add Friend in the lower-right corner of the Google
Talk window.

In the resulting Invitation screen (see Figure 24-11),
enter the e-mail address of the person you want to add
to your contacts list and Click Next.

You can enter any e-mail address, whether the person has a
Gmail account or not.

e If the person already has a Gmail account, you will
see a screen congratulating you for successfully
adding the contact.

e [f the person does not have a Gmail account, you see
the screen shown in Figure 24-12. Edit the invitation
text if desired and click Next.

Pay attention to the number of free Gmail invites remaining on
your account. Gmail allows you a fixed number of invites, so use
them carefully. The screen with the invitation text (Figure 24-12)
also lists your remaining Gmail invites.

Invite your friends to Google Talk

)
ta k@, Talk to more of your friends for free

Send an invitation ta the peaple you'd like to talk to for free. Once they
accept and download Google Talk, you'll be able to talk to them
immediately.

Pick fram wour list of contacts, or enter an email address directly. To add
rmare than one person at a time, separate the addresses with a comma.

Add: | user.name@arnail.com

Choose from my contacts.

Figure 24-11: Enter the e-mail address of contacts you want

to add.

Invite your Friends to Google Talk

))
ta kg' Some of your friends need Gmail first

Almost done! The person you have invited doesnt have a Gmail address
They will need a Gmail usemame and password to use Google Talk.

You have enough invitations available (19 lef, so we'll send your friends
an invitation to open a Gmail account and to download Google Talk.

Add a custom message to the invitation

I've been using Google Talk and thought you might like to try it out. Ve
can use itio call each other for free overthe internet. Here's an invitation
to download Google Talk. Give it a try’!|

== Back Next => Cancel

Figure 24-12: Gmail invites non-Gmail users to join.
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Drof).
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WIth oogle Talk

11 with Google Talk, locate the
erson you want to call in your contacts list, as shown
in Figure 24-13.

If the person is online and available — a green dot
means the person is available — click the phone icon
next to the name. The phone begins to ring.

When the person answers the call, begin talking.

To text chat with someone, double-click his or her name
in your contacts list.

Type text and press Enter on your keyboard to send the
text (see Figure 24-14).

Click the End Call button to terminate the call.

Text chat is especially handy for sending Web URLs during voice
calls. When you sent a URL through fext chat, the other person can
simply dick on the URL like a hyperlink to open it in a Web browser.

If you have an imporfant message to send to someone who is
offline, double-click the person’s name in your contacts list and send
a fext chat message. The text message will be automatically sent
the next fime the user goes online.

Google Talk

talk>’

@ Keith Linderdahl
Jilable ¥

Inbox | Semnasl

[l | X
. Ryan
Christa (invited)

Add friend

Figure 24-13: Green dofs indicate
available confacs.

@ Ryan (=)
| M Email || § can |
S : -~
Ryan: IIl bring rmy 1aptop s0we can burn any pice
wou weant
Kerth: great

Ryan: ho prob on the chat

Hey Keith | need a couple pointars on hooking
up xbox to my network ring me when you geta
chance

Sentat 5:39 PMon b

Keith: hey Ryan o

Figure 24-14: Google Talk also
supports fext chat.



Chat with a Bluetooth Headset

Bluetooth Headset

Chatwith a,Blu
D ro pfg:ggkﬁputer is set up to utilize wireless

10.

Bluetooth headsets. Turn on the Bluetooth headset and
create a partnership between the headset and your com-
puter. See Chapter 14 for details.

Open Skype and choose Tools=>Options to configure
Skype to use a Bluetooth headset.

On the left side of the resulting Options window, click
Sound Devices, as shown in Figure 24-15.

Choose Bluetooth Audio in the Audio In and Audio Out
menus.

Choose Windows Default Device in the Ringing menu,
and select the Ring PC Speaker option. Doing so allows
you to hear ring tones even if you're not wearing your
headset.

Click Save to close the Options window.

In Google Talk, click the Settings link near the top of the
Google Talk window and then click Audio on the left
side of the Settings window, as shown in Figure 24-16.

Choose Bluetooth Audio in the Input and Output Calls
menus.

Choose All Devices in the Notifications menu to ensure
that you hear ringtones even if you're not wearing the
headset.

Click OK to close the Settings dialog box.

&) Skype™ _ Options
B General
~ Audio In Bluetooth Audio I |
£ J Privacy =
Audio Out Bluetooth Audio I |
P Notifications Ringing windaws default device ||
N — [¥]Ring PC speaker
Let Skype adjust my sound device settings
@ Sound Devices
Hotkeys
L T
2) Connection R
A @ Learn mare how ko seb up vour sudio settings.
f;l‘_"! Advanced
=l
‘ﬂ cal Farwarding ‘C‘J Make a test call ko Skype snswering machine.
U & voicemail
o .
Figure 24-15: Configure Skype to use your Bluetooth headset.
‘Eﬁti‘ilgs .
General d
Blocked Auda
Privacy
Motifications
Caonnection Input - microphone o headset
Audio - S
|Bluetaoth Audio [+
Automatically adjust microphane sensitivity
Qutput - speakers or headset
Hotifications - rings and dings
gnu Devices |a|
Calls
|Bluetanth Audio ||
Unmute speaker For ringing
Unmute speaker and microphone when on a cal

Figure 24-16: Google Talk can also use Bluetooth headsets.

213



Chapter 24: Project: Voice Chatting with Your Wireless Network

DropBooks

214



Drd{iBjfats Adding IIIQ.‘ t
apter

a Wireless Camera
to Vour Network

Security cameras are nothing new. Business and home owners have been

setting up security cameras for many years, but the gear was expensive Get ready to...
and required a complex maze of wires to be run through attics or inside
walls. w= Choose a Wireless Camera............cccc.ce.. 216
Now, thanks to a new breed of affordable and easy-to-use Wi-Fi-equipped w= |nstall the Camera 216
cameras, setting up a home security camera is easy. You can position a Wi-Fi .
camera anywhere within range of your Wi-Fi network. You can then monitor = Set Up a Computer to Record Video......... 218

the camera and record video from it using any computer on your network.
You can even set up a special computer just for recording security video if
you want. The computer can be an older unit that you don’t use much any-
more, so long as it has a lot of free hard drive space. In this chapter, you find
out how to select and use a wireless camera with your Wi-Fi network.

S The exact steps you follow when setting up your security camera may be different from

= Replay Recorded Video ...........coooomnn...... 220

the steps listed here, depending on the brand of camera you buy. However, the general
concepts should be the same.
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se a Wireless Camera

pts
D ro p QQC that is compatible with 802.11b or

802.11g Wi-Fi networks, such as the one shown in
Figure 25-1.

Many security cameras are marketed as wireless security cameras,
however they utilize a proprietary radio for wireless transmission
rather than 802.11 Wi-Fi. If the camera doesn't specifically say that
it is compatible with Wi-Fi networks, it may not work with your net-
work.

2. Determine whether you need a weatherproof camera.

The camera shown in Figure 25-1 is not weatherproof, but some
models are. Weatherproof cameras tend fo be more expensive, but
they allow you to safely monitor outdoor areas. Also, be aware that
if the camera was designed for indoor use, its sensor can be dam-

aged by direct exposure fo sunlgh. Figure 25-1: This camera has a built-in 802.11g Wi-Fi radio.
Photo courtesy AirLink101.

Install the Camera

1. Connect an Ethernet cable between the camera and your b, . SKvIPCAM250W WIRELESS 802.116
router or a computer. - —
* Install IPViewPro
Install Wizard
View User Manual
View Quick Installation Guide
Install Adobe” Acrobat”

A temporary Ethernet connection is usually required during setup.
You can reconfigure the camera to work wirelessly later.

2. Connect the camera’s power cable and power on the
camera.

3. Install the camera’s software (see Figure 25-2).

Browse CD
Exit

216 Figure 25-2: Install the camera’s software.



Install the Camera

4. Write down the following pieces of information for your

D B‘cﬁ KS[ . SkyIPCam250wW
IP Camera
ro p IQ ess, subnet mask, and default ‘ :

gateway Wireless Interface
e SSID

Wireless ; @ Enable # Disable
Connection Mode

¢ Encryption format and keys
5. Configure the camera’s software for your network (see Network Name (SSID);
Figure 25-3). Wireless Channel

Security Mode
The camera’s instructions should describe how to log in fo the cam-

era and change network setfings. You need to provide the camera
with the same SSID and encryption keys used by the rest of your
nefwork.

Authentication

6. When configuration is complete, disconnect the
Ethernet cable and test the camera to make sure that it Figure 25-3: Configure the camera for your network.
works wirelessly.

7. Move the camera to its permanent position, mount it, (WCSSETEEE WS MRS cag)

. 8 5 3 File Edit View Go Bookmarks Tools Help 0
and test the wireless connection again (see Figure 25-4). e G T i

# Getting Started B Latest Headlines || AGES Software

In Figure 25-4, | have positioned the camera so that it is looking
through a window in my garage. If the camera gets poor or no Wi-Fi : SkyIPCam250w
reception, move it to a different posifion. If you need more Wi-Fi - adipest
range, consider adding a Wi-Fi repeater fo your network (refer fo
Chapter 10).

Done

Figure 25-4: Test the camera’s wireless connection. 217
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Seélp a Rmémter to Record Video
D ro p SQ Q recording software on a computer

with lots of free hard drive space.

Web and security cams typically record at a resolution of 320x240
pixels. At this resolution, you can expect to need about 200-220 MB
for every hour of recorded video, or 5-6 GB per day. Higher resolu-
tion cameras use exponentially more storage space. Lower resolutions
use less space, but also provide vastly inferior video quality.

2. Disable power-saving settings on the recording computer.

If the computer's hard drive or processor automatically shuts down
after a period of computer inactivity, it won't be able to record
video from the wireless camera.

{111

- =
—
—

3. Launch the camera’s recording software and open the
configuration window (see Figure 25-5).

4. Location the motion detection controls and activate
them if desired.

5. Adjust motion sensitivity.
Motion sensitivity is usually adjusted with a slider control. You may
need fo fine-tune this setting later based on what is and isn't
recorded by the camera.

6. If possible, create detection regions (see Figure 25-6).
In Figure 25-6, | have created motion detection regions around the
windows, because that is the only area where | want motion

detected for recording purposes.

7. Choose notification options for motion detection.

218 Figure 25-6: Set up motion detection on the camera.



Set Up a Computer to Record Video

8.

e -
pB.dQKSSk space you want reserved for

Dro

10.
11.
12.

13.

14.

15.

Open the recording configuration screen (see

the Windows operating system (OS).

| recommend that you reserve at least 1000 MB of free space for
Windows. In practice it is a good idea to leave at least 30—40 percent
of your hard drive open af any given time. This vastly improves the
performance of Windows and your computer.

Set the maximum file size for each recorded video file.

Choose a storage location for the video files.

Choose whether or not you want to recycle storage
space.

When you enable recycling, the recording program overwrites old
files when the reserved limit is reached.

If you want to record video at a scheduled time every
day, open the scheduling page and create a recording
schedule.

Save your configuration changes and close the configu-
ration screen.

Click the Record button and activate recording (see
Figure 25-8).

— — _—
Figure 25-7: Decide how much storage space you want to devote to recorded video.

—
TN

|

="

it

Figure 25-8: Adivate recording.
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Replay Regorded Uideo
D ro p.épétgcks recording utility.
2.

220

Open the playback control panel.

s In the AirLink 101 software, simply click the Play button.

Open the folder containing files from your camera (see
Figure 25-9).

Select the file you want to play and click OK.

Recorded video files are typically named using the date and time of
the recording. In Figure 259, | am opening a file named
20051127092319.avi. This file was recorded at 9:23 am on
November 27, 2005.

Play the file in your media player (see Figure 25-10).

You can also view files by using Windows Explorer or My Computer to
browse to the folder containing the saved video files. There you can
double-dick on files to view them. You can also copy files from this
folder to a safe location in case you need a file for future reference.

1 Select One AVI File
|=re ps_voL) |
3 2005112708395 avi
SProgram Files 2005112708431 avi
sk o 2005127091554 avi
S rview Fro 200511 27032240 avi

20051127092579 avi

Y CAMI_CS-59CO7E

CHProgram FilesiAidinkT01UPYiewr ProdCAaM1 _CS-59C97E20051127092319 avi |

oK I Cancel I

Figure 25-9: Choose a video file to play.

(=) Windows Media Player

File View Play Tools Help

[ R
‘Mow Playing &

Total Time: 0:24

Figure 25-10: View your video files in a media player.



Symbols and Numerics

* (asterisk) character, remote computer IP address
setup, 10

2.4 GHz band, interference elimination, 92

802.11a, Wi-Fi standard, 6

802.11b, 6, 83, 90

802.11g, 6, 90-91

A

access modes, wireless networks, 32
access point. See WAPs
ActiveSync, Bluetooth/Pocket PC, 136, 184
ad hoc networks, 32, 114-120, 153
admin password, WAP login, 8
ADS Tech Instant HDTV PCI card, 156
AirPort cards, 44-50
AirPort Extreme, Macintosh compatibility, 41
antennas, 93, 198

range extending, 93

weatherproof, 198
any available networks, access mode, 32
asterisk (*) character, IP address setup, 10
audio, DMRs (digital media receivers), 175-181
authentication, WPA-PSK encryption, 59-60

5

baby monitors, interference elimination, 92

bandwidth, 84, 109, 199, 201
Belkin, accelerator technologies, 91
bit depth, WEP encryption, 57
Bluetooth

802.11b/g signal interference, 121

ActiveSync, 136

computer names, 123

connections, 125

device types, 121

discovery options, 124

file beaming, 135

GPS receivers, 130-131

headsets, 129

interference elimination, 92

Macintosh configuration, 126-127

PIN code requests, 125, 127

Pocket PCs, 128, 133-136

service selections, 123

voice chats, 213

Windows PC configuration, 122-125
Bluetooth Configuration Wizard, 123
bottlenecks, identifying/removing, 90
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bridges

QOKS"
game consoles, 149-154
network settings, 147
Wi-Fi card configuration, 145

Wi-Fi card installation, 144
broadband modems, 7, 154

C

cable modems, WAP port connections, 7

cables, Ethernet, 7

cameras. See wireless cameras

cardbus Wi-Fi adapter, laptop computers, 26

cell phones, Bluetooth device type, 121

Centronics parallel ports, 190

chats. See voice chats

client computers, ICS (Internet Connection

Sharing) setup, 17

clients. See DHCP clients

Closed Network dialog box, 46

COM ports, GPS receivers/Bluetooth connections,

130-131

component connectors, 157

composite connectors, 157

Computer Name Changes dialog box, 15

computers. See also Macintosh; Windows PC
DHCP server IP address assignments, 16
disabling automatic connections, 110
ICS (Internet Connection Sharing) setup, 17
internal Wi-Fi cards, 24-25
MAC (Media Access Control) address cloning, 21

media center requirements, 156-157
network names, 14
performance monitoring identification, 85
public access prevention methods, 111
Wi-Fi card/bridge installation, 144
wireless camera video recording, 218-219
workgroup names, 14, 15

Connect to Server window, Windows PC from a

Mac login, 38

connections
ad hoc networks, 113-116
AirPort, 46
bridging computers, 146
disabling automatic, 110
disabling/enabling, 31
DMRs, 176
game console status checking, 151
GPS receivers/Bluetooth, 130-131
headset/Bluetooth, 129
Macintosh Bluetooth device, 127
network storage devices, 168
Pocket PC/Bluetooth, 128, 133-136
Pocket PC/hotspot, 139
Pocket PC/media server, 185
public Wi-Fi hotspots, 108-110
refreshing, 96
troubleshooting, 98
WAP devices, 7
Windows PC Bluetooth device, 125
wireless media center/TV, 157
wireless print servers, 190
Xbox Live, 154

contacts, Skype users, 207

cordless phones, interference elimination, 92
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detection regions, wireless cameras, 218
devices
accelerator technologies, 91
AirPort cards, 44
Bluetooth, 121-131
cardbus Wi-Fi adapter, 26
DMRs (digital media receivers), 175-181
external Wi-Fi adapter, 26
firmware updates, 99
game consoles, 149-154
identifying/removing bottlenecks, 90
internal Wi-Fi cards, 24-25
MAC address determination, 76-77
network drives, 168-173
network storage, 167-173
range extending antennas, 93
repeaters, 94
software updates, 100
SSID (service set identifier), 9
WAPs (wireless access points), 6
wireless cameras, 215-220
wireless print servers, 189-195
DHCP (Dynamic Host Configuration Protocol),
server setup, 16
DHCP clients
access point identification, 73-75
ICS (Internet Connection Sharing) setup, 17
Macintosh configuration, 19
performance monitoring identification, 85
Windows PC configuration, 18

DHCP servers, ICS (Internet Connection Sharing)
setup, 17
DHCP service, restarting, 97
digital media receivers (DMRs)
capabilities, 175
Ethernet port connections, 176
iTunes library sharing, 180
media folder sharing, 179
media playback, 181
streaming Internet radio, 181
supported media types, 176
Windows Media Connect configuration,
176-179
directional antennas, range extending method, 93
D-Link routers
accelerator technologies, 91
DHCP server enabling, 16
weatherproof WAPs, 198
DMRs. See digital media receivers (DMRs)
DN servers, DHCP client configuration, 18
drivers, software updates, 100
DSL modems, WAP port connections, 7
DVDs, wireless media center playback, 158-159
Dynamic Host Configuration Protocol (DHCP),
server setup, 16
dynamic IP, 10, 20

E

EIDE connectors, network hard drives, 168
eMacs, AirPort card installation, 45
e-mail, router logs, 85

223



Wi-Fi Home Networking Just the Steps For Dummies

DropB

224

encryption. See also security

, 151
m Encryption Protocol), 48, 54

Wi-Fi adapter configuration, 27
wireless intrusion protection, 61
wireless print servers, 190, 193
WPA (Wi-Fi Protected Access), 49, 54
WPA-PSK (WPA Pre-Shared Key), 54
Ethernet cables
network hard drives, 168-169
repeater connections, 94
WAP connection method, 7
wireless camera installation, 216
Ethernet ports, 6, 26, 176
exception lists, firewalls, 68
external modems, ICS (Internet Connection
Sharing) setup, 17
external Wi-Fi adapter, connections, 26

F

File Explorer, Pocket PC file sharing, 138
file sharing

ad hoc networks, 118

Pocket PC, 138

wireless media centers, 160-162
files

copying between networked Macs, 41

network access protections, 106

network sharing, 14

Pocket PC/Bluetooth beaming, 135
Finder, network storage device access, 173
fire codes, WAPs, 198

firewalls
activity logs, 67
exception lists, 68
halting network traffic, 66
Internet intrusion protection, 61
Mac OS X, 69
public Wi-Fi hotspot exceptions, 62
router built-in, 63
third-party, 64-65
updates, 65
user blocking, 79
WAN ping command blocking, 69
Windows XP SP2 62-63
wireless client identification, 74-75
firmware, updates, 99
folders, 34-36, 159, 172
Found New Hardware Wizard, 25
FTP access, network storage devices, 171

G

game consoles, 150-154

gateways, wireless print servers, 192
Google Talk, 210-213

GPS receivers, 121, 130-131

H

hard drives, network storage devices, 168-173
Hardware Update Wizard, software updates, 100
headsets, 121, 129, 213

high gain antennas, range extending method, 93
host computers, 17
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Host Name controls, network storage device, 170

1S o public Wi-Fi hotspots
ro p @ techniques, 202-203

access point guidelines, 198
bandwidth considerations, 199, 201
deactivating, 203

fire codes, 198

firewall exceptions, 62

ISP service agreements, 199

Pocket PC connections, 139
public/semi-public setup, 197-201
router requirements, 198

security risk reduction, 54

WAP configuration, 200-201

1

iBooks, AirPort card installation, 44
icons, wireless connection display, 29
infrastructure networks, 32, 117
internal Wi-Fi cards, installation, 24-25
Internet, 154, 181, 205-213
Internet Connection Sharing (ICS), network
setup, 17
Internet Explorer, access point IP address, 8
Internet Protocol (TCP/IP) Properties dialog
box, 18
Internet Service Providers (ISPs), 21, 199
IP address
asterisk (*) character, 10
determination methods, 10
DHCP client configuration, 18
DHCP server ranges, 16

Macintosh determination, 86
network storage devices, 170
ping command, 101
Pocket PC determination, 87
Pocket PC/Wi-Fi connections, 136-137
remote computers, 10
WAP/routers, 8
Windows PC determination, 86
wireless print servers, 192-193
ISPs. See Internet Service Providers (ISP)
iTunes, library sharing, 180
iTunes, shared media access, 162

K

Key Index, WEP key settings, 58
key types, WEP encryption, 57-58
keyboards, Bluetooth device type, 121

L

laptops, external Wi-Fi adapters, 26

Linksys routers, 8, 91, 198

Linux, Skype support, 206

Local Area Connection Properties dialog box, 18
local area network (LAN), 6

Log Settings dialog box, 63

logins, 8, 38-40

logs, 67, 72, 85

M

MAC. See Media Access Control (MAC)
Mac OS X, Skype support, 206
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Macintosh. See also computers
g ac installation, 44
@Q %ﬁok installation, 44
AirPort Extreme compatibility checking, 41
Bluetooth configuration, 126-127
copying files between, 41
DHCP client configuration, 19
firewalls, 69
folder sharing, 36
IP address determination, 86
iTunes library sharing, 180
MAC address determination, 77
media file organization, 159
media file sharing, 161
network storage device access, 173
ping command, 101
shared media access, 162
WEP encryption, 48
Wi-Fi network management, 47
Windows PC login, 38-39
Windows user accounts, 37
wireless print server printing, 195
workgroup names, 36
WPA encryption, 49
management software, 169-172
Mbps (megabits per second), Wi-Fi speed, 83
Media Access Control (MAC) address
access point logs, 72
cloning, 21
filtering, 56
Macintosh PC determination, 77
Pocket PC determination, 77
user blocking, 78-79

wireless client identification, 73-75

wireless device determination, 76
media centers. See wireless media centers
media files, 159, 176, 187
media library, Pocket PCs, 186-187
media players, 220
media servers, Pocket PC connections, 185
megabits per second (Mbps), Wi-Fi speed, 83
microphones, voice chat requirement, 205
microwave ovens, interference elimination, 92
modems, 7, 17
motherboards, wireless media center, 156
motion sensitivity, wireless cameras, 218
mouse, Bluetooth device type, 121
movies, wireless media center playback, 158-159
music, DMRs (digital media receivers), 175-181
My Network Places

ad hoc network connections, 116

ad hoc network removal, 119

disabling network bridges, 148

enabling ad hoc networking, 114

Macintosh from a Windows PC login, 40

network storage device access, 173

shared media access, 162

shared network folder access, 35

Wi-Fi card/bridge computer configuration, 145

N

Netgear, 91, 198

Network Bridge Properties dialog box, 147

network bridges, external Wi-Fi adapter, 26

Network Connection Details dialog box, 76

Network Connection Properties dialog box,
34, 106
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refreshing, 96
speed determination, 87
Windows PC IP address determination, 86
Network dialog box, 47-49
network keys, Wi-Fi adapter configuration, 27
network storage devices, 168-173
networks. See also computers
access modes, 32
access point logs, 72
ad hoc connections, 113-116
AirPort card preference settings, 47
bridges, 143-148
client identification for monitoring, 85
computer names, 14
copying files between networked Macs, 41
DHCP client configuration, 18, 19
DHCP server setup, 16
disabling automatic connections, 110
disabling file/printer sharing, 106
disabling SSID Broadcast, 55
disabling/reactivating, 31
file access protections, 106
file/print sharing, 14
game console settings, 152
ICS (Internet Connection Sharing) setup, 17
MAC (Media Access Control) address, 21
Macintosh from a Windows PC login, 40
Mbps (megabits per second) speed, 83
performance monitoring, 83-88
ping command troubleshooting, 101
Pocket PC connections, 136-137

printer drivers, 194
public access prevention methods, 111
range measurements, 88
refreshing available, 30
shared folders, 34-36
storage devices, 167-173
user accounts, 37
WAN (wide area network) settings, 20
Wi-Fi adapter software configuration, 27
Windows Network Setup Wizard, 14
Windows PC from a Macintosh login, 38-39
wireless print servers, 189-195
workgroup names, 14, 15
WPA encryption, 28
non-preferred networks, 32, 110
Notification Area, 29

0

omni-directional antennas, 93

P

parallel ports, print server connections, 190
passkeys, Pocket PC, 134
passphrase, WPA-PSK encryption, 59
passwords

Google Talk, 210

network storage devices, 170

Pocket PC security, 140

Skype, 206

WAP login, 8

Windows user accounts, 37
PCI slots, internal Wi-Fi card installation, 24-25
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PDAs, Bluetooth device type, 121 power supplies, wireless media center, 156
paR{o onitoring, 84-88, 90-94 printer drivers, wireless print servers, 194
D ro p B@@%Stooth requests, 125, 127 printers, 14, 121, 189-195
ping command, 69. 101 processors, wireless media center, 156
Plain Old Telephone System (POTS), 209 programs, firewall exception lists, 68
PlayStation. See game consoles protections, network file access, 106
Pocket PC public Wi-Fi hotspots. See also hotspots
ActiveSync, 136, 184 connection monitoring, 109
ad hoc networks, 115-116, 118-119 connections, 108
Bluetooth connections, 128, 133-136 disabling automatic connections, 110
file beaming, 135 disconnecting, 112
file sharing, 138 firewall exceptions, 62
hotspot connections, 139 free versus subscription services, 105
IP address determination, 87 locating, 107-108
MAC address determination, 77 Pocket PC connections, 139
media library setup, 186 setup, 197-201
media playback, 187 signal searches, 108
media server connections, 185
passkeys, 134 R
passwords, 140
ping command, 101 radio, Internet streaming, 181
power option adjustments, 140 RADIUS servers, WPA encryption, 59
refreshing connections, 96 range extending antennas, WAP enhancement, 93
remote control uses, 184-187 remote access, WAP setup, 10
security protections, 140 remote computers, 10-11
Skype support, 206 remote controls, Pocket PCs, 184-187
Wi-Fi connections, 136-137 repeaters, range extending method, 94
Windows Media Player installation, 184 resolutions, wireless camera guidelines, 218
Windows Mobile 5 operating system routers. See also WAPs (wireless access points)
requirement, 133 accelerator technologies, 91
Point-to-Point over Ethernet (PPPoE), 20 access point logs, 72
Port 80, remote access setup, 10 blocking users, 78
ports, 6, 10, 190 built-in firewalls, 63
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firmware update, 99

IP address, 8

MAC (Media Access Control) address, 21
MAC address filtering, 56

ping command blocking, 69

public Wi-Fi hotspot requirement, 198
supported encryption technologies, 54
WAN (wide area network) settings, 20
WAP (wireless access point) device, 6
wireless print servers, 190

)

searches, 30, 108
security. See also encryption
access point logs, 72
encryption types, 54
file access protections, 106
hotspot risk reduction, 54
Internet intrusions, 61
MAC address determinations, 76-77
MAC address filtering, 56
needs determinations, 54
Pocket PCs, 140
public access prevention methods, 111
RADIUS servers, 59
SSID Broadcasts, 55
third-party firewalls, 64-65
user blocking, 78-79
WEP activation, 57

WEDP key settings, 57-58
Windows Firewall, 62-63
wireless cameras, 215-220
wireless client identification, 73-75
wireless intrusions, 61
wireless print servers, 190, 193
WPA-PSK encryption, 59-60
semi-public WiFi hotspots, setup, 197-201
servers, DHCP (Dynamic Host Configuration
Protocol) setup, 16
Service Pack 2 (SP2), 62
service set identifier (SSID), 9, 27, 150
Shared Documents folder, 34, 159
shared files, ad hoc networks, 118
Shared folder, media file organization, 159
shared folders, 34-36, 179
Skype, 206-209, 213
SMB|/CIFS Filesystem Authentication dialog box,
Windows PC login, 38-39
SnapStream, Beyond TV, 163-165
software, driver updates, 100
sound cards, wireless media center, 157
SP2 (Service Pack 2), 62
speakers, 157, 205
SSID. See service set identifier (SSID)
SSID Broadcast, disabling, 55
standards, 6, 198
static IP, WAN (wide area network) settings, 20
subnet masks, wireless print servers, 192-193
S-Video connectors, 157
System Preferences, 36-37, 96
System Properties dialog box, 15
system tray, wireless connection icon display, 28
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D ro p Btggk&le Talk, 212 WAN. See wide area network (WAN)

traffic statistics, performance monitoring, 84 WAN ping command, blocking, 69
troubleshooting WAPs. See wireless access points (WAPs)

access problems, 102 Web sites

ad hoc networks, 120 AirPort Extreme compatibility checking, 41

bad wireless connections, 98 Boingo Hot Spot in a Box, 203

DVD playback, 158 ControlAP, 203

ping command, 101 Gemtek P-560, 203
TV tuner cards, 156, 163-165 Google Talk, 205, 210
TVs, 157, 163-165 hotspot access controls, 203

hotspot appliances, 203
u IP address determinations, 10
JiWire.com, 107

updates Netopia Hotspot Starter Kit, 203

AirPort card software, 45 PatronSoft FirstSpot, 203

driver software, 100 Rudeo Play & Control, 184

firewalls, 65 Skype, 205, 206

WAP firmware, 99 SnapStream'’s Beyond TV, 163

Wi-Fi cards, 25 Wi-Fi card updates, 25

WPA-PSK encryption, 60 Wi-Fi hotspot locator, 107
USB ports, wireless print server connections, 190 Windows Media Connect, 176
USB Wi-Fi adapters, connections, 26 WEDP. See Wireless Encryption Protocol (WEP)
user accounts, 37, 171 wide area network (WAN), 6, 20
users, 78-79, 207, 211 Wi-Fi cards, 24-25, 27, 150-152

Wi-Fi Protected Access (WPA), 28, 49, 54
U Wi-Fi Protected Access Pre-Shared Key (WPA-
PSK), 54, 59-60

video cards, wireless media center, 156 Windows Firewall
video files, wireless camera storage, 218-219 activity logs, 67
voice chats, 205-213 Conﬁguration[ 62-63

exception lists, 68
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file access protections, 106

1] k traffic, 66
(ﬁ Connect, 176-179, 185

Windows Media Player, 158-1159, 184
Windows Mobile 5 OS, Pocket PC, 133
Windows Network Setup Wizard, 14, 17
Windows OS, Skype support, 206
Windows PC. See also computers

Bluetooth configuration, 122-125

connection troubleshooting, 98

DHCP client configuration, 18

file access protections, 106

folder sharing, 34

internal Wi-Fi card installation, 24-25

IP address determination, 86

Macintosh login, 40

media file organization, 159

media file sharing, 160

media folder sharing, 179

network storage device access, 173

ping command, 101

software updates, 100

user accounts, 37

wireless print server printing, 194
Windows Security Center, SP2 requirement, 62
Windows XP Video Decoder Checkup Utility, 158
wireless access points (WAPs). See also routers

accelerator technologies, 91

activating, 9

AirPort connections, 46

best range positioning, 92

disabling SSID Broadcast, 55

enabling/disabling remote management, 11

Ethernet cable connection method, 7

fire codes, 198

firmware updates, 99

high gain antennas, 93

hotspot setup, 198

interference elimination, 92

IP address, 8

location/positioning suggestions, 7

login passwords, 8

logs, 72

Mbps speed ratings, 83

public Wi-Fi hotspot configuration, 200-201

range extending antennas, 93

rebooting, 97

refreshing connections, 96

remote access setup, 10

repeaters, 94

setup, 5-11

speed setting adjustments, 90

SSID (service set identifier), 9

weatherproof, 198

WEP key settings, 57-58

WiFi standards, 6

wireless client identification, 73-75
wireless cameras

configuration settings, 217

date/time filename format, 220

detection regions, 218

installation, 216-217

motion sensitivity, 218

recycling storage space, 219

resolution guidelines, 218

selection guidelines, 216

video file storage considerations, 218-219

video playback, 220
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wireless cameras (continued)

i Qg 218-219
m dvantages, 216

wireless connection icon, Notification Area
display, 29
Wireless Encryption Protocol (WEP)
activating, 57
bit depth settings, 57
encryption type, 54
key type settings, 57-58
Macintosh, 48
wireless print servers, 190, 193
wireless media centers
capabilities, 155
computer (hardware) requirements, 156-157
DVD playback, 158-159
file sharing, 160-162
live TV recording, 164
media file organization, 159
recorded TV program playback, 165
TV connections, 157
TV viewing, 163
Wireless Network Connection Properties
dialog box
access modes, 32
bridge computers, 145
enabling ad hoc networking, 114
network disabling, 117
network removal, 119

Wireless Network Connection Status dialog box
access modes, 32
network disabling, 117
network search, 30
Wireless Network Connection utility, 28
Wireless Network Connection window, 30-31
Wireless Network Setup Wizard, 28
wireless networks. See networks
wireless PCs, speed determinations, 87
wireless print servers, 190-195
wireless radio, activating, 9
wizards
Bluetooth Configuration Wizard, 123
Found New Hardware Wizard, 25
Hardware Update Wizard, 100
Windows Network Setup Wizard, 14, 17, 28
workgroup names
Macintosh setup, 36
network storage devices, 170
networks, 14, 15
WPA (Wi-Fi Protected Access), 28, 49, 54
WPA-PSK (Wi-Fi Protected Access Pre-Shared

Key), 54, 59-60

Xbox Live. See also game consoles
Xbox Live, game console connections, 154
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